PhotoStory on CD & DVD 10

Bring your memories back to life!
Copyright

This documentation is protected by law. All rights, especially the right of duplication, circulation, and translation, are reserved.

No part of this publication may be reproduced in the form of copies, microfilms or other processes, or transmitted into a language used for machines, especially data processing machines, without the express written consent of the publisher.

All copyrights reserved.

All other product names are trademarks of the corresponding manufacturers. Errors in and changes to the contents as well as program modifications reserved.

MAGIX is a registered trademark of MAGIX AG.

Other mentioned product names may be registered trademarks of the respective manufacturer.

This product uses MAGIX patent pending technology.

Copyright © MAGIX AG, 2002-2011. All rights reserved.
Preface

With MAGIX PhotoStory on CD & DVD 10 you can teach your photos how to walk – or even better, how to dance! With this software your photos will become the star of an impressive multimedia show, and you’re the director!

Enjoy your photos together with your family and friends on TV or on your PC. Play your pictures just like a feature film with great fades and effects as well as narration and subtitles. Add intros and outros or invent your own closing credits. In other words, turn your living room into a cinema!

Create attractive DVD menus that match the format of your slideshow: 4:3 or 16:9 for widescreen TVs or monitors. Burn your slideshow together with a high quality menu onto any current format: a playable DVD, CD-ROM, Video CD, Super Video CD, miniDVD, JPEG disc, TV Showtime DVD, multi-disc, or Blu-ray Disc.

The printed manual is only a brief introduction to the software. You can find detailed documentation as a PDF in the start menu of your MAGIX product. The electronic manual can be opened using "F1" to provide a more detailed explanation of the options, dialog boxes, menus, and program interface. Program help and the PDF manual will even guide you through the format jungle of blank discs, DVDs, Video CDs, High Definition slideshows, etc.

The term slideshow is used in MAGIX PhotoStory on CD & DVD 10.

Have fun with MAGIX PhotoStory on CD & DVD 10!
# Table of Contents

Copyright 2

Preface 3

Support 8
Information on special program versions 10

System requirements 10

Serial number 11

More about MAGIX 12
MAGIX News Center 12
MAGIX Online Album 12
MAGIX Blog Service 12
MAGIX Website Maker 12
Catooh – the Online Content Library 13
MAGIX Community 13

Introduction 14
What is MAGIX PhotoStory on CD & DVD 10? 14
What’s new in MAGIX PhotoStory on CD & DVD 10? 14
Additional new features of the Deluxe version 16
Properties 17
Overview of the program screen 20
Keyboard shortcuts 21

Quick start 25
Disc projects, slideshows, and photos 25
Create a new slideshow with the wizard 26
Designing slideshows 28
Creating CD/DVD menus 33

Edit Fotoshow 36
Video monitor and transport control 36
Media Pool 39
Toolbar 39
Start and end markers 43
Mute sound 43
Overview mode 43
Storyboard mode 45
<table>
<thead>
<tr>
<th>Table of Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timeline mode</td>
</tr>
<tr>
<td><strong>Media Pool</strong></td>
</tr>
<tr>
<td>Media</td>
</tr>
<tr>
<td>Fades</td>
</tr>
<tr>
<td>Title</td>
</tr>
<tr>
<td>Effects</td>
</tr>
<tr>
<td><strong>Record</strong></td>
</tr>
<tr>
<td>Audio recording</td>
</tr>
<tr>
<td>Connecting the source for recording</td>
</tr>
<tr>
<td>Adjusting the Signal Level</td>
</tr>
<tr>
<td>Individual Frame Capture</td>
</tr>
<tr>
<td><strong>Transitions (fades)</strong></td>
</tr>
<tr>
<td>Transitions in Storyboard Mode</td>
</tr>
<tr>
<td>Simple crossfade in Timeline Mode</td>
</tr>
<tr>
<td>Drag &amp; drop onto a &quot;hard&quot; transition</td>
</tr>
<tr>
<td>3D transitions</td>
</tr>
<tr>
<td>3D series</td>
</tr>
<tr>
<td>Stereo3D transitions (Deluxe version only)</td>
</tr>
<tr>
<td><strong>Effects</strong></td>
</tr>
<tr>
<td>Effects in menus</td>
</tr>
<tr>
<td>Effects from the Media Pool</td>
</tr>
<tr>
<td>Optimize picture</td>
</tr>
<tr>
<td>Video Stabilization</td>
</tr>
<tr>
<td>Slideshow Maker</td>
</tr>
<tr>
<td>Sound optimization</td>
</tr>
<tr>
<td>Title editor</td>
</tr>
<tr>
<td>Tempo and beat recognition</td>
</tr>
<tr>
<td>Slideshow effects</td>
</tr>
<tr>
<td><strong>Stereo3D (Deluxe version)</strong></td>
</tr>
<tr>
<td>3D basics</td>
</tr>
<tr>
<td>Record 3D</td>
</tr>
<tr>
<td>Prepare 3D editing</td>
</tr>
<tr>
<td>Set playback mode for 3D</td>
</tr>
<tr>
<td>Align videos and pictures for 3D</td>
</tr>
<tr>
<td>Turn camera movements into 3D videos</td>
</tr>
<tr>
<td>Create titles for 3D videos</td>
</tr>
<tr>
<td>Export and burning 3D videos</td>
</tr>
<tr>
<td><strong>Produce panorama pictures</strong></td>
</tr>
<tr>
<td>Select pictures for panorama</td>
</tr>
<tr>
<td>Topic</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invert image sequence for panorama image</td>
</tr>
<tr>
<td>Calculating the panorama image</td>
</tr>
<tr>
<td>Finished panorama (2 images)</td>
</tr>
<tr>
<td><strong>MAGiX Soundtrack Maker</strong></td>
</tr>
<tr>
<td>Choose music style</td>
</tr>
<tr>
<td>Set mood change</td>
</tr>
<tr>
<td>Generate background music</td>
</tr>
<tr>
<td><strong>General settings</strong></td>
</tr>
<tr>
<td>Playback</td>
</tr>
<tr>
<td>Paths</td>
</tr>
<tr>
<td>Options</td>
</tr>
<tr>
<td>Display</td>
</tr>
<tr>
<td><strong>Project- and slideshow-relevant settings</strong></td>
</tr>
<tr>
<td>New project - Settings</td>
</tr>
<tr>
<td>Movie properties</td>
</tr>
<tr>
<td><strong>Burn disc</strong></td>
</tr>
<tr>
<td>Preview and editing</td>
</tr>
<tr>
<td>Menu</td>
</tr>
<tr>
<td>Menu templates</td>
</tr>
<tr>
<td>Edit disc menu</td>
</tr>
<tr>
<td>Edit DVD menus featuring MAGiX Photo &amp; Graphic Designer 6</td>
</tr>
<tr>
<td>Burn dialog for DVD player</td>
</tr>
<tr>
<td>Burn WMV HD</td>
</tr>
<tr>
<td>Burn JPEG disc</td>
</tr>
<tr>
<td>Create PC show</td>
</tr>
<tr>
<td>Create webDVD</td>
</tr>
<tr>
<td><strong>Export</strong></td>
</tr>
<tr>
<td>Save slideshow as video on your computer</td>
</tr>
<tr>
<td>Export as 3D video (Deluxe version only)</td>
</tr>
<tr>
<td>Publish directly on the Internet.</td>
</tr>
<tr>
<td>Publish via MAGiX Online Album</td>
</tr>
<tr>
<td>Export for mobile device - export video/audio</td>
</tr>
<tr>
<td><strong>Menus</strong></td>
</tr>
<tr>
<td>File Menu</td>
</tr>
<tr>
<td>Edit Menu</td>
</tr>
<tr>
<td>Effects Menu (FX)</td>
</tr>
<tr>
<td>Online menu</td>
</tr>
<tr>
<td>Tasks menu</td>
</tr>
<tr>
<td>Help Menu</td>
</tr>
</tbody>
</table>
# Table of Contents

**Activate additional functions** 178
  Free activation (MPEG 2 codec) 178
  Fee-based activation (MPEG-4) 179
  Activation problems 180

**Problems and solutions** 181
  File will not load 181
  Choppy or uneven playback 181
  Activation problems 181

**Encoder** 183
  Appendix: MPEG Encoder Settings 183
  MPEG-4 encoder settings 187
  MPEG glossary 201

**Annex: Digital Video and Data Storage** 208
  Video Editing on the PC 208
  HDTV 208
  MPEG Compression 209
  General notes on AVI videos 209
  Capacity and quality of different disc formats 210

**MAGIX services in detail** 217
  MAGIX Online Album 217
  MAGIX Community 218
  MAGIX Blog Service 219
  Catooh – the Online Content Library 219
  Youtube / Flickr 220

**If You Still Have Questions** 221
  Task assistant 221
  Tips for program help 221

**Glossary** 222

**Index** 237
Support

Dear MAGIX customer,

Our aim is to provide convenient, fast and solution-focused support at all times. To this end, we offer a wide range of services:

- **Unlimited web support:**
  As a registered MAGIX customer, you have unlimited access to web support offered via the convenient MAGIX service portal on http://support.magix.net, including an intelligent help assistant, high-quality FAQs, patches and user reports that are constantly updated.
  The only requirement for use is product registration on www.magix.com

- **The online community - on-the-spot support and a platform for exchange:**
  MAGIX customers have free and unlimited access to the online community at www.magix.info, which includes approx. 100,000 members and offers the opportunity to ask members questions concerning MAGIX products as well as use the search function to search for specific topics or answers. In addition to questions & answers, the knowledge pool includes a glossary, video tutorials and a discussion forum. The multiple experts, found round-the-clock on www.magix.info guarantee quick answers, which sometimes come within minutes of a question being posted.

- **Email support for MAGIX products:**
  8 (eight) weeks of free email customer service (starting from the purchase date) is automatically included with the purchase of any new MAGIX product. MAGIX guarantees fast processing of your request and an immediate reply.
  **Premium email support:**
  If you experience problems after the 8 weeks of free email support have expired, you can purchase a Premium email support ticket in the MAGIX Shop for USD 12.99 | CAD 13.99 | GBP 9.99 | AUD 18.99 | ZAR 120.00 | EUR 12.99 | SEK 119.00 | NOK 99.00 | DKK 99.00. This ticket applies to a specific problem and is valid until it is solved; it is therefore not restricted to one email.
  Reporting evident program errors is exempt from this regulation.

**Please note:** To be able to use the Premium email support and free product email support via the Internet, you have to register your MAGIX product using the serial number provided. This can be found on the CD case of your installation CD or on the inside of the DVD box.

- **Additional telephone service:**
  Besides the large number of free customer service offers, we also offer a fee-based telephone customer service.
Here you can find a summary of our technical support telephone numbers:
http://support.magix.net/

**Mail (Europe):** MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, Germany

**Mail (North America):** MAGIX Customer Service, 1105 Terminal Way #302, Reno, NV 89502, USA

**Please make sure you have the following information at hand:**
- Program version
- Configuration details (operating system, processor, memory, hard drive, etc.), sound card configuration (type, driver)
- Information regarding other audio software installed

**MAGIX Sales Department**

You can reach the MAGIX Sales Department workdays for help with the following questions and problems:

- Orders
- Product consulting (pre-purchase)
- Upgrade requests
- Returns

**Europe**

Monday - Friday, 09:00-16:00 GMT

**U.K.**: 0203 3189218  
**Denmark**: 699 18149  
**Sweden**: 0852500858  
**Finland**: 09 31581630  
**Norway**: 0210 30665

**North America**

9 am to 4 pm EST Mon-Fri  
**Phone**: 1-305-722-5810
Information on special program versions

This documentation describes the full functionality of MAGIX PhotoStory on CD & DVD 10 Deluxe. If you are using the classic version of MAGIX PhotoStory on CD & DVD 10, some special features may not be available.

System requirements

- For Microsoft® Windows® XP™ I Vista™ I 7™

Minimum configuration:

- Intel® Pentium® or AMD® Athlon® 1 Ghz or higher (512 MB RAM)
- 500 MB for program files, min. 1 GB for video files (5 GB recommended)
- SVGA graphics card (with min. 32 MB RAM, min. resolution 1024 x 600, 16-bit high-color)
- DVD drive, 16-bit sound card, Microsoft® compatible mouse
- Creates CDs with SCSI or IDE CD-R(W) burners, DVDs with DVD-/+R(W) burners and Blu-ray Discs™ with Blu-ray burners.
- Online Services and travel route animation (uses map material from OpenStreetMap) via Internet connection and Microsoft®
Serial number

A serial number is included with each product, and although it is not required for the installation of the software, it does enable access to additional bonus services. Please store this number in a safe place.

What can a serial number do?

A serial number ensures that your copy of MAGIX PhotoStory on CD & DVD 10 is clearly assigned to you and only you, and it makes improved and more targeted customer service possible. Abuse of the software can be prevented with a serial number, since it ensures that the optimum price/performance ratio continues to be offered by MAGIX.

Where can the serial number be found?

The serial number can be found on the reverse side of your CD/DVD case. If your product, for example, is packed in a DVD box, then you’ll find the serial number on the inside.

For versions that have been especially optimized for the Internet (download versions), you’ll receive your serial number for activating the software directly after purchasing the product via email.

When will you need the serial number?

The serial number is required when you start or register MAGIX PhotoStory on CD & DVD 10 for the first time.

Note: We explicitly recommend registering your product, since only then are you entitled to get program updates and contact MAGIX Support. Entering the serial number is also required for activating codecs.
More about MAGIX

MAGIX News Center

The MAGIX News Center features links to current online tutorials and tips & tricks on the software application examples. The "News" is indicated by color according to content:

- Green indicates practical tips & tricks for the software
- Yellow reports the availability of new patches and updates
- Red for special offers, contests and questionnaires

If no new messages are present, the button will appear gray. When the MAGIX News Center is clicked, all of the available information will be displayed. Click the messages to reach the corresponding website.

MAGIX Online Album

MAGIX Online Album is your personal multimedia album on the Internet. If you want to present slideshows or videos online, then MAGIX Online Album is the perfect service.

MAGIX Blog Service

With MAGIX Blog Service, YOU make the news! Share your thoughts, experiences, and news with a worldwide audience in no time using your own interactive online multimedia journal. Invite family, friends, and acquaintances to join in and enter their comments! A free MAGIX Online Album belongs to the MAGIX Blog Service so that you always have full control over your contributions.

MAGIX Website Maker

MAGIX Website Maker helps you create a personal Internet showcase with a professional design in just a few mouse clicks – without prior knowledge, including your own chosen domain and email address. Publish slideshows and videos and accessorize your site with music and various effects – anything from a simple business card to a fireworks display of effects, professional or private – show your best side!
Catooh – the Online Content Library

If your project is missing pictures, videos, DVD menus, sounds, or samples, then you should have a look at the huge selection available at Catooh. There you'll be able to buy media in excellent quality for low prices: DVD menus, Slideshow Maker styles, decorative elements, 3D power effects, 3D transition series, MAGIX Soundpools, songs, ringtones... Perfectly suited to all MAGIX photo, video, and music projects.

MAGIX Community

MAGIX Community is the place to exchange photos, videos, and music with friends and the world. As soon as you have registered for free, you can use all of its great features.
Introduction

What is MAGIX PhotoStory on CD & DVD 10?

The name says it all: MAGIX PhotoStory on CD & DVD 10 puts your photos and movies onto a CD or DVD as a slideshow that can then be viewed on your PC screen or TV – Just like a movie.

The typical scenario: The hard disk is overflowing with photos from your digital camera and camera phone, more holiday, family or birthday pictures are scattered around in envelopes waiting for a scan. What to do with all those digital photos? MAGIX PhotoStory on CD & DVD 10 will tidy everything up, put it together, add fades, music or effects to create an exciting slideshow.

What’s so special? A personal slideshow is created, perfectly arranged just like a feature film. Then you can burn it onto DVD, if desired together with other slideshows. What’s so special you ask? The CD or DVD can then be played on a DVD player and viewed on TV. There are also many further possibilities to export slideshows as movie files or present them directly online.

Information on special program versions

This documentation describes the full functionality of MAGIX PhotoStory on CD & DVD 10 Deluxe. If you are using the classic version of MAGIX PhotoStory on CD & DVD 10, some special features may not be available.

What’s new in MAGIX PhotoStory on CD & DVD 10?

New Title Editor

Titles, text, opening and end credits are now written directly in the preview monitor so that you can see exactly where your titles will be positioned right away. Click the "Title" button in the Media Pool, select a template and place it onto the track via drag & drop. You may now edit your titles in the preview window.

Completely reworked Slideshow Maker

Slideshow Maker has been heavily revised. Effects and fades can now be set and adjusted in detail. This program is accessible via "File-> Wizards -> Slideshow Maker".
Creation of custom color spaces
You can embed custom color spaces in your slideshow. These are especially practical as chapter separators with some text. You will find the color screens in the Media Pool in the "Effects" tab under "Design => Backgrounds => Color swatches" or by pressing the wrench symbol in the toolbar.

Revised DVD menu design
The DVD menu design function has been generally revised. You can access this option directly via the "Burn" button.

Lots of new templates
Thanks to many new templates for 3D titles, DVD menus and background music, your slideshows can receive a completely new dimension. The 3-D title templates are found in the Media Pool in the "Titles" tab, and the DVD menu templates and background music in the "Burn" tab in the "Edit" view.

MAGIX Photo Manager
MAGIX Photo Manager is the perfect companion for managing your photos. Create digital photo albums and add new images with ease. MAGIX Photo Manager can be found under "File -> Supplementary programs".

Creating backgrounds
The Media Pool features useful templates for various applications. For example, there are professional backgrounds for measurements, but there are also special templates with more creative freedom and adjustable color schemes.
Additional new features of the Deluxe version

Even more custom design options in menu design

In the "Burn" screen you will find even more design option in the "Edit" view. Create custom menu pages and add your own menu entries.

Travel route animation

Ideal for vacation slideshows: You can display the locations of your trip on a map and connect them with a line. The travel route may then be saved as an image and integrated into the slideshow. You will find the travel route animation in the "File" menu under the "Wizards" entry.

RAW support

Many digital cameras deliver photos in uncompressed, high-resolution RAW data format. MAGIX PhotoStory on CD & DVD 10 supports import and editing of many RAW files. For an updated list of all compatible camera models, see www.magix.com

Optional AVCHD support

Using optional AVCHD support you can import and burn high-resolution videos incl. AC3 sound. This option has to be activated for a fee before the first use. When you import a AVCHD video into MAGIX PhotoStory on CD & DVD 10, the activation process will start automatically. The burn function can be found in the "Disc selection" dialog in the "Burn" screen.

MAGIX Music Editor

MAGIX Music Editor is a full WAV editor with all necessary cutting, editing & effect functions as well as numerous import/export functions. You can open audio objects from MAGIX PhotoStory on CD & DVD 10 with a mouse click in the MAGIX Music Editor. There you'll be able to take advantage of lots of additional powerful tools, for example, a function for freehand drawing of waveforms. This can be used to fix the most stubborn distortions that cannot be eliminated completely using the MAGIX PhotoStory on CD & DVD 10 DeClicker.
Properties

Importieren

- **Photo:** JPG, BMP, GIF, TIF, PSD, MPO (3D Stereo) and much more; imports from Kodak® Photo-CD (PCD); use animated web graphics as decorative elements (animated GIF import)
- **Video:** MOV, AVI, WMV 9, MPEG-1, MPEG-2, MPEG-4, high-resolution AVCHD videos incl. AC3 sound and much more.
- **Text:** You can easily enter longer texts such as credits with any text processing program and then save them in the universal .rtf text format. Loading such a text into MAGIX PhotoStory on CD & DVD 10 creates a text object.
- **Audio:** Imports camera sound, non-copy-protected CD tracks, MP3, OGG, WAV, etc.; sound recording

**Hint:** MPEG3, AVCHD and AC-4 codecs can be used after a fee-based activation.

Exporting

Slideshows can be exported in the following formats as video files: MXV (MAGIX Video), AVI, MPEG-1/-2, Windows Media 9, Quicktime (*.MOV) and MPEG-4 (must be activated for a fee).

**Please note:** The MPEG-2 encoder required for the MPEG-2 export has not yet been activated. Please have your product serial number (view page 10) at hand for a free activation.

Three views

MAGIX PhotoStory on CD & DVD 10 provides three specialized views for especially easy editing:

- **Storyboard mode** (view page 44) lists several photos in sequence. Every photo is displayed with a preview picture in the storyboard. Choose how you want to fade between photos from many different transition options.
- **Timeline mode** (view page 46) chronologically displays your photos with text and sound elements over four tracks. The longer the representative object remains in the track, the longer the corresponding photo will be displayed during playback. In total, you have four tracks to arrange your photos with titles, movie sequences, and music.
• **Overview mode** (view page 43) displays all photos in multiple rows. The zoom function makes sure that the number of photos you want to view can be viewed at the same time. Photos or photo groups can be deleted, or their order in the list can be changed.

**Concentrated multimedia power**

MAGIX PhotoStory on CD & DVD 10 provides a large number of multimedia functions that help you really get the best out of your photos and make fascinating slideshows from good photos. For example:

• **Image optimization**: Typical errors (exposure, color, redevye, etc.) can be easily fixed using the "1 click" effect. Picture size and position can be corrected, for example, by increasing the size, by rotating, clipping, levelling the horizon, etc. Each editing step is non-destructive, i.e. the original photos remain the same.

• **Transitions**: Besides the many variations for "simple transitions" (e.g. soft fades, black fades, page turn, wave, etc.), there are also complex transitions like picture-in-picture fades or thematic 3D fade series (gallery, photo table, notice board, etc.).

• **3D effect templates** to reshape subjects and have them fly through the picture.

• **1-click animations** for transforming photos into videos (jumping, mosaic, kaleidoscope, etc.).

• **Titles & texts**: You can enter text in various fonts and colors and position them wherever you want in the picture. Dynamic movement of the titles and texts are also possible (for opening and closing credits, for example).

• **Zooms & camera movements**: Zoom into picture sections, pan across the picture!

• **Decorative elements** and **superimposed videos** with cartoons, speech bubbles, costume accessories, frames, etc.

• **Multimedia opening and closing credits** with video templates including sound, personal texts, and motifs.

• **Dubbing**: Theme-related background music for every occasion is included. You can import your own CDs and MP3s directly. The integrated MAGIX Soundtrack Maker is used for quickly composing your own background music from musical templates. The recording functions enable individual spoken commentary via microphone. Multiple options for sound optimization enhance and unify all sound elements in one coherent audio track.
Present & share

MAGIX PhotoStory on CD & DVD 10 provides very flexible options for presenting and sharing your slideshows. For example:

- **Burn a disc:** All standard disc types for playback on DVD players and PCs can be created: Video DVD, (S)VCD, miniDVD, TV-JPEG disc.
- **DVD menus:** Interactive DVD menus are created automatically. Uniquely customizable templates with intros, animated buttons, 3D titles, and music are included. When designing the menu you can directly access the motifs of your slideshow.
- **TV formats:** All TV formats are supported: standard (4:3), widescreen (16:9), PAL, NTSC.
- **Data archiving:** Original photos and project backups can be archived to CD or DVD, including playback software which can play the data archive immediately on any PC.
- **Presentation on a free website:** MAGIX Online Album and MAGIX Community provide comprehensive options for presenting your works to the public online or just to your friends. And all of it comes for free on your own website which can be created and designed with just a few clicks.
- **Integration into your own website:** If you already have a website, then you can also integrate your slideshow into it. To do so, there are a number of video formats available (e.g. WMV or Flash™).

Also in the Deluxe version

- **More elements and templates:** Transition variations, 3D fade series, 3D effects, 1-click animations, decorative elements, opening and closing credits, movieshow themes.
- **3D design & 3D animation:** Freely reshape or rotate photos in front of various backgrounds, have pictures spin through space or distort them.
- **Single frame capture** for video camcorders and webcams (e.g. for cartoons).
- **MAGIX Music Editor** for detailed sound editing.
- **MAGIX Print Studio** for CD/DVD cases, labels, photo calendars, and much more.
- **MAGIX Xtreme Photo Designer 6** for detailed image editing.
- **Thematic background music** and dubbing sounds.
- **Picture-in-picture animations:** Create breathtaking collages.
- **Interactive, high-resolution PC slideshows:** Present your slideshows with menus directly on your PC.
- **Automatic volume reduction** during voice-overs and speech.
- **Blu-ray Disc** support.
- **and much more**
Overview of the program screen

After starting MAGiX PhotoStory on CD & DVD 10 you’ll see the following display:

1. **Menu Bar** (view page 154)
2. "Slideshow" interface (view page 36) for creating and editing your slideshows.
3. "Burn" interface for burning slideshows to disc.
4. Use "Output" dialog for all other slideshow uses.
5. **Media Pool** for navigating through the folders of your computer.
6. **Video monitor** with universal preview function so that you always see what the effects and settings do.
7. Video monitor **transport bar**
8. **Buttons** for quickly toggling between the three screens: Overview mode (view page 43), Timeline mode (view page 46), and Storyboard mode (view page 44).
9. **Arranger (Storyboard mode)**: All the pictures of your slideshow are shown here including preview photos.
Information on special program versions

This documentation describes the full functionality of MAGIX PhotoStory on CD & DVD 10 Deluxe. If you are using the classic version of MAGIX PhotoStory on CD & DVD 10, some special features may not be available.

Keyboard shortcuts

Media Pool

Delete file Del
Copy file Ctrl + Ins
Insert file Shift + Ins
Rename file Alt + R
New folder Ctrl + P
Options P
Help F1

Select files:

Select multiple pictures listed in sequence: "Shift" + click on the first file and then click the last file in the list to be selected.

Select multiple images individually: "Ctrl" + click on the corresponding pictures

Select all pictures in the folder: Ctrl + A

Slideshow

Load/Save project

New project Alt + Ctrl + N
Load project Ctrl + Alt + O
Save project Ctrl + Alt + S
Save project as... Alt + Shift + S
Delete project Alt + Shift + O
New slideshow Ctrl + N
Load slideshow Ctrl + O
Load restoration slideshow Alt + O
Save slideshow Ctrl + S
Save slideshow as... Shift + S
Close slideshow Shift + O
Delete slideshow Shift + I
Burn backup copy to disc Alt + Shift + R

www.magix.com
**Recording**

Audio recording R

**Tools**

Select all (not in Storyboard mode) Ctrl + A
Cut Ctrl + X
Copy Ctrl + C
Insert Ctrl + V
Undo Ctrl + Z
Restore Ctrl + Y
Delete Del
Photo overview O
Slideshow Maker W
Optimize photo Shift + X
Audio cleaning Shift + W

**Cut**

Split object T
Remove object beginning Ctrl + T
Remove object end Shift + T
Split slideshow Alt + T

**Effects**

Edit photo Shift + Y
Zoom 2 Ctrl + Alt + 1
Zoom 3 Ctrl + Alt + 2
Free zoom selection Ctrl + Alt + 3
Fix image proportions Ctrl + Alt + 4
Reset cropping Ctrl + Alt + 5
Pan left -> right Ctrl + Shift + A
Pan right -> left Ctrl + Shift + B
Pan top -> bottom Ctrl + Alt + V
Pan bottom -> top Ctrl + Shift + D
Zoom out Ctrl + Shift + E
Zoom in Ctrl + Shift + F
Reset movement Ctrl + Shift + G
Rotate left Ctrl + Alt + F
### Introduction

- **Rotate right**: Ctrl + Alt + G
- **Rotate 180 degrees**: Ctrl + Alt + H
- **Transition (length)**: Alt + I
- **Apply transition to all**: Alt + A
- **Random transition**: Alt + Z
- **Mirror horizontally**: Ctrl + Alt + A
- **Mirror vertically**: Ctrl + Alt + B
- **Horizontal symmetry**: Ctrl + Alt + C
- **Vertical symmetry**: Ctrl + Alt + D
- **Kaleidoscope**: Ctrl + Alt + E
- **Color shift 1/2/3**: Shift + 1/2/3
- **Title Editor**: Alt + Shift + T
- **Reset video effects**: Ctrl + C
- **Object properties**: Ctrl + E

### Arrangement display

- **Switch Storyboard/Timeline mode**: Tab
- **Optimize grid view**: Shift + B
- **Zoom 1 frame**: Ctrl + 1
- **Zoom 5 frames**: Ctrl + 2
- **Zoom 1 sec**: Ctrl + 3
- **Zoom 10 sec**: Ctrl + 4
- **Zoom 1 min**: Ctrl + 5
- **Zoom 10 min**: Ctrl + 6
- **Zoom range from start to end marker**: Ctrl + 7
- **Zoom the entire slideshow**: Ctrl + 8
## Playback and marker placement

<table>
<thead>
<tr>
<th>Operation</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/Stop playback</td>
<td>Space bar, ↑</td>
</tr>
<tr>
<td>Stop at position (stop playback, move start marker to current position)</td>
<td>Escape, ↓, 0 on the number pad</td>
</tr>
<tr>
<td>Move start marker to the beginning</td>
<td>Home</td>
</tr>
<tr>
<td>Move end marker to the end</td>
<td>end</td>
</tr>
<tr>
<td>Slow wind left</td>
<td>Left</td>
</tr>
<tr>
<td>Slow wind right</td>
<td>Right</td>
</tr>
<tr>
<td>Fast wind left</td>
<td>Ctrl + Left</td>
</tr>
<tr>
<td>Fast wind right</td>
<td>Ctrl + Right</td>
</tr>
<tr>
<td>Full screen playback</td>
<td>Alt + Enter</td>
</tr>
</tbody>
</table>
Quick start

Disc projects, slideshows, and photos

MAGIX PhotoStory on CD & DVD 10 allows you to work with disc projects, slideshows, and photos. In order to work quickly and intuitively, it is important to know the differences between these three hierarchically-ordered terms.

Project

A project includes everything that you want to put on your CD and DVD. This normally contains one or more slideshows and includes a menu structure/menu design which allows you to choose a slideshow later on the CD or DVD. Projects can be saved as "<Projektdatei>" files on your hard drive and can be loaded later, e.g. to edit individual slideshows.

Slideshow

A slideshow is a multimedia presentation of photos which is played like a film. Enjoy it on a PC or TV, since it offers maximum multimedia entertainment value from your photos, videos, music, title texts, transition effects, and much more.

Any slideshow can be exported individually as a video. The "project" can be considered a type of drawer into which you can put multiple slideshows for burning to CD or DVD later.

Easily

Photos are the main component of a slideshow! Integrate photos and videos into your slideshow (provided that the corresponding video codec is installed on your system). Besides photos and videos, a slideshow also includes plenty of other elements: image titles, transitions, decorative elements, music, spoken commentary, and so on.

Summary: "Projects" contain slideshows, and slideshows contain photos. A project’s slideshows appear as menu entries, photos (and videos) appear later on the CD or DVD as selectable menu entries.
Create a new slideshow with the wizard

The wizard helps you quickly and easily create great slideshows.

Start MAGIX PhotoStory on CD & DVD 10 and select "Create new project with wizard". Then confirm the selection with "OK".

The wizard will now lead you through the steps required for creating a new project.

**Note:** The slideshow wizard can be opened via "File (view page 155)" in the "Wizards" submenu.

**Basic settings**

Specify the ratio for the project. You can also determine how MAGIX PhotoStory on CD & DVD 10 should behave with photos that do not match the project’s formatting.

**Cut to fit screen automatically:** Images that do not correspond to the project’s ratio are adjusted automatically. The zoom factor is set in such a way that there are no black bars to the left or right or top to bottom.

**Project name:** Give your disc project a name. This name will be used as a preset title for the disc you are going to burn. The slideshows will also be given this name.
Disc format (capacity display): Set the disc type you prefer here. MAGIX PhotoStory on CD & DVD 10 estimates how much space a disc project will occupy on a corresponding blank disc. This display can be found below the slideshow.

Load photos

Select photos via "Load files..." that should be added to the project. "Delete" removes the selected photos from the list. The sequence of photos can be specified via drag & drop.

Display time for each photo (seconds): By default, photos are displayed for the time entered here. Of course, you can later change the time each photo is displayed.

Total length of slideshow: The approximate total length of the slideshow created is shown here. It adjusts to reflect any changes that are made.

Note: If you load more than 100 photos, the wizard will suggest creating more than one slideshow. Then, the photos will sorted according to creation date using so-called EXIF files, if present. Otherwise, the file date will be used.

Specify effects

Simply select one of the styles that best suits the theme of your slideshow. If you don't want any effects, then select the entry marked "No effects".

More information about effects settings can be found in "Slideshow Maker".

Select background music

You can select between the suggested pieces of music or one of your own by importing it into the list via "Load file(s)". If the slideshow is long enough, then all of the pieces contained in the list will be loaded into the photo one after the other. The sequence of songs can be specified via drag & drop.

Play: This button provides a preview of the selected song.
Remove: This deletes the selected song from the list.

Finishing a new slideshow

One click on "Finish" is enough for the wizard to create the slideshow. You now have the option to watch your slideshow before you accept it.

Manually edited slideshow: The slideshow created can be edited further however you want.

Add a DVD menu to the slideshow and burn it: MAGIX PhotoStory on CD & DVD 10 now switches to the "Burn" screen. The slideshow can be fitted with a DVD menu and burned to DVD.

You can now select how you would like to continue and then end the wizard.

Designing slideshows

Sorting Photos

You should also sort the slideshows correctly. A good slideshow needs a good story that develops along the image sequence including a middle section and an end as well as a dramatic tension that forms the frame for these parts.

That’s easy with a holiday photo slideshow. The tension is already there. It starts with pictures of the departure and then shows pictures of your arrival at the hotel and then the first adventures ...

A good vacation comes with a natural drama that results from the chronological order of the events. This is not necessarily the case for other slideshows; in this case you should consider the order in which you would like to present the photos. The problem with sorting also depends on the purpose for which you have created your slideshow.

Sorting the photos is easy:

• Drag each photo from the photo bar and drop it on the correct position.

You can’t select several photos and sort them simultaneously in the Storyboard. You should switch to Overview mode.
In Overview mode you can use the whole screen to sort your photos.

- Click on the top switch in the bottom left corner to open Overview mode.

- You should maximize the overview to get the best possible overview.

- If not all photos fit into the list you can use the zoom to reduce the size of the display:

Overview mode is the ideal view mode to arrange all photos perfectly for a slideshow. You also may select multiple photos and move them at once.

**Start and end markers**

The section between the start (S) and end marker (E) above the storyboard or the first track of the timeline will be played back in your show each time.

The start and end markers can be moved in different ways by using the mouse. You can move them to any position with drag & drop or directly with a mouse click: Left clicking in the timeline moves the start marker, and right clicking moves the end marker.

The cursor is a red vertical line which moves from left to right during playback to show the current playback position.
If you want to see play back your show, press the space bar or start the slideshow via the transport console below the preview window.

Editing slideshows
MAGIX PhotoStory on CD & DVD 10 provides many different editing functions. Let's start with Storyboard mode:

Each preview photo has several settings for duration, fades, effects, and text.

- **Set display time:** By double-clicking on the time display below the preview image you can access the input dialog where you can manually enter the display digitally or by using the slide control.
- **Add title and text:** Titles (subtitles, opening/closing credits, for example) easily can be added to every photo by clicking on this button.
- **Fades:** The transition (fade) buttons are situated between the photos. You can now preview the available fades, try them out and see the result immediately in on the preview monitor.
- **Picture editing:** Press the "FX" button on the photo box to access the effects and image processing tools which can be used separately on each photo, e.g. optimizing image quality.
- **Rotation:** If a photo is on its side or upside down, then click on the symbol with the rotating arrow. The photo will rotate 90 degrees. You can check the effects directly on the Video Monitor.

**Tip:** For editing complete photo folders (as preparation for import into MAGIX PhotoStory on CD & DVD 10), we recommend MAGIX Photo Manager. This program is also installed automatically and can be used for quickly previewing and easily managing files in your database, besides image optimization.
For more complex single-image editing like photo panorama and photo filter effects, the Deluxe version comes with a separate image processing program, MAGIX Photo Designer. Users of the classic version can download the software at any time for free. To load a photo into MAGIX Photo Designer, select the option “Edit photo” in the FX menu of the photo box. Read more on this in the MAGIX Photo Designer help.

**Dubbing:** If you would like to add spoken commentary to your slideshow, then use the record function for audio recording. A click on the record button (red dot) indicated in the transport console opens the record dialog. You can also use audio CDs, records, or tapes. Audio CD tracks of non-copy-protected CDs and other audio files can be dragged onto the preview photo directly from the Media Pool.

**Timeline mode:** Timeline mode displays your photos "time-wise". The longer the object remains in the track, the longer the corresponding photo will be displayed during playback. Videos also can be used.

The easiest way to access the Timeline mode is via the Tab key (you can also click on the corresponding link at the left-hand border of the photo bar).

Four tracks are available here:

- The first track contains photos or videos of the current slideshow.
- The second track is the audio track for narration and sound effects.

**Note:** All audio material that you add to the second track directly below your photos and videos will be attached to the corresponding photo and video material. If a picture or video already has sound material attached to it (sound-in-picture support), it will be made visible in this track automatically.

- You'll find the tracks on the third track. They can be created by pressing the Title Editor button in the toolbar and entered directly in Timeline mode.
- The fourth track is for background music. The audio material of this audio track can be moved within a project any way you like.

www.magix.com
The objects on the tracks can be re-sized using their lower edge "object handles". Move the mouse over one of the lower corners of the object until the mouse pointer turns into a double arrow. You can now compress the object as much as you like until the desired length has been reached. An object can be faded in or out with similar handles at the top of the object. This also applies to text and audio objects in the timeline.

**Cut slideshow or objects**

A simple cut can also be achieved by pressing the "T" shortcut key, or by using the symbol to the right of the transport console.

**Hint:** Cuts are always made at the point where the red line is located.

The arrow next to the cut button opens a selection menu with the following options:

**Split object ("T")**: This command splits the object at the position of the start marker to produce two separate objects. You can also just press "T" on the keyboard for this action.

**Remove object beginning**: This command cuts the object at the point where the start marker is positioned and deletes all material that precedes the start marker simultaneously.

**Remove object end**: This command cuts the object at the point where the start marker is positioned and deletes all material that comes after the start marker simultaneously.

**Split slideshow**: This command splits the slideshow at the position of the start marker into two independent slideshows. Both appear in the menu underneath the preview window in the "slideshow" area.
Creating CD/DVD menus

Create multiple slideshows

You can burn multiple independent slideshows together onto one disc. A new slideshow can be created in the same project via "File -> New -> Slideshow". You can switch between the individual slideshows via the arrow on the slideshow button in the arranger.

You can also embed slideshows from an existing project into your project. Select "File -> Open", find the desired project on the hard drive, and then click "Open". MAGIX PhotoStory on CD & DVD 10 will now ask you if you would like to close the current project or add a new project. Choose the latter to embed the slideshows into your project.

To remove a slideshow, switch to the corresponding slideshow described above and select "File -> Manage slideshow -> Remove slideshow".

Menu view and menu navigation

In the "Preview" view in the "Burn" screen you can access only complete menu templates. In order to see the advanced menu tools for editing menus, switched into the "Edit" view.

MAGIX PhotoStory on CD & DVD 10 automatically adds graphical selection menus to your slideshows. The menu is also burned to disc and appears when inserted into your player. Just like with a purchased DVD, you can easily select your slideshows with the help of preview pictures, or access particular chapters within a slideshow.
At the center of the monitor you can see a preview of the selection menu. All slideshows appear in the uppermost entries, all photos appear as sub-entries. Use the dropdown menu to the top left to deactivate the menus entirely or only work on the slideshow entries.

Use the "Navigation" section in the "Edit" tab to access the structure of the selection menu.

Here you can switch off all photos that should not be in the photo menu. Simply deactivate the corresponding box.

This way, the entry will be removed from the menu only; the related photo will not be removed from the slideshow. (More than 99 ticks cannot be made as the DVD player cannot list more than 99 entries.)

In the lower section of the screen you can find a whole row of pre-made menu layouts. Use the scroll bar to view each template. There are plenty to choose from:

www.magix.com
• If you wish to fully apply a template, first click on "Templates" in the template bar and double-click on the template of your choice. The complete template will then be applied.

• You can also combine the various elements of the individual templates. For example, if you want to combine the text format of a template with the background of another one, then select "Font" first and double click the template with the text of your choice. Then select "Buttons" and double click the button you like. The preview in the middle shows you the results immediately.

• Double click the preview picture or a menu entry to change the film or chapter name and select a different preview picture.

• Back in the "Preview" view you can use the virtual remote control to test the behavior of finished discs to make sure that everything works as planned.

More disc types

You can access disc selection options by clicking the "Burn disc" button:

In the disc selection dialog, you have to click on the "More options" button to view all available disc types at a glance:

• The disc projects that you can play in the DVD player to enjoy on TV should be burned onto a DVD, (S)VCD, miniDVD, or JPEG disc.

• Disc projects meant for presentation on your PC should be burned as slideshows or high-definition slideshows (WMV HD).

• In the Deluxe version, you can also burn disc projects for high-resolution PC monitors. The formats WMV HD or Blu-ray disc are provided for this purpose.

• In the Deluxe version, there is the disc type that can do anything – Playback a slideshow on TV or PC as well as full project backup: the multidisc. The multidisc combines slideshows for playback on a DVD player and on the PC in the WMV HD format as well as the full project backup of all photo, video and music files.
Ideally, hover the mouse over the buttons for a moment to view the popup information, and then read important information on the corresponding disc type.

Edit Fotoshow

Video monitor and transport control

Select the slideshow window to load photos and edit your slideshow.

Use the video monitor to preview the current slideshow. The "Fullscreen" button switches to fullscreen playback. Press the "Esc" key to return to normal playback. The transport console can be used to start playback of the slideshow. This is located below the video monitor.

Play/pause: The "Play" button in the middle starts playback of the slideshow, i.e. the range between the start and end markers is played
back as a loop ("infinite", recurring). Clicking the play button a second time pauses playback.

**Stop:** The "Stop" button ends playback.

**Back:** This button moves the start marker to the previous picture. This is then displayed in the video monitor. During playback, press this button to go back.

**Forwards:** This button moves the start marker to the next picture. The image is immediately visible in the video monitor. During playback, use this button to move forwards in the slideshow.

**Note:** You can fast-forward or rewind using the cursor (arrow buttons) on your keyboard. Try this out together with the additional functions of the "Ctrl" and "Shift" keys.

**Back to start:** Use this button quickly move the start marker to the beginning of the slideshow.

**Record:** The "Slideshow" window provides a single frame capture (Deluxe version only) feature or an audio recording feature. Single frame capture enables you to make single snapshots from analog video sources. Audio recording inserts new sound material at the position of the start marker, e.g. commentary.

**Stereo3D** (Deluxe version only): This sets the mode for stereoscopic playback. More information is available in Stereo3D (view page 106).

Use the position slider to move quickly within the project. The current position of the playback marker is displayed numerically on the right.

**Cut button and editing menu**

The cut button and cut menu next to it can be found on the right beside the transport console.

Use the cut button to cut a selected object in two at the position of the start marker.

With a click on the small arrow beside the cut button you can access the cut menu which contains further relevant commands.
Split object
This command cuts a scene at the point where the start marker is positioned. This way, two free-standing objects are created.

You can isolate a part of an object in order to delete it:

1. Place the start marker where you’d like to have it by left clicking in the timeline.
2. Select the video object by clicking on it and click on the cut button.
3. Place the start marker at the end of the part you wish to remove and click on the cut button again.
4. Select the middle object that was created and press the "DEL" key.
5. Pull the object at the back to the front; it should automatically snap into place. All subsequent objects will be moved along in unison so that no gaps appear.

You can also use this function to apply effects to a certain part of an object only.

Keyboard shortcut: T

Remove start
This command cuts a scene at the point where the playback marker is positioned and removes the material before the playback marker.

Keyboard shortcut: Z

Remove object end
This command cuts a scene at the playback marker position and removes the material behind the back marker.

Keyboard shortcut: U

Split slideshow
This command splits the slideshow at the point where the start marker is positioned to make two separate slideshows.

Note: You can use this function if you wish to include photo menus and if your slideshow already contains over 99 photos. Otherwise, only every second or third photo (depending on the number of photos) appears in the photo menu, since the number of menu entries is technically limited to 99.

Keyboard shortcut: Alt + T
Zoom in video monitor

The video monitor includes a zoom function for zooming into a certain position for editing, e.g. to select colors exactly.

Keyboard shortcut:

- Zoom: "Ctrl" + mouse wheel
- Reset zoom (100%): "Ctrl" + double click
- Move section with the mouse: Ctrl

Note: The zoom function is not involved with section selection, but is only a view option and is not included during export or burning!

Media Pool

The Media Pool is a central and important element in MAGIX PhotoStory on CD & DVD 10. It offers a series of functions like loading media objects, improving picture quality, design, etc.

Toolbar

Important editing and effect menu commands are available as buttons on the slideshow window. There are different buttons available for each mode.

Top Toolbar

This toolbar lies directly under the menu or the video monitor of the MAGIX PhotoStory on CD & DVD 10.

New project

This menu item creates a new MAGIX PhotoStory on CD & DVD 10 project. You can also open this feature via the "New project" button above the video monitor.

Keyboard shortcut: Shift + N

www.magix.com
Load project
This menu item loads a previously saved MAGIX PhotoStory on CD & DVD 10 project. Please note that the related files must be accessible.

MAGIX PhotoStory on CD & DVD 10 searches for the used sounds, pictures and videos under the path to where you last saved the disc project.

Keyboard shortcut: Ctrl + O

Save project
The current disc project is saved with the name displayed in the project window. If you have not yet specified a name for your project, a dialog will open wherein MAGIX PhotoStory on CD & DVD 10 asks you to do so.

Keyboard shortcut: Ctrl + Alt + S

All modes
The following buttons are visible in all modes of the "Edit" screen.

Slideshow Maker
This is where to open Slideshow Maker.

Undo
You can undo the last steps you made. This means that you can easily try out critical operations. If the result does not meet your expectations, then you can simply "undo" it and return to the initial status.

Keyboard shortcut: Ctrl + Z

Restore
The "Redo" function undoes the previous "Undo" function.

Keyboard shortcut: Shift + Y

Delete
This command deletes the selected photo (or selected object) in Timeline mode.

Keyboard shortcut: Del
Exchange object

Replaces the selected object with an object selected in the Media Pool. Length adjustment moves the objects following it correspondingly.

If photo objects are removed/exchanged, then the display duration will remain.

Also in Timeline mode and Overview mode

The buttons listed here are also visible in the Timeline mode and Overview mode.

Cut

This function deletes the selected photo (or the selected object in the Timeline mode) and copies it to the clipboard. You can then use the "Paste" command to copy it into any slideshow.

Keyboard shortcut: Ctrl + X

Copy

This command copies the selected scenes (or the selected object in Timeline mode) to the clipboard. From there you can paste it into any other slideshow using the "Paste" command.

Keyboard shortcut: Ctrl + C

Paste

Insert

This command inserts the clipboard material (photo or object) at the current position of the start marker.

Keyboard shortcut: Ctrl + V

Title editor

Title Editor (More Informationen can be found in the section "Title editor" on page 96)

Keyboard shortcut: Ctrl + T
Optimize grid view

The start and end markers are moved to the start or end so that all scenes are visible and the complete film can be played. Zoom is also set to 100% so that all objects are visible.

Keyboard shortcut: Shift + B

Only in Timeline mode

The following buttons are found exclusively in Timeline mode.

Optimize photo

*Optimize photos* (view page 85, view page 58)

Keyboard shortcut: Shift + I

Mouse mode for individual objects

This mouse mode for individual objects enables free positioning of individual objects.

Intelligent mouse mode

Intelligent mouse mode moves all objects together located behind the one selected.

Edit bitmap externally

Graphics files (BMPs or JPEGs) can be edited in MAGIX Photo Designer via the "Edit" button.

The selected image file is loaded automatically and, once editing has been completed, is used in the MAGIX PhotoStory on CD & DVD 10 instead of the original material.

Only in overview mode

Rotate 90° to the right

This button turns the selected photo 90° to the right.
Start and end markers

The range between the start and end markers is played just above the first track.

The start and end markers can be moved in different ways using the mouse. You can move them to any position with drag & drop or directly with a mouse click. A left mouse click in the timeline moves the start marker, and a right click moves the end marker.

The play marker is a red vertical line which moves from left to right during playback. It indicates the current play position.

Note: The start marker can also be shifted using the arrow buttons on your computer keyboard. The "Forwards"/"Back" buttons on the transport console move the start marker to the next or previous picture, which can then be seen immediately in the Video Monitor.

Mute sound

Shuts off the entire audio playback is temporarily. This only affects the preview, not the disc that is finally produced. This button is located below to the right in the program window.

Overview mode

"Overview mode" is a special slideshow viewing mode that provides clarity and maintenance of the photos. All photos are listed one after the other (in multiple lines, just like in a text program) and can be copied, cut, moved, deleted, and inserted.
As usual, a double click on a photo opens the Optimize video dialog.

There are no start, play, or end markers in Overview mode. The photo that is to be played is fitted with a border so that you can see where the photo that is currently playing can be found.

This slider specifies how large the photos will appear in the storyboard. The smaller the photos, the more you’ll be able to fit on screen.

Use this button to maximize the overview mode to fullscreen.
Storyboard mode

What is the Storyboard mode?

Storyboard mode is used to view the layout of slideshows. All photos are displayed in linear sequence with preview images. It includes different buttons, text, effects, rotation, time settings, and transitions.

Click "Text" to open the Title Editor. It allows you to enter captions such as subtitles and credits. You can enter text for subtitling or opening/closing credits.

They can be displayed in all kinds of fonts and colors. Your can have your credits scroll down the screen – just like in the movies! Many other text movements are also available from the template menu, such as effects and designs.

Effects: In the Effects menu (or by clicking on "FX") you can select the effects for editing sounds and images.

You can use the "Edit photo" option to open the photo in the separate image editing program MAGIX Photo Designer. After editing the image is transferred directly to the MAGIX PhotoStory on CD & DVD 10 storyboard.

Hint: For more info on using MAGIX Photo Designer, please read its Help file which you can open by pressing the "F1" key.

Rotate: If a photo is on its side or upside down, then click on the Rotate button.

The photo will rotate 90 degrees. You can control the effect directly on the video screen.

www.magix.com
Playback: The range between the start and end markers in the upper half of the storyboard is the section which will be played back. Both markers can be moved with the mouse (or they can be placed with the left and right mouse buttons). Use the space bar to start and stop playback most effectively. Of course, you can also control the playback functions by using the transport control below the preview monitor.

Playback marker: The playback marker will show which photo is currently being played along a horizontal line that runs from left to right over the scene. Dependent upon how long a photo is shown, the speed of the playback marker will vary.

Transitions (Fades): You can also set up the transitions from one photo to the next by mouse clicking on the symbol. A menu will open for you to select different transitions (view page 80).

Menus: In addition to the regular menus there are two more special menus for special tasks.

- Below the video monitor you can use the "slideshow" flip menu to toggle between the slideshows and the current disc project.

The Edit button next to the playback functions offers various options for cutting. Here it is important to observe the difference between "cutting objects" and "separating slideshows":

- "Cut object" cuts the photo (including all subtitles and additional audio or video material) and thus raises the number of current photos by one.
- "Separate slideshow" splits the current slideshow at two positions of the start marker into two separate slideshows.
Timeline mode

What is Timeline mode?
The easiest way to switch to Timeline mode is by clicking on the Timeline mode button in front of the Arranger.

In Timeline mode your photos are displayed in order: The longer the object remains in the track, the longer the corresponding photo will be displayed during the slideshow. Unlike Storyboard mode, the speed of the playback marker does not change during playback. You also have direct access to all media files currently being used in the slideshow.

Timeline

The progress of the slideshow in the movie is displayed horizontally above the tracks. To structure this progression, the actual timeline is visible at the very top above the first track. The unit of measurement of the timeline is milliseconds.

The range between the start and end markers in the timeline is played back as an endless loop.

Tracks
There are 4 tracks in total for loading, arranging, and editing media files via drag & drop or double-click from the Media Pool:

- The first track is for the photos, but videos can also be loaded.
- The next track is for the audio track of videos and for the frames. Additional audio recordings (so-called overdubs) are placed here (commentaries, for example).
- The third track contains the titles (which can be created via the buttons "Text" in Storyboard mode) and style elements. These can also be added via the Slideshow Maker.

www.magix.com
- The fourth track is for additional sound material, i.e. everything you may wish to add to your photo via drag & drop from the Media Pool. Additional audio recordings (so-called overdubs) are placed here (commentaries, for example).

**Volume curves**

Volume on tracks 2 and 4 can be automated. This is achieved using so-called volume curves.

![Volume curve example](image)

*A typical volume gradient for damping background music during a spoken commentary.*

- In context menu of tracks 2 or 4, select "Volume curves".
- Double click the curve to set an automation point.
- Two automation points are required for a simple volume curve (start and end points).
- Curve points can be easily moved via drag & drop, during which the mouse cursor turns into a cross.
- An additional double click on an automation point deletes it.

**Hint:** During audio recording, volume curves can be automatically created if the Volume damping ("Ducking") (view page 75) option is activated.

**Zooming**

**Keyboard shortcut:** The easiest way to zoom is by using the key combination "Ctrl+Page Up" (zoom in) and "Ctrl+Page Down" (zoom out).

**Zoom menu:** Right clicking on the start marker opens the context menu where you can select the most important zoom levels.

**Zoom-enabled sliders:** Use the slider ("fader") to set up the visible clip on the horizontal time axis.
You can tell which part of the entire arrangement is being played by the size and position of the slider. In the full view, the zoom sliders take up the entire sliding space. The full view can be accessed by double clicking on the slider.

If you move the mouse to the edge of the slider, then the cursor will turn into a stretch symbol which can be used to select and compress/stretch the fader. This way you can zoom in and out quickly and it isn’t confined to a set number of steps, but is continuous.

Exact zoom levels can be selected by right clicking on the fader or on the start marker via the context menu. Here you can also jump to certain positions in the arrangement.

**Grid**

The snap grid ensures that the objects always "snap" to certain points so that they can be positioned precisely according to the beat. Two consecutive objects will seamlessly snap together, even if they are on different tracks. This prevents undesired gaps or overlapping objects.

**Objects**

Sound and picture tracks are displayed as separate objects and are edited independently of one another.

Sound material is displayed as a wave form. Where there’s something to see, there’s something to hear. Picture material appears with regular preview pictures as an object in the track.

All objects can be cut uniformly, edited with effects, and arranged any way you like. During playback, all objects on all tracks are mixed together automatically. When moving a photo, all related objects will be moved along with it (audio recordings, frames, and text objects, for example).

**Object cutting and fades**

All objects can be re-sized with their lower edge "object handles". Move the mouse over one of the lower corners of the object until the mouse pointer becomes a double arrow.

You can now stretch the object as much as you like.

At the top ends of every object you’ll find two fade handles that can be adjusted to fade an object in or out.
Adjust brightness/volume
Using the brightness/volume handle located centrally at the top of the object, you can adjust the volume of audio or MIDI objects or the brightness of video and image objects. Simply drag the handle either up or down.

Even if several objects are playing simultaneously, the volume or brightness of individual objects can still be altered.

Select objects
To edit or delete objects using the menus, you must first select them. To do so, simply click on the object you wish to select. The handles of selected objects change color to show that the accompanying object has been selected and can be edited using the menu functions or with effects.

Context menu
Right clicking on an object opens the context menu with effects. You can now use the same Effects as in Storyboard mode.

Duplicate objects
Small objects (for example, audio loops) can be duplicated very easily. First, the objects that need to be duplicated must be selected. Activate the copy command and then the Insert command ("Edit" menu or via the buttons in the Timeline mode).

Speed up this process by clicking on the object to be copied with the mouse while holding down the "Ctrl" key. This generates a copy which you can immediately drag to the desired position.

Mouse modes
With these mouse modes you can specify various working methods of MAGIX PhotoStory on CD & DVD 10 when moving objects.
Mouse mode for individual objects

This mouse mode for individual objects enables free positioning of individual objects.

Intelligent mouse mode

Intelligent mouse mode moves all objects together located behind the one selected.

Media Pool

The structure and workflow of the Media Pool is similar to that featured by Windows Explorer; however, the difference is that only the used files are displayed. This is used to access and load multimedia files of all kinds: video files, audio files, fades, effects, and also complete projects.
Media

Navigation buttons

The navigation buttons let you navigate through your computer’s drives and folders.

Forward/Back  The "Back" button always returns you to the folder where you were previously.

Upwards  The "Up" button brings you to the next highest folder level.

Browse history list and path details

The current folder’s path is displayed in the top center.

Use the arrow button to open the menu to find the folders you previously visited.

Options

All functions of the context menu (switch views, rename, or delete files, etc.) can also be accessed via the options button.

Display options

Settings for how detailed the entries should be listed can be made here.

Search

The Media Pool has an easy search function for finding files on the computer. It may be activated and turned off again with the shown button.

File name: Enter any part of the name of the file you are looking for in the "File name" field. The X symbol deletes the entry. A '?' may be used as a placeholder for a single character, and '*' for any number of characters.

File type: Here you can enter a file name extension. Multiple entries are separated using a semicolon. Below the entry field, various presets may be selected for often-used file name extensions.

www.magix.com
Date: Here, you can set time period limits on your search. Choose an entry from the list.

Folder: If you don’t want to search the entire computer, but only look on certain drives or in a single folder, you can define a certain search path.

Search depth: Here you have various options that determine whether additional locations should be searched.

- Search indexed locations and the selected folder
- Search indexed locations, the selected folder and personal files.
- Search indexed locations, the selected folder, personal files and the project file.

"Indexed locations" are folders, which are searched and cataloged in Windows via the index list. If the index list is activated, the files in the indicated folders will be indexed while the computer is idling, so that the user’s search query may be completed faster.

Note: In Microsoft Windows XP, the indexing service is usually deactivated by default. The search functions in Windows Vista® may be installed with the current version of "Windows Search". They make it possible to easily add to the indexing service. Please refer to the installation instructions from Microsoft.

Computer

The link button "Computer" displays the drives in the Media Pool. All drives will be listed along with their drive letters and can be opened with a double click.

User directory

The second button featuring the user’s name opens their personal folder in the Media Pool.

My media

The "My media" button lets you select "Projects", "My videos", "My music", "My images", and "Recordings".

Projects

Switches to the folder where your projects and videos are usually stored.
**My pictures**
Switches to the "My documents\My pictures" folder. This folder is often used by digital cameras and scanners to store transferred images by default. The included MAGIX Photo Manager program also uses this folder (e.g. during image import).

**My videos**
Displays all usable files found in "My documents\My videos."

**My music**
Displays the contents of the "My Documents\My Music" folder. MAGIX Music Manager also suggests this folder for importing your music collection into the database.

**MAGIX media**

The "MAGIX media" link enables selection of "Manage...", "Database", "Online Album", and "Web import", and "Downloads".

"Manage...": This opens the management program MAGIX Photo Manager for the database. This allows you to create and organize the database accessed by MAGIX PhotoStory on CD & DVD 10.

**Database**: Use this button to open the database view. Right clicking opens the database search. The database first has to be created using the supplied additional programs MAGIX Photo Manager or MAGIX Music Manager.

**Online album**: This buttons opens MAGIX Online Album. This provides a shortcut to uploading and deleting data. To do this, you must first register on MAGIX Online Album.

There are many ways to upload data:

1. While holding "Ctrl" down, select the data to be uploaded in the Media Pool, and select "Copy" in the context menu (opened by right clicking). Switch to the MAGIX Online Album screen, open the desired folder, and select "Paste" in the context menu.
2. In the Media Pool, click on "Online Album", and go to the desired directory. Open the Windows Explorer, select the desired data with "Ctrl" held down, and drag it into the Media Pool.

Both options will result in your desired data being uploaded to your MAGIX Online Album.
**Hint:** This function requires an Internet connection. To gain access, make sure you have your log in information (email address and password) ready.

**Web import:** You can open MAGIX PhotoStory on CD & DVD 10's integrated browser (view page 55) here. It offers you the possibility to collect media from the Internet to use in the current project.

**Downloads:** Use this button to access the media files that you downloaded with Catooh (view page 219).

**Integrated browser**
The integrated browser offers many useful functions that help you collect material for using in your project. All kinds of media can be collected – images, videos, sound or simply text can be all integrated using the built-in browser with great results.

**Tip:** You must have an Internet connection to use the full range of options offered by the integrated browser.

**Open browser**
The integrated browser opens in the Media Pool (view "Media (view page 51)") via "MAGIX Media -> Web import...".

**Navigation in the browser**

**One page back:** Switches to the previous page.

**One page forward:** Switches back to the page before the "One page back" button was pressed.

**Stop:** Stops loading the selected page.

**Reload:** The current page will be reloaded.

www.magix.com
Home: Returns to the home page.

In the address header, next to the navigation buttons, you can simply enter an Internet address like http://www.magix.com. Press the enter button and the corresponding page will be loaded.

Loading Internet media
The buttons described here are used to collect and load media directly from the Internet into the current film. The corresponding functions can be found in the context menu of the browser.

Save selected text: The selected text will be saved. It can then be edited using the Title editor.

Download selected images: The selected images will be saved to your computer.

Start audio recording: A dialog for audio recording opens.

Hint: For recording from the Internet it is important that the sound card is selected as the sound source.

Define the path for saving Internet media.
To define the path for saving Internet media, simply click on the folder symbol and navigate to the desired folder. Confirm your selection with OK.

Accept media after download
This option makes sure that the downloaded media are loaded into the current slideshow right away.

Deleting, copying and moving files
All files listed in the file list can be selected, deleted, or moved/shifted (by holding down the mouse button and using drag & drop to move them) into other folders just like in Windows® Explorer. This way all objects that come into question for a movie can be compiled into a separate folder beforehand.

The selection of these functions can be executed via the context menu which can be opened by right clicking the entry.
All functions of the context menu can also be accessed via the context menu button.

**Load pictures, texts and audio files**

To preview, click on the corresponding file in the Media Pool. The bitmap/video is played in the video monitor. If you want to use the bitmap file for your slideshow, drag it to the Storyboard while holding down the mouse key or to a target track in Timeline mode. You can also load with a simple double click. Videos and graphics are always added to the end; titles and audio files are placed at the position of the start marker.

If you would like to load several files, then hold down the "Ctrl" key while clicking on the entries you would like to use.

If you would like to load a sequence of files, then hold down the "Shift" key, click on the first entry, and then on the last. All entries in between are marked.

The files are moved automatically into the tracks that have been set up for them: Videos and single frame pictures in track one, sound in the second track, text objects (titles) in track three, additional sound files in track four.

If there are a lot of files, then those already selected are highlighted in the Explorer to help you keep an overview.

**Preview**

The preview function can be used for all files. If an audio or video file is selected in the file list, the transport console switches to preview mode. The transport functions of the transport console no longer apply to the objects in the Arranger but rather to the file selected in the Media Pool. You will be able to tell this by the flashing play button in the transport console. Use this button to start the preview. Graphics and text objects are displayed immediately in the video monitor.

**Exchange object**

Replaces the selected object with an object selected in the Media Pool. Length adjustment moves the objects following it correspondingly.

If photo objects are removed/exchanged, then the display duration will remain.

**Sound in picture support**

Some digital cameras have an audio recording function and save a WAV file with each photo. The PC identifies these cameras as separate drives. The audio file is automatically included in the database overview when you import the photo from the camera.

www.magix.com
Fades

This features all fades sorted into the various categories. One click on a category displays all of the blends that are contained.

To load a fade, click it and drag it onto the object that should be faded into. Alternatively, you may select the object that you would like to fade into and double-click on Fade in the Media Pool.

Title

This displays the title settings and the title editor. These presets are sorted into different categories and may be loaded by double-clicking or drag & drop. The 3D title templates are also located here.

The text featured by title objects may be changed directly in the program monitor by double-clicking.

Effects

This provides access to the effects that are sorted into the various categories. Read more about this in the chapter "Effects".

Templates

Most effects categories contain many useful templates that can be added simply by double clicking them. A single click provides a preview.

Image optimization

Brightness & contrast
**Auto exposure**: This button automatically optimizes the exposure, contrast, and color with a few clicks. The other settings options in the dialog provide more precise results.

**Brightness/contrast**: Use the sliders to increase or reduce the brightness and the contrast of the picture.

**Gamma**: "Gamma" specifies the mean gray value provided by the various color ranges. In the preset list, select various envelope curves to edit only the dark, median, or brightest areas of the image. The fader also sets the intensity of the brightening or darkening.

**Color**

![Color settings interface]

**White balance**
All light is not the same. Depending on whether it is sunlight or artificial light, this will have an effect on color variation. The human brain is able to compensate for this variation: A white sheet of paper will still look white under candlelight, although it is in fact much more yellow than by daylight.

In order to imitate this filtering done by the brain, a camera must also analyze and correct the light. White balance does the same thing to a picture that the
brain does by setting the camera to the so-called "color temperature" of the surroundings.

If you do not possess a camera which performs this function automatically, you can apply the white balance function in MAGIX PhotoStory on CD & DVD 10.

An incorrect white balance can lead to an unnatural blue or red hue.

**Directions:** To use the white balance, click on the button to the right of the label "White balance" and then select a point which represents white or a neutral gray to the "outside world". The color temperature is then corrected automatically.

**Tip:** Cool color effects can be achieved by setting a different color as the white benchmark. There is definitely room for experimentation!

**Red-eye removal**
This photo function removes unnatural red eye that results from using a flash. Click on the eye symbol and then select the red pupils in the preview monitor using the mouse.

**Hint:** For photo optimization, we recommend you use MAGIX Photo Manager. The program is installed automatically and can be used for quick previewing and easy management of pictures from your database. It has a tool for correcting red eye and setting auto color and white balance to control discoloration in pictures.

**Saturation**
You can increase or reduce the color portions of images with the “saturation” fader. A newly developed algorithm is applied which makes color changes related to other parameters (for example contrast settings) in order to achieve the most natural coloration possible. With just a little bit of experimentation, you can achieve astounding results – anything from turning summer snapshots into autumnal scenes to funky pop art!

**Color shade**
Select a color for coloring the image from the color chart.

**Red/Green/Blue**
Using the "Red/Green/Blue" slider, you can change the color portion mix for each color.
Selective color correction (Deluxe version)

Secondary color correction allows individual colors in video and image objects to be adjusted. Choose "Selected" or "Not selected" in order to edit the desired ranges separately. The entire image may also be influenced ("Complete image").

"Selected" corresponds with the mask created, and "Not selected" involves the rest of the picture. Here's how to create a mask:

- Activate "Add".
- Place the mouse over the preview monitor. The mouse pointer turns into a pipette tool.
- Click with the pipette tool on the color that you would like to assign to the mask. Unwanted colors can be removed from the selection again by selecting "Remove" and clicking the corresponding color.

MAGIX PhotoStory on CD & DVD 10 displays the mask in black and white stripes to highlight the current selection.

- Adjust the color using the color selection slider until it is satisfactory.
Sharpness

- The fader allows you to regulate the level of image sharpness or apply a soft filter.
- "Fine adjustment" allows you to set how sharp surfaces or edges should appear. This enables you to effectively reduce image distortions (noise).

Distortion

A large palette of effects for transforming your image material is available.

Artistic filter

Erosion: The image is broken-up by means of small rectangles and resembles a "patchwork".

Dilate: This works like erosion, but uses light surfaces instead of dark ones to form the rectangle.
**Emboss** creates a relief of the image edges, in which case strong contrast differences are interpreted as edges.

**Substitution:** Using the rainbow scale red, green, and blue components are exchanged. Quickly create surreal landscapes or a green face!

**Shift:** The color values are inverted increasingly. Blue colors turn red, and green appears purple.

**Quantize:** Depending on the setting, colors are either rounded up or down so that the overall number of colors is reduced. This creates interesting grids and patterns.

**Color fill:** Using this slider, color in the video with red, green, and blue colors (the basic TV colors).

**Contour:** The image is reduced to its contours in two sizes (3 x 3 or 5 x 5). It is possible to select either vertical or horizontal contours.

**Distortion**

![Distortion screenshot](image)

**Motion:** Moving parts of the image are enhanced and warped.

**Echo:** The moving images create an optical "echo"; previous images stand still and gradually turn paler until they completely disappear.

**Whirlpool:** The image is twisted into an "S" shape.

**Fisheye:** The perspective is distorted as if the image were viewed through a fisheye lens.
Mosaic: The video is depicted as a mosaic.

Lens: The image is dynamically distorted at the edges.

Sand: The image is depicted in a granulated manner.

Kaleidoscope: The left upper corner is mirrored horizontally and vertically.

Mirror horizontal/vertical center: The object is mirrored vertically or horizontally – it appears on its side or upside down.

**Speed**

![Image of Speed settings](image)

The playing speed can be adjusted with the slider control. The range between 0 and 1 plays the video slowly; values above 1 accelerate playback. If the playing speed is increased, the object length in the arranger is automatically shortened.

Frame rate: Here you can set the video’s frame rate directly. Changing it directly effects the speed factor, while moving the knob conversely results in changing video frame rate.

Reverse: This button reverses the playback direction (with the same tempo).

**Note:** Since the soundtrack of a movie cannot be played backwards, you have to first separate the movie object from its soundtrack. The speed effects cannot be animated!
View & animation

Size & Position

Values in: Set whether the values are applied in percent or pixels.

Position

Left: Enter the start position from the left image border.

Top: Enter the start position from the top image border.

Center: Based on the current image size, the image starting points (left and top) will be positioned so that they are centered.

Note: Negative values can, of course, also be entered. The image borders will then be outside of the visible area.

Size

Width: Enter the width of the image.

Height: Enter the height of the image here.

Maximize: The image will be maximized according to the movie's resolution.

Set original size: The image will be scaled to its original size.

Retain proportions: This option makes sure that the image will not be stretched or distorted. The proportions of width to height will remain the same.
Clips can be used to:

- display just one section of the photo.
- to move the clip through the picture with the help of a movement effect – the result is a type of camera movement. Read more about this in the chapter "Movement".

In the program monitor, you can set a picture section to serve as the basis for the movement effect. Press the left mouse button and drag out the section you want to use.

This menu lets you select the format for the section.

The format of the original picture is used as the default.

**Fullscreen:** If this check box is selected, the opened section will be zoomed to fullscreen. If this option is switched off, it won’t be possible to add movement to the section.
Camera/zoom
With this effect, you can move a previously selected frame inside the image, creating an impression of camera movement or zoom.

Movement in direction
Determine the direction in which the selected section or image will move in the process during the time selected under "time period". In addition to horizontal and vertical movements, diagonal movements are also possible.

Fullscreen: If this check box is active, the opened section will zoom to fullscreen. If this option is switched off, it won’t be possible to add movement to the section.

Preview: Displays a preview of the section at the playback marker location.

Direction & time
Zoom out: The selected picture section is displayed and then zoomed out to show the entire picture according to the value set in "Time". If no section is selected beforehand, a central section of 50% of the picture will be used.

Zoom in: The entire picture is displayed and then zoomed in to show only a smaller picture section according to the value set in "Time". If no section is selected beforehand, a central section of 50% of the picture will be used.
Direction & time
The option selected here sets the position where the keyframes of each movement effect are set by default. You determine the positions where a movements begins and ends.

Note: Automatically placed keyframes may be edited retroactively, and the option will then be set to "User defined". Read the section "Change the keyframes of an effect after the fact" in the chapter "Animate objects".

Reset: This option applies a static zoom to show the selected section of the picture only.

The size and the position of the image can be roughly entered in the program monitor by simply moving the image into it and dragging on the handles. The frame of the video monitor with handles can also be moved with the keyboard.

Keyboard shortcuts for moving the edges of the frame that are visible in the video monitor:

Nudge the screen 1 pixel: Arrow keys
Nudge the screen 5 percent: Shift + arrow keys

For animated movement effects, it often makes sense to zoom out of the video monitor and use the resulting workspace to, for example, let a minimized image or text object move through the picture.

Keyboard shortcuts for the preview picture:

Thumbnail zoom in/out: Ctrl + mouse wheel
Move thumbnail: Ctrl + left mouse button + drag

See the "Animation from outside of the image" section for more detail.
This button resets all of the current settings.

**Note:** If you animated the object using keyframes, resetting will affect the entire animation. Individual keyframes can be deleted during animation.

**Rotate**

- Rotates the image on the horizontal axis.
- Rotates the image on the vertical axis.
- Rotates the image around its center point.

**Straighten horizon**

The image can be rotated around the axis via the slider. The image is automatically zoomed to avoid black edges.

**Show guidelines:** Activating this check box displays a grid in the program monitor for orientation during horizontal straightening.
**Mirror**

- Mirrors the image on the vertical axis.
- Mirrors the image on the horizontal axis.
- Rotates the image 90° clockwise.
- Rotates the image 90° counterclockwise.

**Angle & shape**

This makes real 3D positioning of images possible, letting you distort the image in space and move it. Here you can enter the individual corner points numerically or move them in the program monitor using the mouse.

This button resets all settings.

**Stereo3D in the Media Pool**

You will find the 3D functionality here.

*Note:* Please also read the corresponding chapter "Stereo 3D" (view page 106).

**Design**

**decoration**

Under "Decoration" you will find tons of choices for pepping up your movie. You will find various categories of decorative objects which serve to orient you during selection.

All you need to do is click the corresponding element and you can start playback by pressing the space bar.

www.magix.com
**Filmstrips:** With the start and end markers in the filmstrip you can specify at which point you wish the decoration to appear and when it should finish.

**Size/Position:** Here you can open an editor to set the size and position of the decoration.

**Double arrows:** A category usually contains more elements than can be seen at first. Use the double arrows to switch to the previous and next pages of each category.

**Magnetic objects**
Decorative elements in the Media Pool ("Design -> Decorations") can easily be linked to videos.

- First, select the decorative element, position it exactly, and then set the desired size.
- Next, define the size of the element and click "Follow object".
- Then sketch a frame over the moving image section, e.g. over the head of a person.

**Upright-format effects**
Here you can select individual effects that are especially made for vertically formatted photos.

**Hint:** This option does not appear for photos in horizontal format.

**Background**
MAGIX PhotoStory on CD & DVD 10 provides diverse backgrounds that can be used in many different ways. Simply drag & drop the desired background at the position you want.

**Intros/Outros:**
These are beginning and end scenes for films with various themes.

**Picture-in-picture collages**
These work similarly to normal picture-in-picture effects, but more objects are used. Depending on the collage, arrange the selected objects one after the other and drag the collage onto the first object.
Animate objects

Different kinds of animations are provided in the Media Pool. In the "Effects" tab, "Video effects" and "Movement effects" provide you with the effects that can animated using keyframes.

The following objects can be animated:

- Image objects (still images)
- Title objects
- MAGIX 3D Maker objects (3D texts)
- Video objects

Preparing animations

- First, select the object in the arranger to animate.
- In the Media Pool, open the "Effects" tab, and then click on the effect you would like to animate. Most of the effects listed here can be animated, with the exception of the "Speed" effect.
- If necessary, set up the effect however you would like it for the start of the animation.
- A timeline is located at the bottom of the Media Pool where keyframes can be set, selected, moved, and deleted.

There are two lines in the timeline to help you orientate yourself while you retroactively edit movement. These lines will help you recognize the start or end of the transition.

Note: The figure corresponds to the display in "Timeline" mode.

Set keyframes

Click the timeline to set the playback marker at the locations where a keyframe should be added.

Note: You can also use the timeline in the arranger for exact positioning.

- The button places keyframes for all parameters required in the animation.
- Additional keyframes can be added simply by placing the playback marker at the next keyframe location and changing the effect accordingly.
- The positioned keyframes can also be retroactively moved via drag & drop.
Copy keyframes
Select the keyframes to be copied by clicking them and then press the "Copy" button. Next, set the playback marker at the location for insertion and the press the "Insert" button.

Display keyframes of individual parameters
Multiple keyframes are added simultaneously to effects if they include multiple parameters.

Click the small arrow beside the name of the animated effect to display all of its parameters.

Now all keyframes of the effects parameter can be individually moved, deleted, activated, and deactivated.

Note: Only those parameters are listed which are used for the animation. As soon as another parameter is required for editing the effect, it becomes visible to you here.

Retroactively editing an effect's keyframes
Previously set keyframes can be retroactively moved and their values can edited.

Keyframes can be moved via drag & drop. Simply click on the keyframe to be moved and drag it to the desired position.

To change an effects setting for an already positioned keyframe, click the keyframe and adjust the effect in the Media Pool.

Soft movement
Normally, a hard, unnatural pan is the result of set keyframes.

This option makes sure that the progression of these movements is executed more softly and more naturally.

It lets you activate the entire parameter group as well as individual parameter curves.

www.magix.com
Delete keyframe

Select the keyframe to be deleted by clicking it.

This button removes the selected keyframe.

Record

Audio recording

Songs, noises, or instruments can be easily recorded in MAGIX PhotoStory on CD & DVD 10 using the recording function. In Storyboard mode the wave file is visible directly below the photo box.

For the recording to be correct it is necessary to connect and calibrate (view page 77) the corresponding sound sources correctly.

Recording dialog
**Add sound to entire slideshow:** Use this option to begin playback of your slideshow from the start marker while recording in order to be able to comment on each photo one after the other. The recording is cut simultaneously after every photo. This way you can move your photos after recording; the corresponding comment is moved automatically.

**Add sound to selected photo:** Use this option to play the selected photo and add text to it directly. If your audio recording lasts longer than the duration set for the photo, then the length of time for each photo is automatically extended.

**Audio driver:** Selects the sound card for the recording.

**Save audio file as/ Save file in the following folder:** Here you can select the title of the audio file you wish to record. You can also select the folder where you wish to store the file.

**Recording quality:** Sets the sound quality of the recording. In the preset menu you can choose between medium wave radio ("AM tuner"), UKW ("FM Radio"), DAT (Digital Audio Tape) and CD quality.

**Volume control:** Using the peakmeter, you can monitor the level of the incoming signal. Please read more on this in the chapter "Adjusting levels" (view page 77)

**Recording:** This button starts the actual recording.

**Stop:** Click this button to stop recording Hint: To remove noise that developed while recording, you should try out the effects in the Audio Cleaning (view page 91) dialog.

### Advanced audio recording settings

#### Driver info
Shows the name of the chosen recording device.

#### General options
- **"Mono"** can be activated for recording in mono. This reduces the required memory space in half. This is useful for spoken commentary as the microphone only communicates a mono signal.
- **"Real-time sample rate adjustment"** automatically matches the sample rate of a new file to be recorded with the sample rate of the selected slideshow (set in the video recording).
- **Automatic damping of volume levels on other tracks ("Ducking")** If you slideshow already has a well-modulated soundtrack, and you would like to
add some spoken comments or other sound material, activate "Automatic dampening of volume level on other tracks" in the record dialog. This automatically lowers the volume of audio objects in the arranger during the recording session. This is achieved using an automatically configured volume curve: Before and after the recording other tracks will be faded in or out, resulting in a homogeneous total volume level. (Lowering of volume level during spoken comments is also called "Ducking").

**Track damping options**

**Intensity of damping:** Here you can determine by how many dB (Decibels) the volume should be lowered. A signaled lowered by about 6 dB will be perceived by the human ear to be about half as loud.

**Tip:** Depending on the kind of music or original sound, different settings should be given a try. If the music is already soft, lowering by 6 dB will probably be enough; a hectic original audio track or loud rock music damping should be stronger.

**Cross fade duration [sec]:** Here you can enter, in seconds, how quickly the signal should be lowered or raised before and after the recording.

**Hint:** Volume damping can be edited later on in the track. You can read more about this topic in Volume curves.

**Connecting the source for recording**

First of all, the source of the audio material must be connected to the sound card input. Again, there are several possibilities which primarily depend on the type of equipment you have.

If you are recording from a microphone, then please connect the microphone to the microphone jack on your sound card (usually red).

If you want to record material from a stereo system, then you can use the line-out or AUX out jacks on the back of your amplifier or tape deck. This involves connecting them to the sound card input (usually red).

If your amplifier has no separate output (other than for the speakers), then you can use the connection intended for headphones for your recordings. In most cases, you will need a cable with two mini-stereo jacks. This type of connection has the advantage of being able to set the headphone input signal.
level with a separate volume. As headphone connections generally are not the best, it is advised that you use the line outputs if possible.

When recording cassettes from a tape deck, you can connect the tape deck’s line out directly to the sound card input.

When recording from vinyl records, you should not connect the record player’s output directly with the sound card because the phono signal needs to be pre-amplified. A more suitable method would be to use the headphone connection or an external pre-amp.

**Adjusting the Signal Level**

Adjusting the signal level to the sound card is also recommended to get the best sound quality during digital recording.

Once a recording source is connected to the sound card, the "Record" button opens the recording dialog and starts the recording source.

You can now adjust the recording level with the help of the LED display in the recording dialog. For this, you must first check off "Show Levels".

If the adjustment is set too high, distortion occurs and the incoming signal must be reduced. If you have connected the source through either an amplifier or tape deck output to the sound card, you can only reduce the signal level in your sound card’s software mixer interface. You can access the mixer directly from within the recording dialog via the “Recording Level” button.

If you reduce input sensitivity by using the input fader, the resolution at which the analog signal is digitized is also reduced. Try to set these automatic controllers to the loudest sound level possible.

The maximum setting for an optimal level is the loudest part of the material. The loudest part should be adjusted to be the maximum. The actual recording begins when you press the "Record" button. At the end of the recording you will be asked if you want to use the recording. Upon confirmation, the newly-recorded material will be placed at the next free position of the start maker in the arrangement.
Individual Frame Capture

Use individual frame capture to record snapshots straight from the connected video source. A DirectShow compatible video recording/TV card or a corresponding USB device (for example, webcam) is required.

Use the time control to automate snapshot recordings. This can be used in the following areas:

- For creating photo stories from videos
- Animations (stop-motion animation)
- Video monitoring
- Fast motion recordings

All pictures taken are added to the open slideshow.

**Video source:** The video card for captures can be set up here.

**Save individual frame as:** Here you can enter the title of the snapshot you wish to take. These will be saved with this name and an incremented number. You can also select the folder where the photos are to be saved.

**Resolution:** Here you can set the resolution of the recording. The resolution is based on the resolutions that the camera supports. You can adjust the picture quality using the fader. The higher the quality, the larger the file size of the individual recordings. "Reset" reverts the picture quality to its previous setting.
Advanced...: Opens the advanced settings dialog of the video driver (view page 79).

Camera noise during recording: You can check the acoustics by setting up a click sound for each snapshot.

Recording: Pressing the red record button takes the picture (or starts the recording procedure for time-delayed capture).

Time control

Photo duration in frames: Specifies how long the photo should be displayed in the slideshow.

Interval: When activated, a series of pictures are taken. Snapshots are taken automatically at the selected interval and then saved with an incremented number. If, for example, you set it up to take photos every two seconds and each of these photos is to be 5 frames in length in the slideshow, the result will be a 10-times accelerated fast motion recording.

Advanced configurations in the video capturing dialog

Here you can adjust certain settings for the video recording driver.

These dialog boxes, so-called “property sheets,” come with the video card drivers. These driver-specific performance properties may deviate depending on the cards. We also have a very limited influence on the behavior of these drivers. If you encounter any difficulties, please contact the video card manufacturer for the latest driver updates.

Input: Sets the crossbar of the video card.

The crossbar determines which video and audio input signal will be recorded. The crossbars are connected in series to the video recording chip itself. In the output field, the video output (for the crossbars) is the input for the recording chip (video or audio decoder-in) of the video card. In the “Input” field, select the signal source that will be used by the video card to capture for this input. Many video cards have separate crossbars for audio and video. If you have a problem, try out the different configurations until the right sound matches the right image.

Composite-in = the normal video input (typically a cinch jack)
S-video = S-video input (mini-din jack)
SVHS-in = SVHS input (special cable)
Tuner-in = TV signal of the integrated tuner

www.magix.com
Imagesetting

**Video decoder**: If the picture only appears in black & white or it flickers, the video standard may be set incorrectly. In mainland Europe, **PAL_B** is used.

**VideoProcAmp**: Fine-adjustment of colors, brightness, contrast etc. We recommend against changing any of the manufacturer’s settings.

**Format**: Please do not change anything here. The capturing format is set in the "Recording quality" option in the video recording dialog.

Station selection

This option is only available if a TV tuner is integrated into your video card.

Transitions (fades)

If you drag photos into the Arranger they are usually in sequence in Timeline/Storyboard mode. This is called a "hard" transition.

Transitions (fades) are a very important style tool for bringing the slideshow to life. With MAGIX PhotoStory on CD & DVD 10 there are many and diverse ways of fading between a slideshow and photos.

For the duration of a transition two scenes may be shown at once and mixed together in different ways. These are called "Transitions" or "Fades". You will find a multitude of different variations in the transitions folder in the Media Pool.

Advanced settings

There are special settings dialogs for all transitions of the first part of the menu and for the transitions in the sub-menus "3D morph" and "3D tile". These are opened with the "Settings..." button. Here you can make further adjustments depending on the type of transition. The dialogs are self-explanatory, the best way of getting to know them is by trial and error.

Transitions in Storyboard Mode

You can open the transitions menu by simply clicking on the transition symbol between two individual photos.

Here’s where you'll find all of the transitions that MAGiX PhotoStory on CD & DVD 10 has to offer. Simply select a transition.
You can also choose the **length of the transition**. "Apply to all" applies the setting to your entire slideshow. Additionally, you can set random presets for each transition ("Random Transitions") or apply the selected preset to all.

**Simple crossfade in Timeline Mode**

A simple transition can be created in the Arranger of the Timeline mode by dragging one object over another. A **crossfade** is automatically created.

Using this basic transition the brightness of both images will be added together, and then one will be faded in as the other is faded out simultaneously. The duration of the crossfade is displayed in the Arranger by white crossing lines. You can adjust the **length of the crossfade** by dragging the upper object handle of the second object to the left or to the right.

To select a transition type click on the transition symbol displayed on each selected object, and then choose your favorite from the menu.

The transition icon will change depending on your selection.

**Drag & drop onto a "hard" transition**

Click on the "Fades" button in the Media Pool. The transitions folder will now appear in the file list. Like always, clicking on a transition once will bring up a preview.

Now just drag the desired transition and drop it onto the second of two photos you want to crossfade. Only when the mouse pointer with the transition preset is placed over a scene change will it turn into an object symbol. The object at the back will be shifted to the front to accommodate the transition.

The **length** of a transition is decided by you. If a transition is shortened, it means that the resulting effect is speeded up. There are two types of transitions: vfx transitions and alpha transitions. They can be found in the Media Pool and are displayed as blue/yellow icons with the letters A/B on them.
If you have selected this type of fade, then you can access it again by clicking on the fades button in the menu and then selecting "Settings..." at the very bottom, which, in turn, opens a dialog for fade effect settings. Thus, an object's fade symbol in the Media Pool can represent an entire group of different effects.

The alpha fades (iris, objects, random, etc.) are actually pre-produced black and white videos combined with the alpha keying effect.

### 3D transitions

#### General options

3D effects offer exciting and varied opportunities to create transitions between two videos. 3D effects may be accessed via "Fades" in the Media Pool.

To achieve the most fluid display of 3D fades, the graphics card's acceleration function is used. 3D functions on graphics cards may be used via either of the software standards "Direct3D" or "OpenGL". These standards are variably supported by the respective graphics card drivers. For this reason you can switch between different fade settings for each standard.

#### Settings

The fade settings enable the behavior and appearance of the 3D fades to be influenced. Click the corresponding fade symbol for the object and choose "Settings" to do this.

The following options are available:

**Anti-aliasing:** The edges of three-dimensional objects often produce unpleasant step effects. Anti-aliasing (edge smoothing) reduces this effect, however this requires increased computing performance. The setting applies globally to all 3D fades, and switching on anti-aliasing during 3D fades has the effect that all other 3D fades are also affected by this setting.

**Mirror X/Y:** These options enable the movement track of 3D objects to be influenced within the fades. The option "X-axis mirror" mirrors the movement of the object horizontally (along the X-axis). The option "Y-axis mirror" mirrors the movement of the object vertically (along the Y-axis).

#### Troubleshooting

**Problem:** The 3D transition display in the video monitor is sluggish and jittering.
Solution: The performance of 3D effects depends on the computing performance of your graphics card. To achieve more fluid display, set anti-aliasing in the settings dialog for the 3D fades or select a reduced resolution for the program monitor. You should also ensure that the most current drivers are installed for your graphics card. When exporting or burning to disc, fades will always be displayed fluidly.

Problem: The 3D transitions remain black or displays errors during

Solution: The 3D fades use hardware-accelerated rendering via the graphics card to calculate the image. This may lead to certain incompatibilities on some systems. Ensure that the most current devices are installed for your graphics card. In some circumstances, switching between rendering modes (via the fades setting dialog) or deactivation of anti-aliasing may correct the problem.

If there should still be problems, however, you can deactivate the hardware acceleration. Refer to “Deactivating hardware acceleration”

Problem: A warning is displayed that there is insufficient graphics card memory available for rendering the transition when exporting 3D transitions.

Solution: The video memory on your graphics card is insufficient for calculating the 3D effect at the desired resolution. Select a lower resolution as required (e.g. 720 x 576) in the export dialog's settings. In case the problem continues to occur, deactivate the hardware acceleration (see above).

Problem: Only a crossfade is displayed when previewing a 3D transition. A warning message is displayed that insufficient graphics card memory is available for the selected resolution.

Solution: The video memory featured by your graphics card is insufficient for calculating the 3D effect at the desired resolution. Right click on the program monitor and then select a reduced resolution under "Resolution presets". If the problem continues to occur, try deactivating the hardware acceleration (see above).

Problem: When viewing 3D fades, only a crossfade is displayed, and the warning message: "An error occurred during calculation of the 3D fade. A warning is displayed that the 3D transition may not be displayed correctly.

Solution: Deactivate the hardware acceleration. Hardware-accelerated rendering via the graphics card increases performance exponentially, however in some circumstances it may lead to problems on some systems. In case image errors occur in the context of 3D fades, the hardware acceleration may be deactivated for 3D fades. In "File -> Settings -> "Program settings ->
Video/audio", deactivate the option "Hardware acceleration for 3D effects". To make this change applicable, the program must be restarted.

### 3D series

The 3D series are an advanced development of the already known 3D fades (view page 82) and open up new thematic possibilities. The 3D effect and a practical sequence of transitions are put to the fore here. For instance, you can let photos pop up and disappear on a notice board or make it look as if the photos were hung on the walls of a gallery. The series stretch out over several photos or even entire slideshows.

In MAGIX PhotoStory on CD & DVD 10 there are several options to call up 3D series for photos:

1. In the Media Pool, click on Fade and open the 3D series. Select the desired 3D series and drag it onto the photo from which the series should start.
2. In the Fades menu the various 3D series between two photos are listed under the menu point "3D Series". Click on the desired 3D series to select it.

A dialog opens in which you can select how many of the subsequent fades should be replaced by the 3D series.

### Stereo3D transitions (Deluxe version only)

The transitions in the Media Pool feature the category "Stereo3D". This includes transitions that create "real" 3D effects using normal 2D photos.

These transitions feature a selection of familiar transitions from MAGIX PhotoStory on CD & DVD 10 that have been prepared especially for real 3D. These are displayed stereoscopically in the respective 3D playback modes (view page 110).

**Note!** These transitions may not be applied to 3D photos, since this makes them very unpleasant to look at and can cause serious headaches!
Effects

Effects in menus

You can access the effects menu for fine tuning via the Effects (view page 170) menu (in Storyboard (view page 44) mode) or via the context menu.

The entries for "Image optimization", "Transform", "View & animation", and "Design" access the corresponding Effects in the Media Pool (view page 58). "Image optimization" provides additional entries for "TV image (view page 171)". The other effects are mentioned in the Effects (view page 170) menu.

Effects from the Media Pool

The effect files in the Media Pool "Effects" settings (view page 58) can be applied by clicking them or via drag & drop.

Simply click on one of the effects to view a short preview on the video monitor to see what an effect can do. If you want to use the effect, simply drag & drop it onto a photo or video.

To deactivate all effects of a photo, select "No effect" (you can also deactivate the effects via "Turn of effects" from the "Effects" menu).

Other effects can be set directly in the Media Pool; they have a direct effect on the selection.

Optimize picture

For more exact settings, there are multiple effects in the Media Pool for "Image optimization (view page 85, view page 58)".

Video Stabilization

The video stabilizer reduces unsteady camera motion and helps to smooth recordings. This option can be accessed from the context menu of a video object or via the "Effects" menu.

www.magix.com
Functionality

Video stabilization balances undesired picture movement. The motion stabilizer equalizes inadvertent movements in the image by moving the image in the opposite direction in accordance with the wrong movements. This produces unusable edges in the footage that are cut off automatically, and black strips replace the edge of the shifted picture, which are then removed using a zoom shot. The result: A clearly more stable, almost imperceptibly larger picture.

Application

Activate the motion stabilizer in the video object FX or context menus. You will see the current video object in the preview monitor.

First you have to check the movie material for shaky scenes. To do this click on the "Stabilize" button. Based on the preset parameters, a relative shift between the pictures is calculated. After concluding the analysis, take a look at the suggested correction, then use the slider for further adjustments. Use the fader to do this. Once you are happy with the final correction click OK. If the first scan did not provide a satisfactory result, try changing the parameters below and repeat the process.

Image stabilization dialog

Stabilizing radius: To prevent the image stabilizer from recognizing every camera movement as unwanted shakiness, you can determine the radius within which movement is accepted; the larger the stabilization radius, the
more shakiness is corrected. Changing this parameter will require re-analysis of the source footage.

**Analysis area:** This area determines the area of the footage that should be analyzed. The center of the image is preset. If shaking occurs in one area more than in another, then you can move the analysis area (e.g. a foreground element at the edge is especially shaky). To do this, use the mouse to “capture” the shaky area. The smaller the area, the quicker the analysis will be calculated. Generally, changing this parameter will require re-analysis of the source footage.

**Maximum movement:** Correction moves the image accordingly to the shaking movements. This means that the edge of the image will be removed. This value determines how large the edge area is which may be cut away by the stabilization feature; the smaller the value, the less movement correction. Changes to this value are immediately applied.

**Temporal smoothing:** This value determines the speed of the movements considered shaky. This allows you to differentiate between a panning shot and a nervous hand-held shot. Changes to this value are immediately applied.

**Cancel:** Exits the dialog without accepting changes to settings.

**Reset:** Resets the current settings.
Slideshow Maker

Slideshow Maker is ideal for converting still images into moving pictures, adding background music, and effects.

Open Slideshow Maker via "File -> Wizards" of the button in the toolbar.

![Slideshow Maker interface](image)

Style templates

Select a template that best matches your needs.

The Deluxe version also includes presets that use Stereo3D transitions (view page 84).

Save/delete style template

Homemade style templates appear in the list of included style templates.

If you like, these can be deleted again.

Intensity

Controls the portion of video and image objects that feature effects.

Transitions

The different sliders are used to set the portion of individual fade types.
3D / Other:

**Fade duration:** Set the length of the fades in seconds.

**Random fades:** The fades are set to random values.

**Effects**

The faders enable the respective effects types to be specified.

**Random effects:** The faders that control the amount of effects are set randomly.

**Treat special image formats intelligently:** Panoramas and portrait photos can be treated "intelligently". If this option is activated, then panoramas and portraits will be treated with special effects adjusted to the format. These effects can also be selected in the detail view.

If this option is selected, then these images will use the same effects as all other images.

**Details** activates effects or fades in the corresponding category. The arrow below the preview monitor plays a preview.

**Properties & title**

**Film length**

**Resulting film length:** This is an estimation of how long the film will be after applying Slideshow Maker.

**Available music:** This is the complete length of the music that is currently selected. Background music (view page 90) enables detailed settings for the pieces of music to be used.

**Adjust film length to the music:** An attempt is made to adjust the length of photo objects to the background music. If the film is too short the music will be cut off. If the film is too long, the music will repeat.

**Adjust music length to the film:** Photo objects have a set length, and the resulting film is filled with music. The music at the end of the movie is simply faded out.

**Including video objects**

**Process videos:** If this option is set, then videos will be automatically processed with effects and transitions.
**Length**: Settings may be made here about whether the original length of the video should be maintained or if it should be shortened.

**Opening and closing credits**
Set the text for opening and closing credits here.

**Text**: Enter the corresponding text for opening and closing credits that should be added by Slideshow Maker.

**File**: A title template, a video, or an image file may also be used.

**Note**: Titles created using Slideshow Maker may also be edited at any time.

**Group associated images together**
If this option is active, an attempt is made to detect associated events via their date information and to separate them from each other optically. Detection of individual events is based on the time span of these events to achieve a sensible separation.

**Begin group with black fade**: A black fade is added between the different events.

**Begin group with title and black fade**: A black fade is added between the different events. A title is also faded in with a suitable duration, e.g. 1st/2nd/3rd day, provided the events take place over multiple days.

**Begin group with title and picture**: A black fade is added between the different events. A title is also faded in with a suitable duration after the black fade, e.g. 1st/2nd/3rd day, provided the events take place over multiple days.

**Background music**
Specify if and which music should be used for the background here.

**Use background music**: Adds background music.

**Load file(s)**: A file selection dialog will open to choose a folder featuring music; select one or multiple files.

**Remove**: The selected pieces of music are removed from the list and will not be used.
**Insert random:** MAGIX PhotoStory on CD & DVD 10 selects random pieces of music from the folder "Import -> My Media -> Slideshow music" in the Media Pool.

**Preview:** This button previews the selected piece of music.

**Volume ratio:** This slider controls the volume ratio between the original sound and the background music.

**Tip:** Songs in the fourth track are listed and used for the background music, provided they are not removed.

**Create slideshow**

After all of the important settings have been made, click this button to produce the slideshow.

If the results do not match what you imagined, then click "Cancel" to discard the changes. Otherwise, you can change the settings again or select another style template and click "Create slideshow".

**Sound optimization**

This option opens an editor for correcting audio material discrepancies.

Select the cleaning function you desire from the upper part of the dialog:

- The equalizer (on page 94) allows you to manipulate the frequency spectrum – perfect for cleaning up muffled dialog.
- The compressor is a dynamic volume control that lends the overall sound a deeper, richer quality.
- The stereo FX processor justifies the position of the sound in the stereo panorama.
- DeNoiser, DeClipper, and DeHisser are professional noise reduction tools that do exactly what their titles say they do.

**Presets:** You can try out the suitability of a number of presets in the preset menu.

**Temporarily deactivate all effects:** Switches all the effects off.
Apply to all: Applies the current settings of all effects to every photo in the selected slideshow.

Declipper

Should the input level of an audio recording be too high, overmodulation may result at the louder parts (the signal peaks). This digital distortion is also called "clipping": At the overmodulated area, the values that are too high are simply cut off, and typical, quite unpleasant-sounding crackling and distortion appear.

MAGIX PhotoStory on CD & DVD 10 contains a special function for dealing with digital clipping and analog distortions. Of course, this only works to a certain degree.

Using the fader you can set at what level the Declipper should register a signal as being overmodulated and, if required, correct it (Clip level). This is important, as different sound cards show different clipping methods. The more the fader is turned up, the lower the level recognized by the program as overmodulated. If the clip level is set too high, unwanted sound modification may occur.

Get clip level: The clip level is gaged automatically.

Noise Reduction: Denoiser and Dehisser

Denoiser

The DeNoiser is especially useful for clearing long-lasting disruptive noise like mains humming, hissing, noises from sound charts, disturbance noise from ground circuits, interference from audio-equipment with high mic outputs (record players), impact noise, or the rumbling of records.

The DeNoiser requires a noise sample. Some typical sounds are at your disposal.

Set the degree to which the noise should be reduced with the fader. It is often better to reduce interference signals by 3-6 dB rather than as much as is possible so as to keep the sound "natural".

Another possibility is to create a noise sample yourself. You need a short sample from the sound track in which only the background noise can be heard. Then switch to the DeNoiser dialog with the "Advanced" button.
Step 1: Select noise sample

First you have to select a noise sample of the noise you want to remove.

You have two options:

**Pick out typical background noise:** You can select and use a number of typical background noises from the flip menu. Select one and listen to it via the "Play" button. If it is similar to the background noise in your sound track, go ahead and use it (see "Step 2: Removing background noise").

**Extracting a new noise sample from a sound track:** You can also pick out a short passage (from the existing sound track) in which you can hear the background noise.

**Automatic search:** Searches especially quiet passages in which background noise most probably resides.

**Previous/play/next:** These buttons allow you to play all of the passages found for easy comparison.

**Save as:** Once found, you can save noise samples on the hard drive which then appear as an entry in the "Typical background noises" drop-down menu to be used in other projects. There's no need to save it if you only want to use it once, and in this case switch to "Remove background noise".

If you only want to use the noise sample in the current project, then you don't have to save it. You can immediately switch to the "Remove category".

Step 2: Remove background noise

**Noise level:** The level of the noise reduction function should be set as precisely as possible. Low settings result in incomplete deletion of the hissing. An incomplete deletion of the hissing produces artifacts and should be avoided. High settings produce dull results and useful signals which are similar to hissing (woodwinds, for example) are also filtered away. It's worth your time to find the best setting.

**Reducer:** Here you can set the balance between the original signal and the signal with depressed interference. It is often better to reduce interference signals by 3-6 dB rather than as much as is possible so as to keep the sound natural. For buzzing it's best to apply complete removal.
Dehisser

The Dehisser eliminates regular "white" noise typically produced by analog tape recordings, microphone pre-amplifiers, A/D converters, or transformers.

Noise reduction can be regulated in decibels with the fader. It is often better to reduce interference signals by 3-6 dB rather than as much as possible in order to keep the sound "natural".

**Noise level:** You can choose between different noise levels. The level of the noise reduction function should be set as precisely as possible. Low settings result in incomplete deletion of the hissing. Incomplete deleting of hissing produces artifacts and should be avoided, since high settings will produce dull results and some useful signals (i.e. woodwinds) which are similar to hissing are also filtered away.

Equalizer

The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and supplies them with separate volume controls to allow you to achieve many impressive effects, from the simple rising of the bass to total sound transformation. If you raise the low frequencies too much throughout the whole level, it might cause distortions.

**Fader:** The volume of each of the 10 frequency bands can be set separately with the 10 volume controls.

**Link frequency bands:** The frequency fields can be bundled together flexibly in order to avoid artificial-sounding exaggeration in individual frequency fields.
Compressor

The compressor is an automated, dynamic volume controller. Loud passages become quieter and the total value is raised. This makes the volume more consistent and speech easier to understand. A compressor is mainly useful in case background noise or music interferes with speech and simply increasing the volume of the individual objects or tracks does not result in any significant improvement.

**Level:** Regulates the level of compression applied (the "ratio").

**Function:** Defines the compressor depending upon the sound material.

Stereo FX

The stereo FX processor provides adjustment of the alignment of the audio material in the stereo balance. If the stereo recordings sound weak and undifferentiated, an extension of the stereo base width can often provide better transparency.

**Bandwidth control:** Adjust the bandwidth between mono (on the extreme left), unchanged base width (center) and maximum bandwidth ("wide" on the extreme right).

Reducing the bandwidth can raise the overall level. In extreme cases, when the left and the right channels include identical material and the bandwidth control is pushed to the extreme left on "mono", the result can be a level increase of 3 decibels.

Raising the bandwidth (values of 100) diminishes the mono compatibility.

www.magix.com
Title editor

Titles can be used for many applications: as a running text (ticker), subtitles, speech and thought bubbles, to display date and time, and much more.

Pressing the text button opens the Title Editor.

Enter text, e.g. for subtitles, lead or end credits in the video monitor. Texts can be displayed in all kinds of fonts and colors.

If you want to format individual words or letters, select them with the mouse and choose a different format or color. If no selection is made, the entire text will be formatted.

Creating titles using a template

The Media Pool includes the tab "Title" with folders filled with additional, thematically named title templates.

- Open one of these entries and select any title template. A simple mouse click provides a preview, and double clicking creates a title object using the template.

Note: Templates may be applied to an existing title object. Settings outside of the text will be lost!
Creating titles without a template

- Try clicking the "General" entry under "Title" in the Media Pool.
- Click the title editor button. A standard title will be produced and displayed in a frame in the video monitor.

- Open the first title in the video monitor by double clicking it
- Next, simply enter the text via your keyboard.
- After the text has been entered, click the check mark in the preview monitor to confirm your entry.
- The size and position of the title may be adjusted directly in the video monitor.
- Format the title via the title editor in the Media Pool however you like.

Text may be displayed in all kinds of fonts and colors.

If you want to format individual words or letters, select them with the mouse and choose a different format or color.

If no selection is made, the entire text will be formatted.
Edit title

- Click again on the title in the video monitor window or the title object in "Timeline" mode.
- Now change the text however you like.
- Confirm your entry by clicking the check mark next to the positioning frame.

Font

- **Font**: Select the font here that should be displayed for the text.
- **Font style**: Choose here whether all of the text or parts of it should be shown bold, in italics, or underlined.
- **Font size**: Set the size of the text here.
- **Direction**: Choose whether the text should be justified to the left, centered, or to the right within the positioning frame.
- **Color**: Press this button to choose the font color.

Effects

- **Font style**: Choose here whether all of the text or parts of it should be shown bold, in italics, or underlined.
- **Outline/shadow/3D**: This function allows you to add shadows, 3D effects, and an outline to the text. These settings can be adjusted in detail via "Advanced".
  
  The 3D button converts the title object into a Xara 3D text object. Xara 3D text objects are described in more detail in the section "3D text (view page 100)".

Animation

- **Animation**: You can make your credits scroll down the screen, and many other text movements and effects and designs are also available.
- **Display duration for the subject**: The display duration for the subject can be set here.

Templates for animated text are arranged in the other Media Pool categories; the icon and the description are there to help you find the correct settings.
Title object

Deletes the whole title object, i.e. text and settings.

Advanced settings

Only use visible TV area: The text will be zoomed so that it will always be within the TV’s limits, which is specified in the Movie effect settings (view page 105).

Background: Specify here whether the text’s background should appear black or white. This is only meaningful if no other video or image object is in the background.

Text effects: Here you can edit different text effects in detail. One color may be set for each effect.

Shadow: The position of the shadow may be set on the horizontal and vertical axes.

Transparency makes the background "shine through" more or less.

Soften: Makes the edge of the shadow harder or softer.

Outline: A border appears around the letters in the text.

Width: You can enter the width of the frame in points.

Color: Clicking on this button opens a color selection dialog, where you can set the frame color.
Filled in: The text will be filled with the color selected in the Title Editor. If the option is deactivated, only the frame will be visible, and the background will appear instead of the color fill.

3D: The text appears with a 3D-style outline. The width and thickness of the 3D contour (H) can be set in points.

3D text
3D text can be created directly from the title editor.

- Click the title editor and then press the "3D" button.

The title object will now be turned into a MAGIX 3D object. If you have also installed MAGIX 3D Maker, the program will open for you to work on the text.

- Presets are also located in the Media Pool under "Titles -> X3D". You can enter or process text here.

Note: For more information about MAGIX 3D Maker, try the help file. You can open it by pressing "F1" from within the program.

Tempo and beat recognition

The Tempo and beat recognition in MAGIX PhotoStory on CD & DVD 10 Deluxe is required for musical cut adjustment and will be launched for this purpose. It analyzes the rhythm of a musical piece. The basis for this analysis is the rhythm speed, measured in BPM (Beats per Minute).

MAGIX PhotoStory on CD & DVD 10 then ensures that photos located at the beats detected are moved such that the images change in time with the rhythm.

Prerequisites for using the beat recognition assistant
- Songs must be longer than 15 seconds
- Songs must be "rhythmic" (i.e. they can be danced to)
- Songs must be in stereo format

Preparation - Setting the start marker and object end
Before opening the Auto Remix Assistant, you should set the start marker at the position in the song object in the arranger where you want detection to...
start. If the song contains a long intro without beats, set the start marker after the intro. As a rule of thumb, the Auto Remix Assistant should always be "fed" dance music.

- The start marker should be set before a quarter note beat or, better still, briefly before a beat at the start of a bar.
- If the start marker lies before the song object, the object is examined from the beginning.
- If detection is not performed by the end of the song, the object can be shortened accordingly with the object handle at the end of the object.

**Automatic Tempo Recognition**

When the Auto Remix Assistant is launched, the selected song object is analyzed and played back. A metronome begins to click according to the result and lines visualize the positions of the quarter notes found in the wave-shaped display.

The following cases are differentiated:

- Position of the start of a measure (the one): red line.
- Position of the other quarter notes (the two, three, and four): green lines.
- Reliably recognized positions: thick lines.
- Unreliably recognized positions: thin lines.
- When tapped, blue lines appear.

If the tact and tempo information is already present, points are indicated above the display at the appropriate positions. The metronome volume can be regulated below and to the left of the wave-shaped display. To the right, the BPM value is indicated. If a valid BPM value was found, it is displayed in green.

If the metronome clicks in time with the music, the measure start is correct. If not, you can correct the tempo manually.

**Setting the manual and Onbeat/Offbeat**

If the result is incorrect, you can help the Auto Remix Assistant with a few mouse clicks on the correction buttons.

There are two possibilities:

On the one hand, the "Tempo correction" list offers alternative BPM numbers which could also fit with the music. The adjustable BPM values are detected automatically – the total BPM can therefore deviate from song to song.
For more difficult audio material, we recommend using the "Tapping input" mode. Either the "T" key must be pressed or the "Tap tempo" button must be clicked with the mouse in time with the music. With repeated tapping of the tempo correction button, one should keep an eye on the color in the BPM display. In the "unlocked" condition (red), the tapping is not in time with the music. One should tap until the "locked" condition is displayed. After a short time, you will hear if the result is correct via the metronome.

Subsequently, offbeat correction takes place as required. If the detected quarter note beats lie around the length of an eighth note (transferred behind the real positions of the quarter note beats), one or more alternatives can be selected from the onbeat/offbeat correction list.

**Determining the start of a measure**

Next, the starting point of the measure is corrected. The beat at the start of the measure must always agree with the high tone of the metronome and/or the red line in the wave-shaped display.

Corrections can be made by tapping; If the start of the measure can be heard, tap with the mouse or press the "T" key. Alternatively, you can also select how many quarter notes the "one" is to be pushed to back.

If the starting marker was set briefly before the first beat of a measure, this correction is not necessary.

**Note:** With all corrections, the metronome and visualization react to the lines in the wave-shaped display only after a short delay.

**Applying BPM and beat detection**

Close the Tempo and beat recognition by clicking "Apply". MAGIX PhotoStory on CD & DVD 10 will now move the photos at the detected beats so that they change in time with the music.
Slideshow effects

In the slideshow Effects menu (view page 170) you can recall the slideshow effects by clicking on "Slideshow effect settings". The dialog is almost identical to the Optimize photo (view page 85, view page 58) dialog.

The slideshow effects apply to the entire slideshow and are intended to regulate the color saturation in the slideshow as a whole.

You can find special TV screen size (view page 105) options for cropping the screen edge, since the image usually exceeds the screen size for a normal TV set.

General use

Presets: Try out the presets from the preset menu.

Auto: This button usually offers a good effects setting. Pick out a picture that is typical for this type of distortion using the position slider, and then click "Automatic setting". The optimum cleaning setting will be applied to the whole scene (or the entire slideshow when using as master effect).

Temporarily deactivate all effects: Switches off all the effects. This way, you can quickly compare the original with the edited version.

OK: The adjustments made to the settings will be applied.

Cancel: Closes the dialog, the settings will not be applied.

Help: Opens the program's help file.

Exposure

Brightness/contrast: Use the sliders to increase or reduce the brightness and the contrast of the picture.

Selective brightness (gamma): "Gamma" specifies the mean gray value that is provided by the various color ranges. "Selective brightness" is the most important function for image improvement. In the preset list, select the various envelope curves to edit only the dark, median, or brightest areas of the image. Using the fader, you can also set the level of brightening or darkening.

Auto-exposure/auto-colour: These buttons enable you to change contrast and color automatically with a few clicks. The other settings options in the dialog provide more options to get the results you want.

www.magix.com
**Adjust colour space:** This option is effective against powerful colors that violate TV standards and can no longer be displayed correctly on-screen. The color saturation of the affected material is thereby reduced until the maximum permitted value is reached.

**Color**

**White balance:** All light is not the same. Depending on whether it is sunlight or artificial light, this will have an effect on color variation. The human brain is able to compensate for this variation: a white sheet of paper will still look white under candlelight, even though it is in fact much more yellow than by daylight.

In order to imitate filtering done by the brain, a camera must also analyze and correct the light. White balance does the same thing to a picture that the brain does. Thus the camera is set to the so-called "color temperature" of the surroundings.

If you are not fortunate enough to possess a camera which performs this function automatically, then you can apply white balance in MAGIX PhotoStory on CD & DVD 10.

An incorrect white balance can lead to an unnatural blue or red hue.

**Directions:** To use the white balance, please click on the button to the right of the label "White balance" and then select a point which represents white or a neutral gray to the "outside world".

The color temperature will be corrected automatically.

**Tip:** Cool color effects can be achieved by setting a different color as the "white" benchmark. There is definitely room for experimentation!

**Remove redeye:** Using this photo function you can remove unnatural redeye that is the result of using a flash. Click on the eye symbol and then select the red pupils in the preview monitor using the mouse.

**Hint:** For photo optimization we recommend you use MAGIX Photo Manager. The program is installed automatically and can be used for quick previewing and easy management of pictures from your database. It has tools for correcting redeye and setting auto color and white balance to control discoloration in pictures.

www.magix.com
For more complex editing like photo panorama and photo filter effects a separate image processing program MAGIX Photo Designer is included. Users of the classic version can download the latest software at any time for free. To load a photo into MAGIX Photo Designer, select the option "Edit photo" in the FX menu of the photo box. Read more about this in the MAGIX Photo Designer Help file.

"Saturation": Using the "Saturation" slider you can increase or reduce the hue proportions in the image. A newly developed algorithm is now used, which carries out color changes in relation to other parameters (for example contrast settings), in order to get the most natural coloration possible. With just a little bit of experimentation, you can achieve the most astounding results. Anything from turning summer snapshots into autumn scenes or funky pop art is possible...

Hue: On the palette you can select a hue to color in the picture.

Red/Green/Blue: The red/green/blue slider corrects the color proportion mix.

Sharpness
This fader allows you to regulate the level of image sharpness.

The "fine tuning" option allows you to determine the level of focus for particular surfaces or borders.

Anti-flickering filter intensity: The anti-flickering filter affects only still images. It is especially intended for zooms in images with many edges and transitions with high contrast (e.g. fences, bars, brick walls). High-frequency images such as these begin to flicker when they are reduced in size. This filter smoothes these edges somewhat.
You should set the intensity of the anti-flickering filter according to your preferences, because smoothing is always a compromise between good contrast and fluid image sequence during playback.

TV image size (Slideshow master effects)
This option ensures that the image size is adapted to fit the real television picture (anti-cropping). Without adjustment the television might otherwise crop the image borders.

The four image margins can be proportionally adjusted by means of the four input fields. Here it is important to find the optimal balance between distortion, reduction, bar formation, and image cropping:
- If the same value is entered for every margin, then the image size is reduced proportionally. In this case no distortions will occur, but there will be bars along the edges.
- If different values are entered for the 4 fields, then the image size is reduced unproportionally. This causes image distortion.

**Apply TV screen size:** On (for photos!): This option enables the input values for the four image borders to be applied to the respective photos in reduced form. The result can immediately be viewed on the preview monitor.

**Fade in TV display area in the preview monitor:** This option displays the image borders of the television as lines in the preview monitor. The four image borders of the TV display area can be set by means of the 4 input fields. It is necessary to know the actual size of the TV picture. To determine it proceed as follows:

**Determining the visible TV frame size**

To determine the picture properties of your television as well as optimal image size editor settings you should perform a test run.

1. Load the **Visible TV picture.mvm** film from the "My projects > visible TV picture" folder.
2. Play back the film and read the instructions on the video screen.
3. Copy the slideshow to CD or DVD.
4. Place the disc into your player and play back the film. Compare the TV picture to the picture displayed on your video screen by MAGiX PhotoStory on CD & DVD 10.
5. Determine the proportional value of the borders cropped by the television with the 4 measurement scales along the edges of the test picture.
6. Enter the values in the “Full TV size” editor.

The image size is now optimized to your TV picture. Depending on device settings and disc carrier type the cropping values may vary slightly.
Stereo3D (Deluxe version)

MAGIX PhotoStory on CD & DVD 10 Deluxe also enables creation and editing of 3D videos and photos. Let's examine this complex topic to learn the basics and a few golden rules. Next, we'll look at the individual work steps in detail.

Note on using 3D content: Some people experience unpleasant symptoms (such as headaches, overexertion, eye strain or nausea) when they are exposed to 3D video. For this reason, we recommend taking regular pauses. If problems occur, you should stop all use immediately and consult a doctor or an optician. Incorrect creation of 3D footage can also cause these symptoms.

Warning to children: Children’s eyesight (especially before the 6th year) is still developing. We recommend consulting your child’s doctor or optician before permitting your child to view 3D videos.

3D basics

Human eyes perceive objects from 2 different angles and our brain "calculates" images from this information. This way we can tell the distance and position of an object. For this reason, 3D material should be shot according to this principle.

Viewing 3D

A regular screen or TV can show images only in 2 dimensions, and various technologies have been developed to enable perception of images in 3D. To this day, all technologies share the following: You need special glasses to deliver different information to the left and right eyes. We will examine these technologies in detail later.

The three golden rules

- Stay within limits during recording: To make a 3D recording (view page 108) with realistic depth information, certain limits must be respected. The most important rule is not to go below the point of minimum distance. Minimum point is the point in the picture, where the camera is the closest.
- Frame closest point: In order to place the 3D effect behind the imaginary frame, both image components must over lay each other exactly at the closest point. At the same time, the same objects must be visible at the edges of both partial images, for which, if needed, you can use the Cropping function in the Media Pool.

www.magix.com
Note: The imaginary window is a type of a plane, behind which the 3D movie plays. You select the closest, frontmost point. Not keeping up with this rule can result in the object to "jump out" of the imaginary window, which when used too much, can cause headaches.

- Maintain realistic eye angles: Object with a 3D depth effect viewed as a red/cyan image (Anaglyph) without glasses will appear displaced. This displacement should, if possible, take up less than 1/30 of the entire image. Otherwise, it will appear that the eyes are looking in different directions.

Notice: Displacement may only occur along the horizontal axis. Displacements on the vertical axis and rotated portions must be adjusted.

Record 3D

The distance between eyes in humans is ca. 65 mm, which forms the so-called "stereo base width". But because our eyes are dynamic and we can even "cross" our eyes, it is possible to focus on objects that are closer.

Various techniques exist for 3D recording. Each method has its advantages and disadvantages:

- **3D cameras with two lenses**: The advantages are obvious; these cameras produce 3D material without excessive work involved. The disadvantage is that the stereo base width (lens distance) cannot be changed.

- **Two cameras on a special mount**: This involves a little more work. Two cameras are mounted on a special support to record material for the left and the right side of the 3D image simultaneously; microphone booms for stereo recordings may also be used for this purpose. The disadvantage in this case is that the shutter releases have to be pressed at exactly the same time if there are moving objects in the picture. In case of video, both movies must be synchronized before being edited. Advantages: Stereo base width may be changed by adjusting the distance between the cameras; larger selection of camera models.

- **Two photos via the same camera**: This technique only allows still images. The camera is simply used to record two images from different perspectives, and these are used as the right and left images. For best results, use a tripod.

- **Consistently fast camera movement, e.g., along a street**: Only a single conventional camera is required in this case, but the range of applications is very limited. This is the most cost-effective method for creating 3D videos. Material is filmed at a speed of circa 6-to 15 km/h. During editing, the edited
video object is duplicated and one of the videos is played back with a time lapse. The movement direction determines which is the right and left image. 3D photos may also be created using this method.

**Warning, minimum distance!**

The position of the object closest to the lens is designated as the minimum point. This minimum point may not exceed a specific minimum point; this is easy to calculate via the following formula:

**Note:** Lens focal point (e.g. 25 mm) x stereo base width (e.g. 65 mm) x 1.5* /1 mm= minimum point (2437.5 mm ~ 2.44 m)

*1.5 is a factor derived from the cut-off appearing when filming through a lens. **1 mm is the so-called "deviation" or "spatial dimension". This only involves a rough value in this case.

**Examples for 3D cameras:**
Panasonic HDC-SDT750 (base width 12 mm): minimum point is approx. 1.5 m.
Fuji REAL 3D W3 (base width 75 mm): minimum point at approx. 3 m; for long-distance recordings as much as 8 m.

This so-called minimum point has an important role in other aspects of 3D editing.

**Prepare 3D editing**

3D videos are filmed and saved by different cameras, which means: depending on the camera model or recording method, the videos or images vary.

**In one file**

Many cameras, especially for photo recordings, create one single file containing the left and the right image next to one another.

- Drag these files from the Media Pool directly into your arrangement.
- Select the created objects.
- Select the "Side-by-Side (left images left/right)" entry in the Media Pool under "Effects > Stereo3D > Properties > Create stereo".
In multiple files

Some 3D cameras create a file for each the left and the right side. This working technique works also if you simply take 2 pictures with a regular photo camera.

- In the Media Pool, open the folder in which the desired file can be found.
- Sort the files in increasing order according to the date. This way, all files will lie in pairs one below the other.
- Now, select the files and drag them from the Media Pool directly into your arrangement.
- In the Media Pool select "Side-by-side (left image right/left) under "Effects > Stereo 3D > Properties > Create stereo" for material with halved width.

Note: If you have created side-by-side material yourself (e.g. placed two photos next to each other in an image file), proceed as described, but at the end select the "side-by-side (left image left/right)" for material with full width.

Set playback mode for 3D

There are various techniques available for playback of 3D videos on the computer. Depending on the technology used, the corresponding playback mode may be activated in MAGIX PhotoStory on CD & DVD 10.

Select the 3D mode you want to work with in the upper left corner of the video monitor.

Here is a list of available techniques and the corresponding requirements:

<table>
<thead>
<tr>
<th>3D mode</th>
<th>Technology</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display occurs in rows</td>
<td>Polarizing filter</td>
<td>• Polarizing filter glasses</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Special monitor, typically referred to as a 3D monitor or similar</td>
</tr>
<tr>
<td>Side-by-side display</td>
<td>Shutter mode</td>
<td>• nVidia 3D Vision Kit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 120 Hz monitor/projector</td>
</tr>
</tbody>
</table>

Note: Both of these modes should only be set in case the preview image is output on a separate monitor. Shutter mode also requires a 3D-capable graphics card.
Anaglyph display

- Color anaglyphs
- Red/cyan glasses

Align videos and pictures for 3D

Anaglyph display is recommended for this, which may be set via the video monitor (view page 110). Only in this mode is precise geometric alignment of images possible.

Note: In case you wish to edit 3D-video material, it is recommended to conduct scene recognition and split the video into individual scenes. This is necessary because the left and right side of each scene must be arranged individually.

The so-called minimum point is the point in the picture that the camera is closest too. This forms the "center" of the 3D image and must be defined as such in MAGIX PhotoStory on CD & DVD 10.

For this task, go to "Media Pool -> Effects -> Stereo 3D" and access the entry "Aligning".
Juxtapose both images one over the other, so that the minimum point of both is at the same location.

You should first see whether automat ions for spatial adjustment and synchronization deliver desired results. Click on the button "Automatic".

If this does not produce the desired effect, proceed as follows:

- Find the minimum point in the image.
- If the images are offset vertically, then these need to be balanced via the slide controllers under "Spatially align".
- If the images have rotational differences, you have to adjust these with the rotation controller.
- Try to juxtapose the closest points of both sides precisely using the upper slider.
- To test the results, put on the cyan/red glasses. In case the image has an exaggerated spatial depth, try to position the left and right sides closer to each other using the controls.

**Turn camera movements into 3D videos**

Camera movements may be transformed into 3D videos by being duplicated and converted via time displacement. To do so, you can simply record on the right or the left side while, for example, driving along a street.

The speed should be set between 6-15 km/h (approx. 4-10 mph) and depends on the frame rate, the focal point, and the distance of the objects being filmed (among other things). At increased speeds, it may occur that the spatial impression is too strong and the filmed material seems unnatural and unpleasant.

- If the video is in the arrangement, the stereo depth for the 2D object may be set in the Media Pool via "Effects -> Stereo 3D --> Properties".
- Depending on the direction of the recordings, you will have to move the control either to the right or the left.
- Check the results in the anaglyph display with red/cyan glasses
- Correct any unrealistic effects by adjusting the controller in the opposite direction.
- If the spatial depth is exaggerated, reduce the changed parameters.

**Note:** Not only camera movements, but also other 2D materials may be arranged spatially.

3D material may be edited with the same functions as 2D material.
Create titles for 3D videos

Xara3D title objects (view page 100) automatically have "real" 3D properties and for this reason may be used in the arrangement without any problems.

Export and burning 3D videos

There are no special requirements for export and burning. Only the desired 3D technique is specified.

**Anaglyph:** This technique is recommended for uncomplicated playback of finished videos or playback via conventional TV sets or projectors. Viewers must simply put on a pair of red/cyan glasses to be able to enjoy a 3D film.

**Side-by-side:** Create 3D movies for a 3D-capable playback device without having to compromise the quality. It doesn't matter initially whether your video is viewed in "Shutter" mode or via "Polfilter".

- Depending on your playback device, you should set double resolution in order to produce full resolution for both the right and the left image.
- Not all playback rates are capable of double resolution. If this is the case for your device, 50 % pinched images will be displayed. The quality is nevertheless higher than output via the anaglyph technique.

**Note:** When exporting to side-by-side formats, make sure that the vertical resolution is the sum of both images, but the aspect ratio (e.g. 16:9) refers to a partial image!

Export files/upload movies to the Internet

The standard path for all file exports via "File -> Export movie or file -> Internet". Depending on the export format and destination, the export dialog also allows the 3D technique to be used to be selected.

For direct selection as Windows Media Video 3D, click "Export" and select "3D film" from the dialog.

Burn CD

When burning a Blu-ray Disc™ or DVD, you must first open the encoder settings in the burn dialog and set the desired 3D technology. Next, you may
proceed to burn the disc as usual. During the burning process, MAGIX PhotoStory on CD & DVD 10 automatically creates an intro video with corresponding instructions that will play back when the disc is placed into a drive.

Produce panorama pictures

Create "genuine" panorama images from matching photos. You can also let your imagination run wild and put together anything you want to.

**Note:** Optimize your photos beforehand so that the transitions can't be detected in the finished panorama.

Select pictures for panorama

Load all necessary photos into the slideshow project as usual. The images that should make up the panorama should be selected one after the other while holding down the "Shift" button. Select the entry "Panorama photo" from the context menu "Effects (view page 170)> Video object effects".

Invert image sequence for panorama image

Sometimes photos are accidentally loaded in the wrong sequence or were created from left to right. If you forgot to sort your photos correctly beforehand, then simply click "Invert sequence".

Calculating the panorama image

If you click "Create", the panorama image will be processed. Depending on the resolution and number of original images included, this may take some time. The original photos are replaced in your slideshow with the panorama image you've created, but the original files on the hard drive will remain intact.

**Hint:** You can create a panorama image from a maximum of six images. Click on "More options" for more information on the upgrade.
The MAGiX Soundtrack Maker adds atmosphere. Music tracks corresponding to the specified mood are generated automatically. Even mood changes are possible.

Open the MAGiX Soundtrack Maker using the Edit > Assistants (view page 158) menu. The work is split into 3 steps.

Then close the dialog by clicking on "Apply". If you click on "Cancel", the dialog will be closed and all changes will be discarded.

First choose a music style. Clicking on "Buy more styles" will open the MAGiX Online Content Library (view page 219). Here you can buy more music styles for MAGiX Soundtrack Maker.

The option "Apply only between start and end marker" lets you limit the length of the background music you want to create. You can also set the start and end markers (view page 42) with the left and right mouse key if MAGiX Soundtrack Maker is open.

www.magix.com
Set mood change

Select a mood from the list.

**Preview:** Here you can preview your selected emotion.

**Position:** With the position slider you can move to a certain position to set the emotions at a certain position. Instead, you can also move the start marker with the left mouse button. The preview will be displayed in the video monitor.

**Add emotion:** This button inserts the emotion at the current position. MAGIX Soundtrack Maker will then suggest a new position for the next emotion by repositioning the position slider. Of course you can also put it elsewhere and insert further moods.

**Delete emotion:** Deletes the current emotion.

Generate background music

One click on "Create soundtrack" creates a new soundtrack. "Progress" shows the current status.

**Variations**

If you don't like the background music that was created, then you can create variations. You can do this for the entire background music as well as for individual emotions.
• If you want to vary the entire background music, then simply click "Create variations".
• If you only want this to apply to a certain emotion, then you should first go to it with the position slider in the dialog (or the start marker on the main screen). Then activate the option "Vary only selected emotions" and click on "Create variations".

General settings

You can access the project-independent MAGiX PhotoStory on CD & DVD 10 settings this way. These settings are also global.

Keyboard shortcut: P

Playback

Audio playback

Driver selection
DirectSound should be selected here. DirectSound is a component of DirectX that is installed automatically on your computer during program installation (if necessary). If the DirectX system is no longer installed on your computer or no longer works properly, then there is a DirectSound installation routine for reinstallation to be found in the "Addon" folder of the MAGiX PhotoStory on CD & DVD 10 program disc.

Output device
Use this option to specify which sound card plays the wave audio objects. This is especially important if you have multiple sound cards installed on your computer.

Audio buffer size
Here you can specify the buffer size that should be used for playback of the entire arrangement or for previewing audio files in the Media Pool.

Video playback

Use output and file cache
This option activates a clipboard which enables smoother playback of transition effects. You should usually keep this option activated.
**Arranger**

**Autoscroll during playback:**
The screen playback does not follow the playback cursor if it has reached the end of the screen.

**Fast:** If autoscroll is activated, the screen view automatically shifts when the playback cursor reaches the last quarter of the screen during playback.

**Slow:** If autoscroll is activated, the screen view automatically shifts when the playback cursor reaches the right edge of the screen during playback. This is particularly useful for longer disc projects.

**Warning:** Scrolling requires constant recalculation of the screen view, which may lead to interrupted playback if the amount of system RAM is too low. If this happens, simply deactivate the autoscroll feature.

**Image material playback**

**Adjust size of image material in higher quality (slower)**
You can use this feature to improve the quality when resizing, particularly downsizing to less than half of the original size for picture-in-picture effects. This also requires more CPU power.

**Note:** Switching off this option has no effect on quality during exporting/burning.

**Load image material in the background**
Image material will be loaded in the background so that it can still be edited during the loading process.

**Paths**

**Projects:** The standard path for all projects (*.<Pojektdatei>)

**Exports:** The standard path for all file exports via "File -> Export slideshow..."

**Audio import:** The standard path for all imported (music) files.

**Disc images:** Specify the path for the folder where MAGIX PhotoStory on CD & DVD 10 saves the temporary files required for creating a disc.
Options

Here you can specify the most important options for the behavior and display of MAGIX PhotoStory on CD & DVD 10.

Keyboard shortcut: P

Video standard

PAL is used in Europe; the US and Japan use NTSC. This setting should not be changed.

Preview

The resolution can be reduced for video decoding, but this only has an effect while preview editing. If playback becomes jerky, then we recommend entering a lower value. The quality of exported videos is not influenced by this.

Video options

Hardware acceleration for 3D effects

Here you can (de)activate hardware acceleration of your graphics card for 3D effects. You can find more information about this topic in the "3-D fades" (view page 82) chapter.

High output quality with dynamic zoom and combination effects

If this option is set, then a newly developed zoom algorithm will be used that provides much more accurate results. You should, however, only use this option if you own a PC that is capable of handling processor-heavy tasks. Otherwise export (and invariably disc creation) can take a lot longer.

Other

Reactivate hint dialogs

Once installed, MAGIX PhotoStory on CD & DVD 10 displays a number of safety queries and instructions at various points in the program. These may be switched off by clicking the small box at the bottom that says "Don't show this message again". To display these warning messages again, select the "Reactivate hint dialogs" option.

Online Services

Here you can configure the Online Services (view page 175) you use. You require a connection to the Internet to do this.
System

Automatically fade photos with effects
Loaded photos will be automatically supplied with a crossfade (view page 80).

Automatically create frametable during import
Sometimes, rebuilding a frame table can get rid of problems in certain MPEG files. For example, such problems can be present if the navigation (positioning of the playback marker, transport) is bumpy or doesn’t function at all. Normally, when loading MPEG video, a frame table is not created in order to speed up the loading process. If you do create one anyway, MPEG files are normally noticeably faster and easier to edit.

Load CD tracks via record dialog
If this option is activated, then you can record audio CDs via the record button in the transport control. While dragging & dropping from the file manager the record window where recording starts will be opened. This option can be used if drag & drop via the file manager does not working properly, or if you want to record the first bars of an incomplete CD track in the arrangement. Here you should note that the digital track data from the digital analog converters of the CD-ROM drive have to be converted into analog signals and then into digital data by the analog/digital converters. Depending on the quality of the converter used, this can lead to losses in quality.

Automatic preview when changing transition
Activate this option to quickly play a short preview of the transition effect.

"Cut to fit monitor automatically" influences movies
If this option is active, then videos will be cut to avoid black edges. The property "Cut to fit monitor automatically" must be activated for the project.

Automatically preview exported clips
If you export a movie as a video file, then it will be played back immediately after being created.

Update preview images in the background
The object display is updated after move and zoom operations in the background so that you can continue working without distractions.

Hide news
This option deactivates the MAGiX News Center (view page 12) in the main interface of MAGiX PhotoStory on CD & DVD 10.
Standard picture length
Here you can adjust the default display duration of the selected photo. This can be changed again at any time.

Display

Video Mode

Compatibility Mode (Video for Windows)
This mode works on all systems. Activate this mode if there are problems with playback.

Hardware Acceleration (Direct 3D)
This mode offers extreme increase in speed by calculating mixing, effects, and various transitions the the graphics card directly. Depending on the graphics card, performance can increase by 300%. The graphics card will not be used during export.

Note! To use this mode the graphics card must possess at least 128 MB memory. You will need to install Direct 3D 9, or higher, and the graphics card driver must support "High Level Pixel Shader Language 2.0". MAGIX PhotoStory on CD & DVD 10 checks the corresponding properties when this mode is selected and switches it off if necessary.

Alternative Mode 1 (Mixer Overlay)
This mode performs hardware-based deinterlacing for output onto a PC screen or a projector, whereby the playback quality is significantly better than with interlaced analog video recordings.

Alternative Mode 2 (Video Mixing Renderer 9)
This mode uses the hardware de-interlacing function of modern graphics cards together with DirectX 9. Make sure that you are using the most recent version of your graphics card driver, which must be compatible with DirectX 9 to function properly. This mode is only superior to "Overlay Mixer" mode with a limited number of graphics card models.

De-interlacing
The DirectShow modes "Overlay mixer" and "Video mixing renderer 9" enable activation of hardware de-interlacing for the graphics card. For general information about de-interlacing and the options "Top/bottom field first", please read the corresponding article "De-interlacing (view page 203)" in the manual.

www.magix.com
Image formation in Vertical Blank Intervals (VBI)

The image formation takes place in the vertical blank intervals of the monitor signal (or the connected TV signal). This helps avoid image interruptions.

**Warning:** Because of waiting time required for the next VBI, this process adds significant computational time!

For digital displays like the TFT monitors you can deactivate the option. In the Overlay mode image formation occurs exclusively in VBI.

**Use high resolution for fullscreen playback**

**Note:** This option is available only in the standard mode (hardware acceleration Direct3D) (view page 121).

If the option is activated, image resolution during preview will be increased. This demands more computer resources, but is not a problem for most graphics cards. You should deactivate this option only if you have problems with fullscreen playback.
Project- and slideshow-relevant settings

New project - Settings

When creating a new disc project, you can specify multiple settings that will continue to apply to the related slideshows.

Load existing project or slideshow: Select from the last projects and slideshows you were working to start working from where you previously left off.

Create new project: Give your disc project a name. This name will be used as a preset title for the disc you are going to burn. The slideshows will also be given this name.

Use 16:9 aspect ratio for current project: This option lets you edit the slideshow from the very beginning in 16:9 format. The video monitor's size adjusts to correspond to this.

Advanced

Display time for each photo: By default, photos are displayed for the time entered here. Of course, you can change the time each photo is displayed later.

Fade photos automatically with effects: When loading photos, they will automatically fade from one into the other using effects. These fades can be changed or removed later.

Cut new images to fit screen automatically: Images that do not correspond to the slideshow's ratio are adjusted automatically. The zoom factor is set in such a way that there are no black bars to the left or right or top to bottom.

Presets for the capacity display: Set the disc type you prefer here. MAGIX PhotoStory on CD & DVD 10 estimates how much space a disc project will occupy on a corresponding blank disc. This display can be found below the slideshow.
Movie properties

The dialog with the settings for the current slideshow are displayed here. The dialog can be opened via the "File" menu (view page 155).

Automatically select preview image

MAGIX PhotoStory on CD & DVD 10 uses an automatically-selected preview image.

Use image file

Clicking the folder button opens a dialog to load image files. In this dialog, you can navigate to the directory where the image file is found and select it by double clicking.

Use preview image from movie

Use the fader to select a frame from the current slideshow.

Burn disc

Switch to the "Burn" screen first by pressing the corresponding button.

You can burn your movies (including a selection menu) onto CD, DVD, Blu-ray Disc, or upload them to MAGIX Online Album.

All movies loaded into the project will be included. If you want to remove some of the movies, switch back to the "Edit" screen and delete some of them from the project. To do so, switch to the corresponding movie, open the "File" menu and select "Manage movies -> Remove movie".

Note: The program display changes at a screen resolution of 1280 x 1024. This makes the program more manageable and easier to use. The work steps remain the same despite the different display.
Preview and editing

MAGIX PhotoStory on CD & DVD 10 provides two different modes for designing and previewing the disc menu.

**Preview**
The preview mode is mainly intended to behave like a DVD player or Blu-ray player for checking the disc menu under realistic conditions. Only templates may only be used; more detailed editing of the disc menu is not possible at this time.

**Edit**
During editing, you may adjust many features of the disc menu. There are many templates available for this that may be changed flexibly once loaded.

Remote control
The virtual remote control is an important helper when it comes to checking how the disc will perform later.

When you later insert the CD or DVD with your disc project into your player, this remote control will control the preview picture just like a "real" remote control controls the picture on a monitor or TV. The DVD menu navigation can now be initiated with the arrow keys or the "OK" button. Activated buttons are highlighted.
The **number keys** select the corresponding entry on the menu page. All menu entries are marked with a corresponding number. Within a chapter menu, playback is started from the particular scene. In the movie menu, the corresponding chapter menu (if available) is changed or movie playback is started.

**Navigation keys:** These help you move from one section to the next in the menu of the CD/DVD being burned. You can switch between individual entries and confirm the switch by pressing "OK". The remote control works just like the remote control for your home DVD player.

**Skip/Move forward/back:** This allows you to skip to the next or previous scene while playing back your movie. In the menu, you can skip forward or back from one menu page to another.

**Play:** Starts the first entry in the menu. In case both the scene menus and chapter menus are available (see menu mode), the scene menu will be displayed first.

Press the play button again to start playback at the beginning of the first scene of the first chapter.
Pressing stop halts playback.
Disc switches to the first page of the film menu.
**Sub** switches into the chapter menu (if available) of the currently selected film.

**Menu**

MAGIX PhotoStory on CD & DVD 10 can add graphical selection menus to your movies. The menu is also burned to disc and appears when inserted into the player. Just like with a purchased DVD or Blu-ray Disc™, you may easily select your movies with the help of preview pictures, or access particular chapters within a movie.
Menu templates

At the bottom of the screen, you’ll see an array of preset menu templates. A tree structure is located on the left-hand side for you to choose the type of menu template.

- **Animated (DVD):** These templates contain background and introductory videos as well as music. The DVD menu tools are displayed in various modes (selected buttons, for example). The templates can only be used for mini DVDs and DVDs. If you burn a VCD or SVCD, then still pictures and normal tools will be shown. Music can also be used.

- **Static (DVD, VCD, SVCD):** Here you will find templates suitable for use with DVDs, VCDs and SVCDs. They consist of normal background pictures and tools.

- **Unique:** These templates adjust to your disc project; the photos you use are integrated directly into the menu. Every menu is unique and matches the project in its own way.

- **TV ShowTime DVD:** Use these templates (suitable for miniDVDs and WMV HD) to show your pictures, not as small preview pictures in the slideshow menu, but rather as a full-size preview photo on every menu page. This way you can use the "Skip" keys of the remote control to present the photos like a slideshow - with the option of being able to start the slideshow at any time from the current photo onwards.

**Note:** For these menus you have to leave the modes "slideshow and photo menus" activated!

- **HD DVD, WMV HD, miniHD-DVD:** These templates contain super-sharp, high-resolution background images that are particularly noticeable on HD TV devices.

**Note:** This function is only available in MAGIX PhotoStory on CD & DVD 10 Deluxe!

If you selected a specific type of menu template, you can use the horizontal scroll bar to view all the templates. There are several possibilities when using the templates:

- If you wish to apply a template to all menu pages, click on "Complete" in the template bar and double click on the template of your choice. The complete template will then be applied.
- You can also combine the various elements of the individual templates. If, for example, you wish to combine the text format of a template with another
background, select "Text" and double click on the template with the desired text. The preview in the middle shows you the results immediately.

You can load the template (or individual template elements) for the current menu (slideshow or photo) as well as for all menus.

Click on this button to load the current selection for the entire disc menu.

Clicking on the small arrow next to the button opens a menu containing additional options for applying the current selection to the disc menu or current menu page.

**Edit disc menu**

The preview pictures and the menu title can be moved freely in the preview monitor. The menu may be edited very flexibly.

Activate the "Edit" button to do this.

**Load an OnDisc editing from disc (only Deluxe version)**

Use this button to load the DVD-/+RW in your drive for on-disc editing. For more information on this, consult the On-disc editing section.

**Edit menu elements**

Hold down the left mouse button and drag text boxes or graphical elements to the desired position. You can adjust the size by dragging out the corners and edges of the frame.

You can undo the last steps you made. This means that you can easily try out critical operations. If the result does not meet your expectations, then you can simply "undo" it and return to the initial status.

Keyboard shortcut: Ctrl + Z

This command cancels a previous "Undo" command.

Keyboard shortcut: Ctrl + Y
Set aspect ratio: Avoid distortions by using this button to set the page proportions of the menu elements.

Group: Menu elements, including the description text and number, can be moved or scaled in size.

Fade in TV display area in the preview monitor: This option displays the image borders of the television (view page 105) as lines in the preview monitor.

Grid: You can precisely align the frame positions with one another using the grid button. A dialog can be opened to set the grid more exactly using the small arrow next to the button.

**Navigation**
- All movies are listed as first entries. The corresponding menu level is the **film menu**.
- All scenes are listed as second entries to the right. The corresponding menu level is the **chapter menu**.

Removing the red check deactivates the corresponding entry in the photo menu. The scenes are still played, but you can no longer select them directly from the menu.
- If you click a film entry, then the film menu will open in the preview.
- If you click one of the chapters listed, then the chapter menu will open in the preview.

**Disc options**
You may deactivate the menus entirely or customize them here.

Intro video: Press this button to load videos to be used as introductions to your DVD or mini DVD. The *.avi, *.mpg, *.mxv, *.vob formats are supported. The intro is played immediately after the DVD has been inserted into the player. The DVD menu will then appear. A check mark "Do not skip" ensures that the intro video must be played completely each time the disc is inserted and that it may not be skipped with the remote control or otherwise.

Slideshow & photo menu
The disc menu essentially consists of two layers:
**Slideshow menu:** The upper layer includes the slideshow menu, which is only used if a project contains multiple slideshows.

**Photo menu:** This is the lowest layer of the disc menu, which takes the photos (in the first track of the timeline mode) into the slideshow as menu entries.

**Warning:** A photo menu may only contain up to 99 entries. If your slideshow contains more than 99 photos, you should either burn the slideshow without the photo menu or split your slideshow into several parts.

**Note on SVCD compatibility**
Some DVD players may have difficulty playing created SVCDs (despite fault-free burning) if the disc contains a project burned in "Chapter and photo menus" mode and contains several slideshows and/or a large number of photos. These compatibility problems can be avoided by:

- Using menu mode 1 or 2 for SVCD,
- Only adding a single movie to the disc, or
- Turning off the PBC (playback control) function, i.e. the menu navigation of the DVD player.

**Preview pictures:** Shows/hides the preview pictures in the disc menu.

**Numbering:** The numbers beside the menu entries can be selected directly using the remote control, but they might be disturbing sometimes. Use this option to show/hide them.

**Frame:** A frame borders the preview pictures. If you think it gets in the way, then you can easily remove it using this option.

**Design page**

**Background graphic:** You have three options in this case. You can either set a certain "color value" for the background. Or, you can select an image file from your hard drive. You can also select a certain frame from a video in your project.

**Animated selection menus**
Audio-visual animations may also be added to the DVD menus. As required, background videos are played as endless loops while the menu is shown on the screen. Add background music in various formats or use any background picture for each menu.
Sound/music: Load an audio file into the preview monitor and use it as an animation in the menu background.

Video: Load a video or graphics file into the preview monitor and use it as an animation in the menu background. In addition to the options for the background graphic (see above), you may also use a sequence from a loaded slideshow or from a different video file.

Background video options:

- Create animated menu buttons: The preview images for individual movies in the movie menu are shown as small movie samples. Set the start point and length of the animation using the sequence options faders.
- Use video's audio track: The audio track of the background video is used with the menu.
- Play menu animation as a loop: The background video (audio and/or video) is played back as a loop.
- Length of the menu view is set by: Audio/video or whichever medium is longer. You can specify how long the background video should be here. The other medium will be played as a loop.

Design button

MAGIX PhotoStory on CD & DVD 10 enables simple editing of any menu entry. They will appear in the disc menu as buttons with preview images.

Only in the Deluxe: New menu pages may also be added or irrelevant pages may be removed.

- Adds a new menu entry.

- Removes the selected menu entry.

Tip: If you would simply like to deactivate unused menu entries, this may be done via the navigation.

Note: Undesired menu entries may be deactivated in Navigation.

Pressing this button or double clicking the menu entries allows menu entries you have created to be edited. The dialog with the properties of the menu entries (view page 132) will open.
**Edit in MAGiX Photo Designer:** These buttons open MAGiX Photo Designer for further editing of your background pictures or the selected menu elements.

**Jump to linked page**

To test the targets of menu entries, select the desired menu entry and click the button.

**Menu entry/menu page properties**

Double clicking the preview picture or a menu entry opens an editor for you to adjust the preview picture or menu entry.

**Menu text**

In the text input field, you can enter any text to match the chosen menu entry.

- Set the vertical direction of the text (upwards, centered or downward).

- Set the horizontal direction of the text (left, centered or right).

**Font size:** Set the height of the text in pixels.
Font color: Define the foreground color of the text.

Font: Set which font and which style (bold, italic, etc.) should be used.

Shadow: Set the color and size of the shadow that will appear underneath the text.

3D effect: If you would like to make your text appear three-dimensional, you can set the width, height, and color of the 3D effect.

Apply to all: Except for the text, all settings are applied to all entries in the current menu.

Menu image
Use frame from movie: Use the fader to set which frame should be used in the video as a preview picture. The numerical input fields are sorted as follows: Hours:Minutes:Seconds:Frames.

Use different graphic: You can also load your own bitmap images to be used as menu pictures.

Hint: It may be the case that there are no menu pictures in some menu templates, so changing the menu picture won’t have any noticeable effect.

Actions at the end of the slideshow (Slideshow menu only)
Here, you can enter which action should be carried out once the slideshow has finished playing. You have the choice of:

Stop playback: This option depends on the DVD player being used. Most DVD players show the DVD player’s own menu (or background picture) after playback.

Jump to slideshow menu/photo menu: Jumps back to the previously shown menu.

Tip Should one of the two options not be available, then check which menu mode is set.

Jump to next slideshow: The next slideshow will be played without having to do anything else.
Play slideshow as an endless loop: You can burn every slideshow onto a miniDVD or DVD as a loop as well. This means that the slideshow is played as an endless loop until the next menu entry is accessed using the remote control, or until playback is stopped. This way you can transform your TV into an aquarium, a train journey, a fireplace, or anything that you could watch over and over again.

**Note:** This option only works with DVDs or miniDVDs.

Edit your own menu entries
There is another view in this dialog to edit menu entries you have created. Menu links can be edited here. This makes it possible to link a menu entry with a certain action, menu page, or a certain position in the slideshow.

No link: The menu element cannot be selected and has no function other than to display menu text.

Link to page in current menu: Jumps to a a menu page in the current slideshow or chapter menu in the current slideshow.

Link to another menu: Opens another slideshow or slideshow menu.

Link to chapter in a slideshow: If this option is selected, enter the slideshow and photo where playback should start.

**Note:** For DVDs, only chapters within the current slideshow may be jumped to.

Link to slideshow start: The entered slideshow will be played from the start.

OnDisc Editing
With OnDisc Editing you can burn more slideshows onto disc at a later stage and customize the menu accordingly. It's also possible to just rework the menu.

In order to use OnDisc Editing, the “Prepare disc for OnDisc Editing” option has to activated. You will find this option in the "Burn disc" dialog (view page 124).

To put a slideshow onto a DVD, first load the slideshow and switch to the "Burn" interface, insert the DVD-/-RW and click this button.
MAGIX PhotoStory on CD & DVD 10 will ask you if you wish to add the slideshows loaded into the Edit Slideshow Monitor to the disc. If you answer "Yes", the entries will be added to the existing menu.

It is **not** possible to retroactively edit already burned slideshows in Edit Slideshow Monitor. (For this, use the Recover backup project function). You may only make changes to the menu.

In addition to the standard options of menu design (see “Burn” interface), you can remove existing slideshows from the menu in OnDisc Editing mode, in order to replace them by new reworked versions.

- Select the slideshow in the navigation structure
- and press the "Del" key.
- To re-insert the slideshow, press the "Shift + Del" keys.

**Note!** Deleting certain parts of your DVD-/+RW is not possible. Every new version of the menu will be burned additionally to the disc, reducing the available disc space by the size of this addition.

It is impossible to delete slideshows from a DVD. If you remove a slideshow from the menu, it will still be played, providing “Actions at the end of the movie” is set up accordingly. To find out more see “Menu entries and preview images”.

With “Burn disc” you can create your "new" disc. Here, only the new slideshows and the adjusted menu will be encoded and burned to disc.
Burning wizard

Click "Burn" to open the screen where you create DVDs, Blu-ray Discs, or another video medium, including a menu.

Here you can select what kind of disc you would like to create. Under "Additional options" you will find other disc formats that are used more seldom.

Note: For each disc format there are different limitations. For example, with many formats animated menus are not possible or no menus and transitions at all are possible. You can find an overview of these limitations in the PDF manual or in "Help" under "Appendix: Digital videos and storage media".

Disk space

<table>
<thead>
<tr>
<th>Disc type</th>
<th>Storage media</th>
<th>Menu</th>
<th>Quality</th>
<th>Length (optimal quality)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD</td>
<td>DVD</td>
<td>Yes</td>
<td>***</td>
<td>98 min.</td>
</tr>
<tr>
<td>WMV HD</td>
<td>CD/DVD</td>
<td>Yes</td>
<td>*****</td>
<td>107 min./DVD</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>15 min./CD</td>
</tr>
<tr>
<td>Blu-ray Disc TM (view page 213)</td>
<td>Blu-ray Disc™</td>
<td>Yes</td>
<td>*****</td>
<td>110 min.</td>
</tr>
<tr>
<td>AVCHD (view page 213)</td>
<td>DVD/Blu-ray Disc™</td>
<td>Yes</td>
<td>*****</td>
<td>30 min./DVD</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>160 min./Blu-ray Disc™</td>
</tr>
<tr>
<td>Multi Disc</td>
<td>CD/DVD</td>
<td>Yes</td>
<td>****</td>
<td>45 min./DVD</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>7 min./CD</td>
</tr>
<tr>
<td>MiniDVD (view page 216)</td>
<td>CD</td>
<td>Yes</td>
<td>***</td>
<td>approx. 20 minutes</td>
</tr>
<tr>
<td>JPEG DISC</td>
<td>CD/DVD</td>
<td>No</td>
<td>*****</td>
<td>This depends on the original images and</td>
</tr>
</tbody>
</table>

www.magix.com
* The set duration for some DVD players may be determined by this table. The amount of image material that can be put onto a CD or DVD depends on the sizes of the picture files.

You may also use the menu templates from the category "TV Showtime DVD" for the disc types MiniDVD and DVD. Each picture of a slideshow is displayed fullscreen on its own menu page (without having to playback the slideshow).

For the MPEG-2 encoder especially, which is used for SVCDs, DVDs, and MiniDVDs (i.e. CD-ROMs written in DVD file format), it can be difficult to supply reliable relating to the required memory space. If the "variable bit rate" of the MPEG-2 encoder is activated, encoding will occur according to the movements in the picture. The required memory depends on the film material; an action film would need more memory than a drama, for instance.

If you cannot save your disc project on a single blank CD, you will have to divide it up into different sections.

Further information on MPEG compression and formats can be found in the chapter "Attachment: video and data storage devices (view page 207)" of the PDF manual.

**Test series with variable encoder settings**
If you would like to know how much memory space you require for various encoder settings, you should run some simulations before burning.

So you don’t waste any blank CDs while testing, you should activate the “Simulate first” option.

Then create, for example, a short (ca. 5 min.) disc project and simulate burning in multiple cycles with various settings.

After every simulation you can access the created file on the hard disk to check how large the file has become.

From the results, you can extrapolate how much disc space your disc project will require. The memory requirements of a 5-minute disc project would have to be multiplied by 20 in order to estimate the space required for a 100-minute movie. You should also add buffer for the selection menu. (view page 126)
Separate project onto multiple discs

Automatically: If the disc project requires more memory than is available on the CD or DVD, a dialog will appear before burning asking whether the disc project should be automatically segmented for multiple discs. Confirm this by clicking “Yes”. The disc project will then be automatically divided into individual disc projects and burned sequentially onto multiple discs. This is the easiest method as everything is automatic and all you have to do is insert a new blank CD when required.

Manual

Case 1: If several slideshows do not fit onto a single disc.
In this case, delete as many slideshows as is needed until the remaining slideshows fit onto the disc. You can create a new disc project and load and burn the other slideshows afterwards.

1. Return to the "Edit" screen.
2. All slideshows which shouldn’t be burned at this time must be placed into a project of their own. Save them separately to your hard disk (“File > Manage slideshows > Export slideshow file, for example, as “Part 2” and “Part 3”).
3. Remove the desired slideshows (e.g. "Part2" and "Part3") from project (menu "File > Manage slideshows > Remove from project").
4. Switch to the "Burn" interface and burn the first slideshow (“Part 1”) to CD or DVD.
5. Create a new disc project (“New” button), switch to the “Edit” view and load it into the second slideshow (“Part 2”).
6. Switch to the "Burn" interface and burn the second slideshow to CD or DVD.
7. Repeat the last two steps for each separately saved slideshow.

Case 2: If a long slideshow doesn’t fit onto a disc.
In this case, the slideshow has to be split into two or more parts that will be burned separately onto disc.

1. Switch back to the "Edit" view and place the start marker to the position at which you wish to divide the movie. In the "Edit" menu, select “Cut -> Separate slideshow”.
2. All passages behind the start marker will be removed from the slideshow and made into a smaller slideshow. Both slideshows can be moved using the "Select to edit" menu in the Arranger. Save both of them separately to your hard disk (“File > Manage slideshows > Save slideshows” menu option, for example, as “Part 1” and “Part 2”).
3. Remove one of the two slideshows (for example, "Part 2") from the disc project ("Manage slideshows -> Remove from project" menu option).
4. Switch to the "Burn" interface and burn the first slideshow ("Part 1") to CD or DVD.
5. Create a new disc project ("New" button), switch to the "Edit" view and load it into the second slideshow ("Part 2").
6. Switch to the "Burn" interface and burn the second slideshow to CD or DVD.

Edit DVD menus featuring MAGIX Photo & Graphic Designer 6

Customizing menu templates:

- **Export menu template**: Export desired template as a PSD file from MAGIX PhotoStory on CD & DVD 10 and import into graphics program.
- **Change font**: Create a new text layer, assign a new name, and add it to the correct layer set.
- **Create new background/button graphics**: Import newly created button graphics into the graphics program, scale and move them until the size and position are correct. Rename the created layers and add them to the correct layer set.

Create a custom new DVD menu: We recommend adjusting an existing menu template using a graphics program beforehand. This exercise will help you learn about the functions and structure of a DVD menu as a PSD file to create menus without using any templates.

Export menu

The transfer of the menu templates to the graphics program takes place in one of two ways:

If a complex, longer edit is required or if you have created a menu without a template, then use the PSD import/export function in the menu editing functions.

Next, open the PSD file in the graphics program of your choice.

For smaller changes, you can also shorten this process: click the button "In external editor" in the "Disc options" on "Design page".

www.magix.com
A temporary PSD file will be added and opened in the program that has been selected in the program settings as the menu editor. After editing has been completed and saved in this external program, the temporary PSD file will be imported again and the menu page will be updated immediately.

**Menu text with external menu editing**

Menu elements are transferred as a bitmap during PSD export as well as during import of the edited PSD. This also applies to the text displayed in the menu. This text may also normally be changed in the "Menu entry properties" dialog. The menu text are adjusted if movies or chapters are added or removed.

The PSD contains these texts as a bitmap and cannot be changed. During importing, the bitmaps replace the original text entries. By the way, this is maintained, and the font will only be set to a size of 0 so that texts are not displayed in duplicate; the menu will therefore look identical after external editing.

It is important that no more movies or chapters are added to the menu. Otherwise the preview images, that have also changed along with the menu structure will no longer match the bitmap text, since the bitmap text will not match the changed references in the menu structure!

**An example**

A chapter with two entries is present. Entry 1 is named "travel preparations". Entry 2 is named "arrival". A chapter named "the trip" is going to be added between chapter 1 and chapter 2. The second chapter now becomes chapter 3 and moves to the next menu page.

**Normal text behavior:** The second entry (now with preview image for the newly inserted chapter) receives the new title "the trip". The next menu page features chapter 3 as the first entry with the name "the trip".

**Text after external menu editing:** The second entry will feature the title "arrival" (as a bitmap, as a component of the button), but the preview image will feature the new chapter "the trip"! The next menu page now features the preview image for chapter 3 (formerly chapter 2, "arrival"), this is now called "travel preparations"! The name is a component of the button as a bitmap for the first menu entry on the page, and this is "travel preparations" on the first menu page. Completely out of order!
If the number of menu entries displayed is increased, this results from copying the layer groups in the PSD (see below). Of course, the rendered text layers are also copied into the layer groups, which results in incorrect text again.

The best way to proceed is to edit the text entries at the very end, since changes normally will not follow at this point. If changes are required nevertheless, then proceed as follows:

1. Restore the "correct" chapters or movie names by resetting the font size in the dialog "Menu entry properties" to the default value. Two texts will be displayed; the incorrect bitmap and the correct one.
2. Export the menu template as a PSD.
3. Delete the incorrect bitmap object in the corresponding layer and re-import the PSD.

Of course, the menu text may also be added from the start via an external graphics editing program only (in order to take advantage of the additional options provided in this case). Delete the corresponding bitmap objects in the PSD immediately after export and replace these with your own text objects.

Structure of a PSD file

MAGIX PhotoStory on CD & DVD 10 produces a PSD file during export that contains a layer for each object of the menu entry. This uses a naming scheme that enables assignment of the objects in the file to their contents. Individual layers feature mathematical signs that indicate their function. This naming scheme is similar to that featured in Adobe Premiere and which is only expanded occasionally in MAGIX PhotoStory on CD & DVD 10 to describe additional mechanisms.)

This is how these mathematical characters are used:

Characters for layer groups

<table>
<thead>
<tr>
<th>Character(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(+) or (+)</td>
<td>Play button/start film</td>
</tr>
<tr>
<td>++</td>
<td>Chapter menu button</td>
</tr>
<tr>
<td>+&gt;</td>
<td>Next page</td>
</tr>
<tr>
<td>+&lt;</td>
<td>Previous page</td>
</tr>
<tr>
<td>+^</td>
<td>Root menu button (jump back from chapter menu)</td>
</tr>
<tr>
<td>+*</td>
<td>Menu title:</td>
</tr>
<tr>
<td>^^</td>
<td>Layer group is ignored</td>
</tr>
</tbody>
</table>
Characters for individual layers

(-) Layer contains text
(=1) Layer contains a bitmap with a highlight of the menu element.
(%) Preview image/thumbnail from the movie to be referenced
Bitmap information will be ignored during import and only the size and position will be exported.

Edit externally

Step 2: Edit menu in MAGIX Photo & Graphic Designer 6: The created PSD file will now be loaded in the external applications.

Editing a menu for 3 to 5 movies
Once the PSD file has been loaded in MAGIX Photo & Graphic Designer 6, the pages & layers gallery will open. Each layer of the PSD file will be created with the contained objects via the corresponding Photo & Graphic Designer layers. The layer groups are represented by the names of the individual Photo & Graphic Designer layers, with PSD layer names separated by backslashes (\).

Find the layers of the group, which you would like to duplicate. In the example, this refers to the 4 layers on the movie button ad two layers of the chapter menu button. You will have to work a little to ensure visual assignment of the objects to the work area, since the program does not select the corresponding objects when a layer is selected, and conversely it doesn't select the layer when the work area with objects is selected. Open a layer in the pages & layers gallery and select the contained object. The selection is displayed in the work space.

Clicking "duplicate" copies the 6 layers individually with the corresponding objects in the pages & layers gallery. The created layers will always be placed at the top position, so it makes most sense to copy the existing layers from the lower level to the top. Otherwise, the correct order of the new layers may be restored using drag & drop.

Next, select all of the button’s objects while holding the "Shift" key to move them to a new position. Normally, the frames and chapter menu objects behind the highlight layers also need to be selected and dragged. Multi-selection in the object gallery is not possible since the objects are in different layers, and the program will prevent you from selecting them together.

These steps must be repeated for each additional button.

Finally, the changes must be saved as a PSD file. Select "Export" in the "File" menu to do this ("Save as..." does not allow this).
Add new font to text
In MAGIX Photo & Graphic Designer 6, activate the text tool after loading the PSD file, and write the desired text next to the movie button.

Next, localize the existing text layer for the individual movie buttons (page & layer gallery, see above). Drag and drop the text object from the background into the desired layer and delete the previous text object ("Del" key or "Delete" in the pages & layers gallery). Since naming takes place in the surrounding layer and the objects in program themselves don't have names, you don't have to rename anything.

Repeat this process for every movie button and "Export" the result.

Adjust background and buttons
In this case, MAGIX Photo & Graphic Designer 6 features a workflow similar to creating new texts.

For example, when the menu template is open, drag and drop two graphics for navigation buttons into the existing PSD. Two new layers will appear in the menu template with two new graphics objects. Drag these into the layer with the bitmap graphics to be replaced. Renaming them is unnecessary, since the surrounding layers take care of this.

Localized, scale, and move as follows: Create graphics for your new menu, e.g. for "Prev" and "Next" buttons, by dragging them into the open PSD. This includes a total of 4 layers, two button graphics, and two highlights. The highlight layers must be renamed and scaled and placed on the screen using the mouse. Move the layers into the "(+-) next button" or "(+-<) prev button" layer set using drag & drop.

Play back menu in MAGIX PhotoStory on CD & DVD 10
After editing, a PSD file is created, which is imported into MAGIX PhotoStory on CD & DVD 10 again and must then be assigned to a menu page as a template.

If access takes place via "Edit externally" see above (view page 139), this is done automatically during saving and closing of the graphics program. Otherwise, use the button "Import PSD" to do this.

This imports and converts the PSD (saved to an automatically generated folder in the folder Content\DVD\Layouts, with TPL files and the generated bitmap files).
Create DVD menus without a template

It is recommended that an existing menu template is adjusted first with a graphics program. This exercise will help you learn about the functions and structure of a DVD menu as a PSD file to create menus without using any templates.

You can create PSD files without templates if the following is observed.

- MAGIX PhotoStory on CD & DVD 10 can only use bitmap layers from the menu PSD file. Text layers are read as a bitmap (graphic) so that MAGIX PhotoStory on CD & DVD 10 cannot make any changes to the text. Layer effects, etc. cannot be read by MAGIX PhotoStory on CD & DVD 10. For this reason, all layers featuring additional features in the graphics program need to be reduced/combined to bitmap level.
- The correct naming of layers is very important! MAGIX PhotoStory on CD & DVD 10 assigns the layers and layer groups to the menu items via their names, which makes their correctness important. The characters added in front (view page 139) of the layer names should therefore be observed.

A correct menu PSD contains the following elements:

- background
- menu title
- x movie buttons with preview image, frame bitmap, text for menu, text for numbering, highlight
- one chapter menu button per movie button with bitmap and highlight
- 3 navigation buttons: in front, in the back, and the root menu

**Background:** The background utilizes all layers from the PSD file from the very back to the foremost "usable" layer groups. All of the layers up until this are combined via alpha layering. If the appearance of the background in the graphics and in MAGIX PhotoStory on CD & DVD 10 is different, then this step may also be made in the graphics program. In Photoshop, all associated layers would be combined with the background layer.

**Menu titles:** In the next step, the layers of the menu title are added and combined into a single layer group. This must feature a name that begins with "(+*)". Besides the text layer, additional layers such as text background, shadows, etc. may be present. All layers are unified as a single layer via alpha layering.

**Film buttons:** Layers for film buttons are each combined as a layer group that features the prefix "(+-)" or "(+)" at the beginning of its name. The layers
themselves have different functions that are kept together via this naming prefix.

**Preview image:** The name of the layer for the preview image begins with "(%)". In this case, MAGIX PhotoStory on CD & DVD 10 only reads the position and size of the layer and uses this range to generate the preview image. In case multiple preview images are present, their right corners will be combined during importing.

**Text layer:** This includes text layers beginning with "(-)". "(-) index text" serves as an identifier for the naming, all other text layers will bear the name of the button label.

**Highlight layer:** The highlight layer is the top of the layer groups. Its name begins with "(=1)". This should contain a highlight version (e.g. altered color) of the frame bitmap.

All other layers will be combined into a frame bitmap.

**Chapter menu buttons:** The last portion features the layer groups for the chapter menus and navigation buttons. These are named variously ("(++)" or "(+-)","(+>)", and "+(^)"), by they feature the same principle the structure. All highlight layers (beginning with "(=1)") become the highlight bitmap; all other layers become the buttons bitmap via alpha layering.

The sequence of the layer groups from the PSD file is basically not considered by MAGIX PhotoStory on CD & DVD 10. Characterization in the program takes place in the order outlined here, even if the associated layer groups in are saved in a different order in the PSD file.

An exception is formed by movie and chapter menu buttons: arrangement in MAGIX PhotoStory on CD & DVD 10 takes place in the sequence featured by the PSD file. The first chapter menu button detected belongs to the detected movie button, the second to the second movie button, and so on.
Burn dialog for DVD player

Here you can select your burner, the type of disc, the encoder settings. For video CDs it is MPEG-1, for Mini DVDs, Super Video CDs and DVD, use MPEG-2. Mini-HD DVD and Blu-ray disc uses MPEG-2, and higher bitrates are employed in order to reach the higher HD resolutions.

Proceed as follows to burn a disc:

- **Set up burner and burn speed**: If multiple burners are installed, you may select which device you wish to use in this menu.
- **Encoder settings**: Use the "Encoder" button to access the selection dialog to specify settings for the MPEG encoder (memory requirements, quality, and duration of the MPEG conversion). "Advanced settings" accesses a dialog featuring additional options. You can adjust all the fine settings for the MPEG encoder here.
- **Burning disc/starting video encoding**: The button "Burn disc" starts the disc burning process. Every time you burn and every time a simulation is carried out, the disc project is encoded. Please note that the MPEG file is not deleted from the hard disk after the burn process has finished. Depending on the length of the project, encoding and burning may take some time. The time required can be seen in the dialog.

**Creating an ISO image**

The simplest way to create an ISO image is to select "Image recorder" under "Burner". When starting the "Burning process", you have to specify a name for the image file you wish to create.
Options

**Simulate first:** If you are not sure about the write speed or memory requirements of the selected disc, you can simulate the write process before burning.

**Add project backup:** Use this option to add additional project data to the CD/DVD together with the selected video format. You can then load the disc project from the finished disc to re-edit it and create a changed version.

**Activate buffer underrun protection:** Many burners support techniques that prevent "buffer underrun". Use this option to activate this protective feature and burn your files at higher speeds (without risking making a coaster out of your blank disc).

**Completely format DVD/CD-RW media:** This option reformats the RW media and deletes all existing file material.

**Prepare disc for OnDisc editing:** With a DVD±RW, it is possible to add more slideshows to the disc, or to edit the menu at a later date. The disc has to be burned with the option "Prepare disc for OnDisc editing" activated.

**Shutdown computer after burning:** Activate this option to automatically turn off the computer after encoding and burning has been completed. You could, for instance, start the encoding and burning process in the evening, and then you don't have to wait for the process to finish to switch off your computer.

**Activate the burner's defect management option:** If a certain section of the disc is defective, then this will be recognized by the burner and labeled as such. No content will be saved there as a result.

**Burn standard video DVD onto same disc:** On a WMV HD disc you can use this option burn an additional normal DVD video onto disc. This ensures that your discs can also be played back on standalone DVD players. See Multi disc.

**CD/DVD title:** This is the title of the DVD as displayed as disc name on the PC. The disc project name is displayed here by default.

**Encoder settings**

Use the "Encoder settings..." button to access the selection dialog to specify the properties of the MPEG encoder (memory requirements, quality, and duration of the MPEG conversion)

**Preset:** This features useful settings for the selected disc type. Here are several sample DVD presets:

www.magix.com
Long-play video DVD  DVD with extra-long playing time. The bit rate is reduced, which compromises quality.

Long-play music DVD  DVD with extra-long playtime for music. The bit rate for the soundtrack remains at the highest quality level.

Standard DVD  Normal DVD

Widescreen DVD  Normal DVD in 16:9 format

**Note:** NTSC (USA and Japan) or PAL (Europe) may be selected for all settings.

**Bit rate:** The bit rate determines the memory required for the completed video. The higher the bit rate, the larger the file, and the shorter the maximum playing time of the movie that fits on a disc.

**Adjust bit rate:** The expected file size of the finished video is estimated, depending on the set bit rate. If the movie does not fit onto the disc, the bit rate is corrected accordingly.

**Quality:** Specifies the quality of the encoding process. The higher the quality, the better the finished video will look; however, encoding will take considerably longer.

**Smart rendering:** Smart rendering considerably reduces the load of encoding processing for MPEG files. During the production of MPEG files, only those parts of the movie that were changed in the program are re-encoded. Please note: The MPEG files contained in the movie **must** have the same format, i.e. the bit rates (variable or constant), audio formats, image resolutions and video formats must match.

**Anti-interlace filter:** This option should only be activated for playback on a TV screen, since it is intended to reduce line flickering.

**3D mode:** In case your project features 3D material that has been edited with Stereo 3D, a mode may be selected here for burning the material to disc. 3D is switched on as a standard.

To return to the standard settings, press the **Reset** button.

The "Advanced" button opens the "Advanced settings" dialog. You can adjust all the fine settings for the MPEG encoder here. Details about the "MPEG encoder settings (view page 183)" are available in the PDF manual and in the help file.
Burn WMV HD

WMV HD (Windows Media High Definition Disc) is a type of disc optimized for playback of slideshows on PC. The slideshow(s) are converted in a high-resolution format into the Windows Media 9 format and a menu is added, like with DVDs. You must have Windows Media Player 9 or higher installed on your PC. Video encoding will be preset for HDTV resolution (1280 x 720, also known as "720p"). To select different resolutions, click on the button “Encoder settings” and in “Presets” choose the following:

- Standard PAL (720x576) or NTSC (720 x 480)
- Standard PC resolutions (1024 x 768 or 1280 x 1024)
- HDTV 720p (1280x720) or 1080i (1920x1080)

Burn JPEG disc

The JPEG disc is a special case. No video file is created to be burned, but rather every photo in the disc project is exported individually with effects and burned to CD or DVD. Many modern DVD players can play JPEG files directly.

If a project contains several slideshows, a subfolder will be created for each one, and the corresponding images will be placed into each one. This means that there are no menus, no sound, no animated effects or transitions – although it does offer the best possible quality available for playback on TV.

Create PC show

Press this button to create a presentation optimized for your PC in the WMA format.

First, enter a path where the slideshow will be located and then click "OK".

Create webDVD

Here you can create an online presentation which can be uploaded to MAGIX Online Album and opened there. To do this, you must first register on MAGIX Online Album.

First you have to create and save the online presentation on your computer, after which it can be uploaded. Indicate a location to save the file. Usually the suggested folder needs no alteration.

www.magix.com
Export

The button "Export" opens the export wizard, which features the most important export settings for your slideshow. Note that only export the current slideshow may be exported. Other slideshows in the project and the disc menu are not included.

Save slideshow as video on your computer

This option recalculates a slideshow including all objects, effects settings, fades, texts, and other features into a video file and saves it on your computer.

Simply select a certain quality (e.g. DVD quality) and a file format (e.g. MPEG-4). The dialog provide further information about the properties of the selected medium.

Note: Only the most familiar and most often used formats are listed as options. "File -> Export slideshow (view page 159)" features many additional file formats.
Export as 3D video (Deluxe version only)

This option recalculates a slideshow including all objects, effects settings, fades, texts, and other features into a 3D video file and saves it on your computer.

Simply select a certain quality (for example, DVD quality) and a file format (e.g. MPEG 4). The dialog will provide further information on the properties of the selected medium.

**Note:** Read the chapter "Stereo 3D (view page 106)" for more information about 3D video.
Publish directly on the Internet.

This option uploads your movie directly to YouTube®, Vimeo, or Facebook (Deluxe version only). YouTube® is likely the most famous portal for homemade clips. Vimeo is becoming more popular as a platform for more demanding videos.

Community: Select the desired platform: YouTube, flickr, or Facebook.

Title: Enter the name of the slideshow.

Description: Add a short description of your slideshow to describe its contents to other community members.

Category: Select the category for your movie here.

Send: Select whether the film should be private, accessible only to you and authorized persons, or public, meaning freely accessible.

Export settings: Set various quality settings.
Publish via MAGIX Online Album

This accesses the MAGIX Online Album login dialog directly. Next, present your photos together with videos and music in custom-designed online albums.

www.magix.com
Export for mobile device - export video/audio

This dialog enables you to transfer your finished video onto external devices. In this case, MAGIX PhotoStory on CD & DVD 10 offers settings for a number of playback devices, including mobile phones, mobile video players, smartphones, PDAs, or games consoles.

Export to mobile devices

Most devices require certain format settings (file format, resolution, bit rate, picture repeat rate, etc.) to be able to play a video.

The menu is divided into various device classes (mobile phones, organizers and PDAs, games consoles, and video players) to make it easier to select your device. The last three selections are saved as favorites in the top part of the device list if you have more than one device or want to present your movies to your friends.

If your device is listed here, you won't have to worry about the format settings, because the necessary settings of the export dialog are automatically customized to the target device. Simply select your device, and then click the "OK" button - that's all.
Menus

In this chapter you’ll find the full menu list of your copy of MAGIX PhotoStory on CD & DVD 10 and the corresponding functions.

File Menu

New

Project

This menu item creates a new MAGIX PhotoStory on CD & DVD 10 project. You can also open this feature via the "New project" button above the video monitor.

Keyboard shortcut: Shift + N

Slideshow

This option creates a new slideshow. The default name for a new slideshow can be specified in the program settings.

Keyboard shortcut: Ctrl + Alt + N

Open

This menu item loads a previously saved MAGIX PhotoStory on CD & DVD 10 project. Please note that the related files must be accessible.

MAGIX PhotoStory on CD & DVD 10 searches for the used sounds, pictures and videos under the path to where you last saved the disc project.

Keyboard shortcut: Ctrl + O

Open automatically saved project...

This option loads an automatically created slideshow backup. This type of automatic backup gets the file extension MV_ (underscore). This command is only intended for use in emergencies, e.g. if you unintentionally saved your change and wish to return to the previous version of the project.

Keyboard shortcut: Alt + O
Manage slideshow

Remove from project
This option removes the current slideshow from the project.

Keyboard shortcut: Shift + F4

Rename
You can enter a name for the current slideshow here.

Attach
This function attaches an opened slideshow to another one. This attaches it to the end of the opened slideshow and automatically applies the original slideshow’s settings.

Attach an opened slideshow: An already opened slideshow can be selected from the list and attached. This option is only available if your project contains multiple slideshows.

Attach the last edited slideshow: All of the slideshows that were last edited are listed. This option is only available if other slideshows have been previously edited.

Load and attach a slideshow: Click a folder and a dialog will open to select a slideshow. Navigate like in Windows Explorer to the folder that contains the desired slideshow. Double clicking on a slideshow file (*.mvm) opens it and attaches it to the current slideshow.

Import slideshow file
Use this option to load a slideshow into your project.

Please note that all related photos must be accessible. MAGIX PhotoStory on CD & DVD 10 searches for the used sounds, pictures, and videos from the path to where you last saved the slideshow.

Keyboard shortcut: Ctrl + O

Export slideshow file
A dialog opens where you can specify the path and name of the slideshow. The slideshow can then be imported again into other projects.

Note: The slideshow file (*.mvm) contains all information about the used media files, cuts, effects, and titles, but not the picture and sound material itself. This is found in the recorded or imported media files that remain unchanged during
the entire MAGiX PhotoStory on CD & DVD 10 editing process. To save the full slideshow into a dedicated directory, for instance to continue editing on a different PC, please use the function "Copy movie and media into directory".

Wizards

This menu entry contains different aids for different tasks in MAGiX PhotoStory on CD & DVD 10.

Slideshow wizard
This wizard makes creating great slideshows (view page 25) child's play. You will be led through the necessary steps automatically.

Clean-up Wizard
The Clean Up Wizard helps you delete disc projects from you hard drive, including all slideshows and the audio, video, and picture files used in them. Use this function to free up disk space for future projects.

Caution: If the files you used in the slideshow have also been used in other slideshows (like trailers, opening music, for example), then you should make backup copies of these files beforehand.

Keyboard shortcut: Shift + I

Delete specific files
Choose this option if you would like to select certain files for deletion. You can select the desired files in the "File selection" dialog. In the next step, the Clean Up Wizard automatically looks for other files which belong to your selection. Using this method you can delete an entire slideshow with all of its accompanying media, help, project, and backup files. Before they are deleted you receive relevant information in a dialog and a confirmation request.

Search and delete superfluous files
Choose this option if you would like to find unnecessary files or free up some space on your hard drive. The Clean Up Wizard then automatically looks for extraneous files created during use of MAGiX PhotoStory on CD & DVD 10. Before they are deleted you receive relevant information in a dialog and a confirmation request.

Slideshow Maker
This is where to open Slideshow Maker.
Soundtrack Maker
This command opens the MAGIX Soundtrack Maker (view page 115).

Adjust music to section
If you have edited your background music with Tempo and beat recognition and a musical tempo was provided, then you can adjust the cuts to change automatically in time with the beat using this command. All hard cuts (edits without transitions) will be moved to occur on the musical quarter notes.

Keyboard shortcut: Ctrl + Shift + U

Save
The current disc project is saved with the name displayed in the project window. If you have not yet specified a name for your project, a dialog will open wherein MAGIX PhotoStory on CD & DVD 10 asks you to do so.

Keyboard shortcut: Ctrl + Alt + S

Save Disc Project as
A dialog opens where you can specify the path and name of the Disc Project.

Keyboard shortcut: Alt + Shift + S

Import
A dialog for importing media files opens. Choose between "Search" and "Automatic import".

Search: A dialog for selecting media files opens. The selected files will be imported into the current slideshow after "Open" is clicked.

Note: Media files can be dragged and dropped into the slideshow from the Media Pool much more conveniently.

Import automatically: To copy photos from a digital camera to the computer, the accompanying MAGIX Photo Manager program will open. As soon as the program is ready, connect the digital camera with the computer. The imported photos can be conveniently dragged from the Media pool into the slideshow. Please also read the MAGIX Photo Manager help file by pressing "F1" from within the program.
Scan image

Scan photo externally...
Opens MAGIX Photo Designer for scanning photos. This function is required if there are problems when scanning with MAGIX PhotoStory on CD & DVD 10.

Keyboard shortcut: Alt + Shift + A

Twain scanner

Select source
The TWAIN interface connects MAGIX PhotoStory on CD & DVD 10 with nearly all modern scanners or digital cameras. To scan, please proceed as follows:

1. Install the TWAIN software for your device.
2. Restart your PC.
4. Click on "File > Twain Scanner/Camera > Select source" if the scanner works with 32 bit software.
5. Select your device from the dialog. This step is only required once and only has to be repeated if you want to change the device.

Scan with
The scan window of your scan software will appear. Specify the resolution and color depth in this window. When the scan is complete, the TWAIN software should close automatically and MAGIX PhotoStory on CD & DVD 10 should now contain the newly created image file. It’s possible that the TWAIN window remains open. You can then scan multiple pictures one after the other.

Recording
Select between Audio recording (view page 74) and Single image recording.

Export
This provides all export formats supported by MAGIX PhotoStory on CD & DVD 10 that aren’t covered by burning. Refer to "Exporting" for more information.

Video as AVI
When exporting to AVI video, you can set and configure the size and frame rate of the AVI video and the compression codec for audio (audio compression) and video (codec).

Please also note the general info on AVI videos (view page 209)!

Keyboard shortcut: Alt + A

www.magix.com
Video as MPEG video
MPEG is short for "Motion Picture Experts Group" and is a very powerful compression format for audio and video files.

MAGIX PhotoStory on CD & DVD 10 is equipped with the high performance Ligos GoMotion encoder. In the MPEG export dialog you can fine tune the options for the MPEG encoder. MPEG files are created when you burn a CD/DVD. Usually standardized MPEG-1/-2 is used for creating (S)VCDs or DVDs. However, many DVD players can also process (S)VCDs with non-standard bit rates, so there is room for experimenting here.

Simply export your movie to MPEG via the File menu. When burning the disc the program recognizes that the file is already available and uses this instead.

Details on the MPEG encoder settings can be found in the MPEG Encoder help!

Shortcut

<table>
<thead>
<tr>
<th>MPEG-2 (DVD)</th>
<th>Alt + H</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPEG-2 (miniDVD)</td>
<td>Alt + I</td>
</tr>
<tr>
<td>MPEG-2(Super Video CD)</td>
<td>Alt + J</td>
</tr>
<tr>
<td>MPEG-1 (Video CD)</td>
<td>Alt + K</td>
</tr>
</tbody>
</table>

MAGIX video export
Exports the movie in MAGIX video format. This format is used for video recording by MAGIX video software and is optimized for digitally edited high-quality video material.

Keyboard shortcut: Ctrl + Alt + M

Video as Quicktime Movie
Exports the movie in QuickTime movie format. This enables streaming playback of audio and video files over the Internet.

As with RealMedia export, appropriate adjustments can also be made for video site, frame rate, and codec settings. However, the export dialog does not permit you to add commentary to the video.

For QuickTime files (*.mov) you have to install the QuickTime library.

Keyboard shortcut: Ctrl + Alt + Q
**Windows Media Export**
Exports the arrangement in Window Media format. This audio/video format is optimized for the Internet.

You can also use it to archive your movies in high-quality when compared to MPEG-sized files. Windows Media is an alternative if you would like to view your movies primarily on your PC. Pocket PC and Smartphone movies are also created with the Windows Media Format.

Depending on your requirements you can choose between different profiles. If the Windows Media Encoder 9 is installed (which can be downloaded free of charge from Microsoft) you can edit the profiles or add your own.

**Two pass:** The video is compressed in 2 stages in order to export highly-compressed videos for the Internet optimally.

**Slideshow:** Lets you create slideshows with audio soundtracks. The created files are very small despite their high image quality, since only still images (no transitions or movement effects) are displayed.

In the dialog you can add the author name, copyright details, and a description.

Keyboard shortcut:  Alt + F

**Advanced settings**
Here you’ll find more on the advanced settings in the Windows Media Video Export section. You can enter precise details for the format you wish to create. Profiles from the system or from another file can also be imported.

**Real Media Export**
Exports the arrangement in RM format.

RealMedia enables streaming playback of video files via the Internet. This has a very high compression rate, but the quality is noticeably reduced. After choosing a name for your file you can specify the bit rate of the transmission speed (modem, ISDN, etc.) at which the audio file can be played without errors.

There are many embedding options for meta information for this format.

**Audio settings/Video settings:** Here you can select the presets for the quality of the audio or video material. An additional dialog is opened via the "Advanced" button. In advanced video options you can select the frame rate.
per second (fps). The lower the rate, the less data will be transferred and the poorer the quality of the picture will be.

**Clip information:** Enter the author, video name, etc. to appear in the RealPlayer during playback.

**Clip meta information:** Enter keywords for search engines. If the RealVideo clip is loaded onto a homepage, then search engines will find it. However, these search engine tags can be deactivated.

**Video preprocessing:** The "2-pass encoding" field is of special interest, since you can improve the quality (audio and video files are compressed separately). Furthermore, you can select various filters.

**Video size:** Set up video sizes between 160x120 and 720x576 pixels.

**Profile:** Select the bandwidth for the video, i.e. over which data connection it will be played in real time ("streamed"). The settings selected may limit the other selections as files for 28k modems cannot be created at high quality. Streaming videos require a server application that must be installed on the server for the video to be played ("streamed") in real time. If you don’t have this application it has to be downloaded. "RealServer" is a server application that enables streaming video in RealVideo format.

**Key:** Alt + G

**Video as MPEG-4 video**

**Hint:** In order to use the MPEG-4 video export feature, you will have to activate this function first.

MPEG-4 is the most advanced video format available at the moment. Unlike others, it can provide high-quality pictures at the same file size.

Behind MPEG-4, you’ll find a highly complex "academic" standard that operates and is supported variably according to make. To go into detail on these differences and parameters would be beyond the scope of this documentation. For this reason, indications, along with the operational manual of your device, are given that should help create executable MPEG-4 files. For more experimental users, the complete setup options of the MPEG-4 codec can be found behind the "Advanced settings..." buttons.

**Video/Audio:** The MPEG-4 format and the advanced AVC format are also available but have, as of yet, only been used in a few devices. MPEG4 video can be combined with AAC or AMR sound, the latter mostly in conjunction with
Mobile phones. The combination ACC/AAC doesn’t appear very often (Apple iPod Video), ACC with AMR in contrast, not at all.

**Multiplexer:** Here you can find the so-called container formats and special options for Apple iPod and Sony PSP. MPEG-4 is usually used as an **output format**, mobile phones mostly use 3GPP.

Keyboard shortcut: Ctrl + Alt + G

**Animated GIF**
The video will be exported as an animated GIF file (also called "AniGIF"). This file format is supported by many mobile phones.

Keyboard shortcut: Ctrl + Alt + F

**Single frame as BMP**
Exports the image at the position of the start marker and displayed on the video screen as a BMP file.

Keyboard shortcut: Ctrl + Alt + B

**Single frame as JPG**
Exports the picture located at the current start marker and displayed in the video monitor as a JPG file.

Keyboard shortcut: Ctrl + Alt + J

**Internet**
This is a list of menu entries regarding all of the services that are available directly from within MAGIX PhotoStory on CD & DVD 10.

**Send slideshow as email (Deluxe version)**
With this option selected in the File menu a compressed file in Windows™ Media Format will be created. Your email program will be simultaneously activated and the file created will be added as an attachment of a new message. Any slideshow can be compressed without intermediate steps and sent as an email immediately.

Keyboard shortcut: Shift + U

**Transfer to external device**
Most devices require certain format settings (file format, resolution, bit rate, picture repeat rate, etc.) to be able to play a video.
The menu is divided into various device classes (mobile phones, organizers and PDAs, games consoles, and video players) to make choosing your device easier. The last three selections are saved as favorites in the top part of the device list if you have more than one device or want to present your movies to your friends.

If your device is listed here, you won’t have to worry about the format settings, because the necessary settings of the Export dialog are automatically customized to the target device. Simply select your device and click "OK".

**Download presets for new device**

The selection of playback devices is constantly changing. New devices or versions are coming on the market every day. The list of supported devices may therefore not be up-to-date and may not (yet) contain your specific device. MAGIX continuously maintains updated preset lists for the available devices (available online for download). Internet access is required.

The command "Download presets for new device" opens a website containing an up-to-date list of all supported devices and device versions. Just search for the desired device and click the corresponding link. The settings for the device will be downloaded and made available to you in MAGIX PhotoStory on CD & DVD 10.

**Warning:** Some browsers display a warning if you try to download an executable file (.exe). You can ignore this warning.

If your device is not listed on the website, you can report your unsupported device so that it will be included in later updates.

**Output to device**

This command opens the dialog for outputting the completed video or its soundtrack to analog or digital video recorders/camcorders or various mobile devices such as smartphones, PDAs, video players, or games consoles.

Please read the chapter "Output audio/video (view page 154)".

Keyboard shortcut:  

**Backup copy**

Files must be saved to be able to be easily retrieved in case of a hard drive crash or some other error.
**Copy project and media into folder...**
The project and all of the files it contains are saved together in one folder. Use this function to transfer an entire project to another computer.

Keyboard shortcut:   Shift + Q

**Copy slideshow and media into folder...**
The slideshow and all necessary files can be saved in any folder.

Keyboard shortcut:   Shift + R

**Projekt, Fotoshows und Medien brennen**
Use this option to burn the project with all relevant slideshows and their files to CD or DVD.

Even larger projects can be burned straight to disc. The project, if necessary, will be split up and burned automatically to multiple discs. A restore program which is burned to the first disc of this type of backup, guarantees easy re-recording of the backup.

**Burn slideshow and media to CD/DVD**
Use this option to burn the slideshow and all relevant files to CD or DVD.

Even larger slideshows can be burned straight to disc. If necessary, the slideshow will be split up and burned automatically to multiple discs. A restore program which is burned to the first disc of this type of backup guarantees easy re-recording of the backup.

Keyboard shortcut:   Alt + Shift + R
Use this menu command to restore a project backup that has been saved onto a CD/DVD. The disc has to be burned with the option "Add project backup data" (see "Burn disc dialog (view page 124)").

You can choose which of the slideshows contained on the disc should be restored by selecting it from the list and highlighting which directory. In this folder a subfolder Backup_xx will be created for each restored backup where all project files of the disc will be stored. All restored slideshows are then loaded into MAGIX PhotoStory on CD & DVD 10 and can be edited.

If you select the option "Restore image files only", only the original image files contained on the disc are restored.
Burn project (image) again

All necessary files, menus, and encoded video files needed to burn a CD/DVD will be temporarily stored on your hard drive. After your disc is burned, these are **not** automatically deleted. Use "Burn disc project (image) again" enables you to burn as many discs as you would like without having to encode the files again.

In the dialog, choose the image you want. All necessary files are then transferred to the MAGIX Speed burnR.

**Tip**: For more information on using MAGIX Speed burnR, read the help file of the program.

Settings

**Slideshow...**
Opens the settings for the current slideshow.

**Project...**
**Project name**: Give your disc project a name. This name will be used as a preset title for the disc you are going to burn. The slideshows will also be given this name.

**Use 16:9 aspect ratio for current disc project**: This option lets you edit the slideshow from the very beginning in 16:9 format. The video monitor's size changes to correspond to this.

**Cut new images to fit screen automatically**: Images that do not correspond to the slideshow’s ratio are adjusted automatically. The zoom factor is set in such a way that there are no black bars to the left or right or top to bottom.

www.magix.com
Program Settings
This menu item opens the Program Settings (view page 117).

Keyboard shortcut: P

Slideshow effect settings
This menu item accesses the slideshow's effects settings (view page 85, view page 58). The settings made here apply to the entire slideshow.

Keyboard shortcut: M

Change the program interface
Here you can switch between various designs, in which MAGIX PhotoStory on CD & DVD 10 can be represented.

Reset Program Settings to Default...
Use this function to reset all program settings (view page 117) you made in MAGIX PhotoStory on CD & DVD 10 to their original settings.

Exit
Closes MAGIX PhotoStory on CD & DVD 10.

Keyboard shortcut: Alt + F4
Edit Menu

Undo

You can undo the last steps you made. This means that you can easily try out critical operations. If the result does not meet your expectations, then you can simply "undo" it and return to the initial status.

Keyboard shortcut: Ctrl + Z

Redo

This command cancels a previous "Undo" command.

Keyboard shortcut: Ctrl + Y

Cut

This function deletes the selected photo (or the selected object in the Timeline mode) and copies it to the clipboard. You can then use the "Paste" command to copy it into any slideshow.

Keyboard shortcut: Ctrl + X

Copy

This command copies the selected scenes (or the selected object in Timeline mode) to the clipboard. From there you can paste it into any other slideshow using the "Paste" command.

Keyboard shortcut: Ctrl + C

Insert

This command inserts the clipboard material (photo or object) at the current position of the start marker.

Keyboard shortcut: Ctrl + V
Delete

This command cancels the selected photo (or the selected object in Timeline mode).

Keyboard shortcut: Del

Objekt austauschen

Replaces the selected object with an object selected in the Media Pool. Length adjustment moves the objects following it correspondingly.

If photo objects are removed/exchanged, then the display duration will remain.

Split object

This command cuts a scene at the point where the start marker is positioned. This way, two free-standing objects are created.

You can isolate a part of an object in order to delete it:

1. Place the start marker where you’d like to have it by left clicking in the timeline.
2. Select the video object by clicking on it and click on the cut button.
3. Place the start marker at the end of the part you wish to remove and click on the cut button again.
4. Select the middle object that was created and press the "DEL" key.
5. Pull the object at the back to the front; it should automatically snap into place. All subsequent objects will be moved along in unison so that no gaps appear.

You can also use this function to apply effects to a certain part of an object only.

Keyboard shortcut: T
Effects Menu (FX)

Image optimization
This places the image material in the right light, sharpens shaky recordings, and corrects tint, all conveniently from the Media Pool.

TV picture
This submenu item performs various adjustments for the TV picture. Besides interlace and anti-flickering filters, you will find the option to adjust the image to the real proportions of the TV picture. A special algorithm ensures an optimal ratio between image size and image borders (anti-cropping).

Interpolation for interlace material
Choose this option to remove interlace artifacts from your video image. If, for instance, you extract freeze frames from a video, ridge structures appear in sequences which feature movement.

Anti-flicker filter
Choose this option for still pictures with detailed structures and high contrast. This filter reduces line flickering during TV playback.

Border cropping adjustment
Select this option if the edges are cropped during playback on your television. Values stored in “Slideshow effects settings (view page 105)” will be applied.

Distortion
Image material can be transformed in various artistic ways; a broad palette of effects is available to you for this in the Media Pool.

View & animation
These effects allow properties like section, image size, position, and rotation of image and video objects to be specified in the Media Pool.

Design
Add different decorations, speech bubbles, and animations to photos directly in the Media Pool to add life to your slideshow.

Rotate 90°
Rotates the image 90° clockwise/counterclockwise.
Shortcuts: Ctrl + Alt + F to the right
Ctrl + Alt + G to the left

You can also turn a photo in Storyboard (view page 44) mode via the rotation buttons on the photo box.

Automatically cut to fit monitor

This option enables photos to be adjusted to suit the current format. In this case, the picture is zoomed in to such an extent that the upper and lower parts of the photo are hidden and the annoying black bars to the sides disappear. The consequence of course is that portions of the image will be missing.

Keyboard shortcut: Shift + A

Display duration...

Enter the display duration for the current photo here in [Minutes]:[Seconds]:[Frames].

Tip: The display duration for photos may also be set in the Media Pool. To do so, click on the desired photo and select the "Effects" tab.

Apply to area between the start and end markers: Applies the settings to all photos located between the start and end markers.

Apply to all: The settings are applied to every photo in the current movie. The settings will not be applied to photos in additional movies in the project.

Edit image (external)...

The command "Edit image (external)" enables photos to be edited with the MAGIX Photo Designer graphics program. The command appears in the context menu for every image. The context menu opens by clicking the small FX button at the top edge of the photo box. A dialog window of the MAGIX Photo Designer wizard appears. This is a clever little helper that recommends several typical photo tasks from which you can simply select the specific task, mark with a cross, and then send your picture to MAGIX Photo Designer. MAGIX Photo Designer opens and loads the selected picture. In MAGIX Photo Designer you are supplied with the necessary instructions for editing your photos. Have fun experimenting!

After editing has been completed, the modified picture will be used instead of the original material.
Retouch red eye, select clippings, apply creative distortions ("flowing color"), enhance Internet photos, and much more. The integrated MAGiX Photo Designer makes it possible. Even unsuccessful recordings can be fit for presentation in the blink of an eye. Read more on this in the MAGiX Photo Designer help.

Create panorama image...

With only a single click you can create a panorama (view page 114) in MAGiX PhotoStory on CD & DVD 10. You can do this fully automatic or manually; try experimenting with it.

Picture-in-picture collages

These work similarly to normal picture-in-picture effects, but more objects are used. Depending on the collage, arrange the selected objects one after the other and drag the collage onto the first object.

Fades

This features all fades sorted into the various categories. One click on a category displays all of the blends that are contained.

To load a fade, click it and drag it onto the object that should be faded into. Alternatively, you may select the object that you would like to fade into and double-click on Fade in the Media Pool.

Background design

Select a color, a picture, or any video on your hard disk which you would like to serve as the background for the photo displayed. This function is especially useful when photos have black bars around them or if they are reduced in size.

Video Stabilization

Opens the video stabilizer dialog to help you correct shaky footage. Read more on this topic in "Video Stabilization".

Keyboard shortcut: Shift + K

Title Editor

Title Editor

Keyboard shortcut: Ctrl + T

www.magix.com
Save as title template...

If you have designed special titles, these can be saved as a template. Titles will be saved in the titles folder in MAGIX PhotoStory on CD & DVD 10 to make them easier to find in the Media Pool (under "Titles).

Keyboard shortcut: Shift + E

Convert to 3D titles...

The title object will now be turned into a MAGIX 3D object. If you have also installed MAGIX 3D Maker, the program will open for you to work on the text.

Fade in date as title

MAGIX PhotoStory on CD & DVD 10 can add a time or date ("timecode") to the picture material. To add a timecode, right click the image and choose the "Fade in date as title" option from the context menu.

If a photo file is involved (i.e. a photo created with a digital camera that contains EXIF data), then the date the picture was taken will be added. If a different kind of file is involved, the creation date will be used as the timecode. Next, the title editor opens for you to customize the entry.

Sound optimization

The "Audio cleaning (More Informationen can be found in the section "Sound optimization" on page 91)" dialog will open to help you remove noise.

Keyboard shortcut: Shift + W

Adjust music to section

If you have edited your background music with Tempo and beat recognition and a musical tempo was provided, then you can adjust the cuts to change automatically in time with the beat using this command. All hard cuts (edits without transitions) will be moved to occur on the musical quarter notes.

Keyboard shortcut: Ctrl + Shift + U

Reset Effects

This is not really an "effect", since it actually deactivates all current effects.

Show/Hide

Hides or shows the selected object.
Properties

This function displays all the information about the currently selected objects such as file name, position on the hard-drive, tempo, etc. The Object Editor also defines the foreground and background color of every object in the arrangement.

More information is available under Object properties.

Online menu

This is a list of menu entries regarding all of the services that are available directly from within MAGIX PhotoStory on CD & DVD 10.

Tasks menu

In this menu you will find direct solution and short video explanations on how to perform tasks in different topics. Not only will you find step-by-step instructions for sound and pictures here, but you also find quick access to many of functions.

If you click on an entry with a camera symbol, then you will open a short tutorial video which displays a solution. Entries without camera symbols offer a solution to the problem immediately.

Help Menu

Help

This command is available for almost every feature of the program, and it opens the "Help" file for the corresponding topic. Use this command to get help on any of MAGIX PhotoStory on CD & DVD 10's functions.

Keyboard shortcut: F1

Content

Use the command "Content" in the "Help" menu to open the start page of the help file. You can read through the help file step-by-step and jump to specific sections via the tree structure on the right hand side.
magix.info

Help and get help - Directly from within the program, you'll be able to access magix.info, the new MAGiX Knowledge Database. You'll find answers to all the most frequently asked questions about MAGiX products and multimedia in general. Couldn’t find an answer to your particular question? No problem – just ask the question yourself!

You can access magix.info online at http://www.magix.info

Start introductory video

The introductory video shows you how all the most important features work. Specific topics are explained in detail in additional tutorial videos.

Keyboard shortcut: Ctrl + F1

To play the introductory video you may have to insert the program CD.

Display Tool Tips

Tooltips are small information windows that open up automatically if the mouse pointer stops briefly on a button or some other area. They provide information about the function of the button. These information boxes can be switched on or off with this option.

Keyboard shortcut: Ctrl + Shift + F1

MAGiX Screenshare

This function makes it possible for you to offer assistance to other users directly via the Internet, or to get help from others. To do this, you have to register MAGiX PhotoStory on CD & DVD 10 first.

Hint: To inform the screensharing guests of exactly what is being shown, it is also a good idea to telephone or chat simultaneously.

Register as host for a screen transfer

1. If you want to start a screenshare instance yourself, then you have to register as a host first. To do this, open the menu "Online" and then select "Screen transfer as host...".
2. In the dialog you can enter a name for the screen session. Your user account name is used here by default.
3. Now click on "Start session". A small window will now open in the bottom right corner which displays the status of your screen session. A number will also be displayed (session ID) which serves as a password for your guests.

4. Start the screenshare instance.

Register as guest of a screen session
1. You have to register as a guest to view a screensharing instance. To do this, open the menu "Online" and then select "Screen transfer as guest...".
2. Enter the password you received from your host (8-digit session ID).
3. Now click on "Start session". A window will open displaying a smaller version of your host's screen.

Register online
This option opens the MAGIX homepage for online registration where you can register yourself as a MAGIX user.

Registration grants you access to the MAGIX support website http://support.magix.net (see support) where various program updates and help programs can be downloaded.

With the registration form supplied (start menu under "MAGIX PhotoStory on CD & DVD 10 -> Service and support -> Register") you can register via post or fax. Simply print it out, fill it in, and send it off!

Online Update
Connects directly to the online update page where you can get the latest version of your program.

About MAGIX PhotoStory on CD & DVD 10
Displays copyright info and version number of MAGIX PhotoStory on CD & DVD 10.
Activate additional functions

You can activate encoders/decoders for various file formats as required.

Why does it have to be "activated"?
To import (decode) or export (encode) certain video and audio formats, you will require a specific codec. MAGIX PhotoStory on CD & DVD 10 will ask you if you want to activate the codec as soon as you need it. The integration of decoders and encoders from third parties into programs usually costs money. These codecs are integrated via additional, voluntary activation in MAGIX programs which, according to usage and degree of prevalence, can be free or fee-based for special high-quality codecs. This way, MAGIX can continue to be able to provide you with optimum value for money for your software.

Free activation (MPEG 2 codec)

To be able to use the MPEG-2 codec, you will have to first activate it for free.

Activation can be done online via telephone or via post/fax. The quickest and easiest way to order an activation code is via the Internet.

Order activation code online
Click on "Order online..." (Field 1). Your Internet browser will open. Once you have registered, the activation code will be sent to the email address you supplied upon registration.

If your computer has no Internet access, you have the following options for activation:

Order activation code in MAGIX Service Center
Use this option to conduct activation from a different computer which has Internet access.

Order activation code via telephone
The telephone number and necessary details you will need to call to receive activation by telephone are displayed here.

Order activation code via post/fax
After clicking on "Order via post/fax" (field 2), your user code will appear. This automatically assigns your personal activation code to your PC. Click on "Continue to order form" to transfer your user code automatically to the post/fax form. Now send the completed form as a print out to the address/fax information provided.
no. mentioned. Your activation code will be sent to you in just a few days via post or fax. It can also be sent by mail if an email address is stated.

**Enter activation code**
After receiving your personal activation code, you can use the activation dialog for the corresponding file format to start exporting for the respective format. If you receive the activation code via email, then copy it into the input field in the dialog and click "Activate...".

**Fee-based activation (MPEG-4)**
The MPEG-4 codec requires a fee-based activation. This can be done online, via telephone, or via post/fax. The quickest and easiest way to order an activation code is via the Internet. Ordering the activation code takes just a few minutes via email. Ordering your activation code via post/fax requires a few days for processing.

**Order activation code online**
Click on "Order online..." (Field 1). The web browser will open for you to register MAGIX PhotoStory on CD & DVD 10 first (if you have not already done so). You will then be forwarded to a website where you can request the corresponding activation.

If your computer has no Internet access, then you have the following options for activation:

**Order activation code in MAGIX Service Center**
Use this option to conduct activation from a different computer which has Internet access.

**Order activation code via post/fax**
After clicking on "Order via post/fax" (field 2) your user code will appear. This automatically assigns your personal activation code to your PC. Click on "Continue to order form" to transfer your user code automatically to the post/fax form. Now send the completed form as a printout to the address/fax no. mentioned. Once payment has been processed successfully, your activation code will be sent to you in the post/via fax in just a few days. Optionally, it can also be sent by email if an email address is stated.

**Enter activation code**
After receiving your personal activation code use the export or burn function to reopen the activation dialog for the corresponding file format. Type or copy the activation code into the input field in the dialog and click on "Activate...".
Activation problems

**Problem:** The entered code is incorrect (telephone activation)

Make sure your entry is correct; in most cases a typo is to blame. If the code is entered correctly, dial the number of our Call Center. Our support staff will help you personally.

**The MAGIX website won't open**

Check your Internet connection; you may have to use manual dial-up.

**The form for ordering via post/fax won't open**

- Check that an adequate text editing program is installed and activated (for example, MS Word).

**I still haven't received an email with the activation code**

- Check that your inbox isn't full.
- Have a look in your spam folder.

You can always send questions via email to our support whenever you like. Please have the following information at hand so that we can assist you as quickly and as specifically as possible.

- Complete product name
- Exact version number (to be found in the about box in the "About" menu item of the "Help" menu)
- Encoder/Decoder name
- Your user code (accessible via the "Activate via post/fax" dialog)

**Problem:** I have installed MAGIX PhotoStory on CD & DVD 10 on a new computer, installed a new hard drive in my old computer (sound card, memory...), or installed it multiple times on the same computer. My activation code is no longer accepted!

If the program cannot be activated again after it has been activated multiple times, please contact the MAGIX customer service (view page 7).
Problems and solutions

File will not load

- If files cannot be loaded, this means that the format is either not supported by MAGIX PhotoStory on CD & DVD 10, or the corresponding codec must be activated first. Read the sections "Import and export formats" and "Activate additional functions".
- In case of AVI files, it is possible that the necessary codec is not installed. For this, read the section "General tips for AVI videos" (view page 209) in the "Digital video and data carriers" supplement of the PDF manual or help (F1 key).

Tip: To find out which codecs are used in the movie file, different help programs are available. An example for this is "GSpot" or "AVIcodec".

Choppy or uneven playback

Don’t panic if the picture on your screen is choppy or uneven. The finished product will look perfect and play smoothly. Don’t forget that MAGIX PhotoStory on CD & DVD 10 calculates all effects in real time. This lets you see for yourself what sort of influence each of the effects will have on your video footage. Some effects make even today’s high-performance PCs work quite hard, and often, a steady, continuous video stream is simply not possible on your PC. The final product, free from previous choppiness, is only available after rendering it to DVD or exporting it. For that reason, you should first edit the movie in its raw version without effects. The preview generally delivers a steady picture, allowing you to work quickly and quietly. Towards the end, you can add effects to your movies to give them a special touch of Hollywood!

Activation problems

Problem: The entered code is incorrect (telephone activation)

Make sure your entry is correct; in most cases a typo is to blame. If the code is entered correctly, dial the number of our Call Center. Our support staff will help you personally.
The MAGIX website won't open

Check your Internet connection; you may have to use manual dial-up.

The form for ordering via post/fax won't open

- Check that an adequate text editing program is installed and activated (for example, MS Word).

I still haven't received an email with the activation code

- Check that your inbox isn't full.
- Have a look in your spam folder.

You can always send questions via email to our support whenever you like. Please have the following information at hand so that we can assist you as quickly and as specifically as possible.

- Complete product name
- Exact version number (to be found in the about box in the "About" menu item of the "Help" menu)
- Encoder/Decoder name
- Your user code (accessible via the "Activate via post/fax" dialog)

Problem: I have installed MAGIX PhotoStory on CD & DVD 10 on a new computer, installed a new hard drive in my old computer (sound card, memory...), or installed it multiple times on the same computer. My activation code is no longer accepted!

If the program cannot be activated again after it has been activated multiple times, please contact the MAGIX customer service (view page 7).
Appendix: MPEG Encoder Settings

General settings

MPEG type: Set the output type of the created MPEG file. You can adjust the encoder settings freely (to export your video in the corresponding format, for instance) for further use in other programs or on your own website.

If you open the encoder from a burn dialog, or intend to use the exported material for VCDs, SVCDs or DVDs, then select the corresponding option. This will adjust the settings of the encoder according to the standards required for the corresponding discs to be played in a compatible player.

Video format: Automatically specifies the video format, aspect ratio, and frame rate (see video settings (view page 184)). You can choose between PAL or NTSC.

Interlace mode: The movie is encoded interlaced (i.e. in two half-screens, so-called fields). This is essential for later playback on TV screens. If you want to view the exported movie on your PC only and like a "cinemascope" view, you can also encode by frame (progressively). Some video projectors also support playback of progressively encoded image material. See Interlace (view page 203).

Bit rate: The bit rate determines the memory requirement by the completed video. The amount of data available can be used differently for different display modes. 20 MB can be 4 seconds of DVD video, or 5 minutes of Internet streaming at the thumbnail size. The quality of an MPEG video is measured by the width of the created data stream, i.e. the bit rate. This is the amount of transmitted data per time unit and is indicated in kBit/s or bit per second.

Quality: Determines the quality of the encoding process, or the quality of the movement (view page 201) to be more precise. The higher the quality, the better the finished video will look, but encoding will take considerably longer. The preset value "10" is a good compromise between speed and quality.

Smart Rendering: Smart Rendering can considerably reduce the encoding/processing strain of MPEG files. The production of MPEG files re-encodes only those parts of the movie that were changed in the program (e.g. by video cleaning or effects). Please note: The MPEG files contained in
the movie must have the same format, i.e. the bit rates (variable or constant), audio formats, image resolutions, and video formats must match.

**Quick, GOP-precise copying:** This special Smart Rendering mode enables MPEG material to be transferred without having to encode it for the target medium, thereby greatly increasing the encoding speed. The video material cannot appear to have been altered in any way; only hard cuts (without fades) are permitted. These won’t be executed precisely to the frame, but will rather take place at the next GOP borders. For this reason, cuts should be set somewhat more generously.

To burn DVDs in original 5.1 Surround Sound (Dolby Digital Audio) without having to re-encode, this option has to be activated.

Allows you to rip the necessary settings from an existing MPEG file. This can be useful if you want to merge MPEG files together without re-rendering via Smart Rendering.

**Video settings**

**Frame rate:** PAL requires 25 frames/sec, NTSC 29.97 frames/sec. Please note: encoding NTSC material as PAL or vice versa may be possible; however, it will result in jittery images.

**Aspect ratio:** Lets you set the image side or pixel ratio. With MPEG 2 the image format is displayed as image ratio; correspondingly there is 1:1 (square screen, not recommended), 4:3 (regular video) an 2.21:1 (cinemascope). This applies irrespectively of the selected video format.

With MPEG 1 the pixel format is specified instead. There is 1:1, CIR601 (corresponds to regular video) for 625 lines = PAL and 525 lines = NTSC and the same in 16:9. When selecting the output format Video CD the pixel format is automatically adjusted to the selected video format. Use with caution, even if you only want to export MPEG 1.

The option **Auto** is set as default. Here you can adjust the Movie settings accordingly.

**Resolution:** Width and height of the video corresponds with the settings in the export dialog.

**GOP structure:** Here you can change the settings of the GOP (view page 203) sequence, i.e. the number of P frames per I frame within a GOP. Please note that the total length of the GOP must not exceed 15 frames, which
corresponds to the default setting (1 I frame + 4 P frames + 5*2 B frames = 15 frames).

However, you can reduce the length of the GOP sequence (while compromising the image quality at the same bit rate). This speeds up the encoding process considerably as the motion estimation while encoding P and B frames requires high CPU performance. The speed of decoding, i.e. playback, is also increased.

If I frame is set to 1, each frame is an I frame. If the value is set larger, the setting describes the total length of the GOP.

**Auto GOP:** Closed GOPs do not contain relations to frames from subsequent GOPs. MPEGs where all GOPs are closed, make MPEG editing easier as the I frames only can be edited alone if the GOP is closed. Auto GOP closes GOPs at scene changes, whereby two different and complex procedures ("fast" and "VSCD") are used.

**Bit rate mode**

In "constant bit rate" mode a bit rate that constantly remains the same is used. This option should be used for Video CDs, as it is only required here. With a constant bit rate the full power of MPEG compression can not be used properly as bandwidth for non-moving scenes is lost.

"Variable bit rate" mode attempts to adjust the available storage space to the requirements of the video you want to encode. The actual bit rate fluctuates around a mean value. During calm sections of the video it may drop to a minimum value, if there are movements in the scene it may rise to the maximum value. There are two different regulation processes (mode 1 and mode 128).

**Advanced video settings**

**MPEG profile and level:** The MPEG-2 standard defines so-called "profiles" and "levels". For creating SVCDs and DVDs you can use "Main profile and Main level". The high profile adds additional properties to the data stream like the option to display an image at a reduced resolution for restricted transmission quality (SNR-scalable profile), or locally scaled, for instance an HDTV data stream on a standard TV set. The 4:2:2 profile is used if the image data is to be encoded for alternative chroma scanning. However, these profiles are supported by very few encoders, and mainly only for professional use.
These levels define the restrictions to the image resolution and the maximum data rate. Low level can only reach a reduced resolution (352x2888 = CIF); high level, or High 1440, enables encoding in HDTV format.

Estimate movement: These parameters are controlled via the quality controller (see General Settings).

Other

Noise sensitivity: This factor defines how sensitive the encoder will react to noise in the source material. If the source material only contains a little noise (digital recordings, computer animations, or material already de-noised by video cleaning), then you don’t have to change the default value 4, or you can even reduce to increase the quality further. However, if you want to encode noisy material, then too low of a factor will considerably increase the encoding time at the cost of quality. For an unedited analog video you can increase the factor to 8-14.

Noise reduction (click on noise sensitivity): A noise filter is used with adjustable settings from 1-31.

Advanced parameters

Additional expert settings are available in the tree to the right of the window. These should only be changed by experienced users. They have been optimized for general applications to such an extent that changes are only necessary in exceptional cases.

Audio settings

Audio type: You can use MPEG Layer 1, 2 or PCM (WAV) audio. Select "No audio" in the export dialog.

Sample rate: You can set a sample rate of 32, 44.1 or 48 kHz for the audio track. VCDs and SVCDs require 44.1 kHz, DVDs require 48 kHz. To reduce the size of audio data it is recommended to lower the bit rate instead of the sample rate.

Mode: You can use Mono, Stereo, Joint Stereo or Dual Channel.

Bit rate: Here you can set the bitrate of the audio signal. The higher the bit rate, the better the playback quality. VCD requires 224 kBit/s, and for SVCDs and DVDs select a value between 384 kBit/s and 448 kBit/s.
MPEG-4 encoder settings

Behind MPEG-4, you'll find a highly complex "academic" standard that operates and is supported variably according to make.

**Tip:** First, check if there is a suitable preset in the export dialog for your purposes. Before changes are made in "Advanced settings", the effects and interplay of the different parameters should be familiar.

The "Advanced settings" are divided into "Video", "Audio", and "Multiplexer".

Under "Video", there is a choice between "MPEG-4 (view page 187)" (H.263) and "AVC/H.264 (view page 192)". Depending on the purpose of application of the material to be exported, both of these encoder settings can be selected for compressing the video material. It is important in this case to know how the material will be played back.

Under "Audio", there is a choice between "AMR (view page 198)" and "AC (view page 198)". The AMR format is more suitable for mobile devices that don't necessarily require high playback quality. ACC is more flexible, on the other hand, but it is supported by fewer mobile devices.

For material that is not exactly specific, encoder qualities recommend AVC image and AAC sound, since these encoders are equally suitable for all source material.

The option "Export as website" also creates an HTML page in an integrated Flash player that can play back the video created. Read the topic "Embed Flash videos into your own web site".

**MPEG-4**

The MPEG-4 (H.263) codec is especially useful for video material with little or only slower movements.

**Generic MPEG-4 preset**

Different presets located within the encoder.

**(A)SP@L0-L5:** (Advanced) Simple Profile in Level 0-5

**(Q)CIF (Common Intermediate Format):** CIF is a video format produced as soon as 1990 with the video compression format H.261. At that time, the format was used for video telephone conferences.

www.magix.com
The "Q" in QCIF stands for "Quarter", and since resolution is halved in terms of height and width compared to CIF, the entire size is only a quarter of CIF. QCIF was popular with mobile telephone manufacturers, since the resolution of 176 x 144 pixels was sensible for the first affordable SmartPhones (144 x 176).

**(Half)D1:** D1 corresponds with MPEG-2 DVD. HalfD1 has exactly half of the entire number of pixels, meaning that the pixel number of the height and weight is 2/3 of D1.

**720p:** Video stream with a resolution of 1280 x 720p (progressive).

**Apple iPod:** Apple iPod-compatible stream.

**Sony PSP:** Sony PSP-compatible stream.

**Profile/Level**

So that profile and level are conformant with the other settings, pay attention to the minimum and maximum values in the following tables.

---

**Note!** In case the settings are not included in this information, problems playing back the encoded videos can lead to problems.

### Table 1: The levels of the MPEG-4 simple profile (SP)

<table>
<thead>
<tr>
<th>Level</th>
<th>Typical visual session size</th>
<th>Max. number of objects</th>
<th>Maximum number objects per type</th>
<th>Max. unique quant. tables</th>
<th>Max. VMV buffer size (MB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>L0</td>
<td>QCIF</td>
<td>1</td>
<td>1 x simple</td>
<td>1</td>
<td>198</td>
</tr>
<tr>
<td>L1</td>
<td>QCIF</td>
<td>4</td>
<td>4 x simple</td>
<td>1</td>
<td>198</td>
</tr>
<tr>
<td>L2</td>
<td>CIF</td>
<td>4</td>
<td>4 x simple</td>
<td>1</td>
<td>792</td>
</tr>
<tr>
<td>L3</td>
<td>CIF</td>
<td>4</td>
<td>4 x simple</td>
<td>1</td>
<td>792</td>
</tr>
</tbody>
</table>

**Continuation of table 1**

<table>
<thead>
<tr>
<th>Level</th>
<th>Max. VCV buffer size (MB)</th>
<th>VCV decoder rate (MB/s)</th>
<th>Max. total VBV buffer size (units of 16384 bits)</th>
<th>Max. VOL VBV buffer size (units of 16384 bits)</th>
<th>Max. video packet length (bits)</th>
<th>Max. bitrate (kbit/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>L0</td>
<td>99</td>
<td>1485</td>
<td>10</td>
<td>10</td>
<td>2048</td>
<td>64</td>
</tr>
<tr>
<td>L1</td>
<td>99</td>
<td>1485</td>
<td>10</td>
<td>10</td>
<td>2048</td>
<td>64</td>
</tr>
<tr>
<td>L2</td>
<td>396</td>
<td>5940</td>
<td>40</td>
<td>40</td>
<td>4096</td>
<td>128</td>
</tr>
<tr>
<td>L3</td>
<td>396</td>
<td>11880</td>
<td>40</td>
<td>40</td>
<td>8192</td>
<td>384</td>
</tr>
</tbody>
</table>
Table 2: The levels of the MPEG-4 advanced simple profile (ASP)

<table>
<thead>
<tr>
<th>Level</th>
<th>Typical visual session size</th>
<th>Max. number of objects</th>
<th>Max. number per type</th>
<th>Max. unique quant. tables</th>
<th>Max. VMV buffer size (MB)</th>
<th>Max. VCV buffer size (MB)</th>
<th>VCV decoder rate (MB/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>L0</td>
<td>176x144</td>
<td>1</td>
<td>1x AS or simple</td>
<td>1</td>
<td>297</td>
<td>99</td>
<td>2970</td>
</tr>
<tr>
<td>L1</td>
<td>176x144</td>
<td>4</td>
<td>4x AS or simple</td>
<td>1</td>
<td>297</td>
<td>99</td>
<td>2970</td>
</tr>
<tr>
<td>L2</td>
<td>352x288</td>
<td>4</td>
<td>4x AS or simple</td>
<td>1</td>
<td>1188</td>
<td>396</td>
<td>5940</td>
</tr>
<tr>
<td>L3</td>
<td>352x288</td>
<td>4</td>
<td>4x AS or simple</td>
<td>1</td>
<td>1188</td>
<td>396</td>
<td>11880</td>
</tr>
<tr>
<td>L4</td>
<td>352x576</td>
<td>4</td>
<td>4x AS or simple</td>
<td>1</td>
<td>2376</td>
<td>792</td>
<td>23760</td>
</tr>
<tr>
<td>L5</td>
<td>720x576</td>
<td>4</td>
<td>4x AS or simple</td>
<td>1</td>
<td>4860</td>
<td>1620</td>
<td>48600</td>
</tr>
</tbody>
</table>

Continuation of table 2

<table>
<thead>
<tr>
<th>Level</th>
<th>Max. percentage of intra MBs with AC prediction in VCV buffer</th>
<th>Max. total VBV buffer size (units of 16384 bits)</th>
<th>Max. VOL VBV buffer size (units of 16384 bits)</th>
<th>Max. video packet length (bits)</th>
<th>Max. bitrate (kbit/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>L0</td>
<td>100</td>
<td>10</td>
<td>10</td>
<td>2048</td>
<td>128</td>
</tr>
<tr>
<td>L1</td>
<td>100</td>
<td>10</td>
<td>10</td>
<td>2048</td>
<td>128</td>
</tr>
<tr>
<td>L2</td>
<td>100</td>
<td>40</td>
<td>40</td>
<td>4096</td>
<td>384</td>
</tr>
<tr>
<td>L3</td>
<td>100</td>
<td>40</td>
<td>40</td>
<td>4096</td>
<td>768</td>
</tr>
<tr>
<td>L4</td>
<td>50</td>
<td>80</td>
<td>80</td>
<td>8192</td>
<td>3000</td>
</tr>
<tr>
<td>L5</td>
<td>25</td>
<td>112</td>
<td>112</td>
<td>16384</td>
<td>8000</td>
</tr>
</tbody>
</table>

**Picture type**

"Picture type" specifies which parts of a frame should be used as the basis for the encoding:

- **Frame**: A frame is a single image from a video sequence, also called a full image.
• **Field**: A half-image, two of which combine to produce a frame. Read more about this explanation regarding "Interlace (view page 203)".

**Field order**

**Note**: This parameter is only available if the setting "Field" is selected for "Picture type".

In case of interlaced streams, the half-image sequence is set. Read more about this explanation regarding "Interlace (view page 203)".

**Pulldown**

**Note**: This parameter is only available if the setting "Frame" or "MBAFF" (only for AVC/H.264) is selected for "Picture type".

In normal cases, an image playback rate of 24 (or 23.976) frames per second is use; the NTSC system however requires 30 (or 29.97) frames/s, and there is a special algorithm for converting the video’s frame rate. For compilations or test purposes, switch this option to "No". In normal cases, the setting can be set to "Auto".

**Slice count**

A frame can be divided into multiple slices for encoding. Specify the maximum number of slices are permitted. If set to "0", then the number will be determined automatically.

**Bit rate control**

The bit rate indicates how much data per second is saved in the video (playback speed). This makes the bit rate the deciding parameter for the video to be encoded.

**Mode**

- **Constant bit rate**: The constant bit rate should only be used if the device used to play the video supports constant bit rates.
- **Variable bit rate**: The bit rate varies. For faster movements in the video, the bit rate increases, and for still images or slow pans, a lower bit rate is sufficient for creating the video in constant quality.
- **Constant quality**: Similar to the "Variable bit rate" mode, the bit rate varies according to the video material. The quality depends on the selected profile and can be changed.
- **Constant quantizer**: In this mode, a fixed colour quantization is used for the macro blocks. Under Advanced settings, a value between 1 and 32 can be set independent of the respective frame (I-Frame (view page 203), P-Frame, or
B-Frame (view page 205)). The higher the value, the stronger the quantization: small values produce qualitatively high-quality images and the data rate increases, and larger values produce a reduction in data, but the quality suffers.

**Bit rate (Bits/s)**
- In "Constant bit rate" mode: Exactly those values entered are applied to be able to calculate the size of the video precisely.
- In "Variable bit rate" mode: The values entered here are applied to the video as an average as a guideline. The size of the video to be exported can only be approximated.

**Max. rate**
This is the maximum bit rate that should be present in the video stream, i.e. maximum number of bits that may be transferred to the decoder.

**Note:** This option is only available in "Variable bit rate" mode.

**VBV buf. size**
VBV is the abbreviation for "Video rate buffer verifier definition" and the size of the buffer (storage area) that is applied to the encoding.

The larger the buffer is, the better the results will be, but the processing will also take much longer. The smaller the buffer is, the more parallel processing can take place at the same time in RAM.

**Pixel aspect ratio**
Specifies the page ratio of the individual image points (pixels).

**Meaning:** Different television norms and the standard pixel ratio. Select a setting and the results are displayed as "X" and "Y".

**X/Y:** The actual pixel ratio. If under "Meaning" the setting "Custom" is selected, then a custom ratio can be set.

**GOP structure**
**Max key interval**
Determines the maximum GOP (view page 203) length. High values mean improved compression. Lower values create stronger security protection and enable improved access to individual frames for processing the video.
B-frames count
The number of B-Frames (view page 205). Several applications, e.g. video conferences, require a setting of "0" for this, i.e. no B-Frames, in order to enable the shortest possible reaction times for transfer.

Scene change detection
If this option is activated the scenes will be detected during encoding, thus allowing you to insert an I frame (view page 203) after a scene change.

Input info
Information about the incoming video stream is displayed here during live recordings.

Statistics
Information about the encoder activity is displayed here during live recordings.

AVC / H.264
The H.264/AVC codec is suitable for all types of material; however, it requires relatively higher CPU power for later decoding.

In the advanced encoder settings of the AVC encoder the "Generic" options in "Main Settings" are mainly interesting.

The AVC preset and video format can be adjusted here. For instance, if DVD quality is desired you should select "DVD". The video format should be selected specific to the country so that the material can be played on the devices most commonly available in these countries. For instance, you should select PAL for Germany, SECAM for France and NTSC for the US.

Generic
AVC preset
This is where the actual video stream that will be exported is selected.

- **Baseline**: According to ISO/ICE 11172-1/2 standard
- **CIF**: Corresponds with MPEG-1 VideoCD
- **Main**: Corresponds with ISO/ICE 13818-1/2 standard
- **SVCD**: Corresponds with MPEG-2 Super VideoCD
- **D1**: Corresponds with MPEG-2 DVD
- **High**: HIGH profile 1920x1080i
- **DVD**: DVD video
- **HD DVD**: HD DVD video
- **Blu-ray**: Blu-ray Disc
- **Blu-ray HD**: Blu-ray Disc in high definition
- **Sony PSP**: Sony PSP-compatible format
- **HD 1280 x 720p**: High profile with a resolution 1280x720p (progressive)
- **HD 1440 x 1080i**: High profile with a resolution of 1440 x 1080i (interlaced)
- **Apple iPod**: Apple iPod-compatible stream.

**Video format**
Specifies where the video to be exported should be. The encoder optimizes video material for the selected mode of playback.

- **Auto**: The format from the MAGIX PhotoStory on CD & DVD 10 project.
- **PAL**: Phase Alternating Line, or PAL, is a process for color transmission for analog TV that is primarily used in Europe, but also in Australia, South America, and many African and Asian countries.

  - The image repetition rate for PAL is 25 Hz.

- **NTSC**: NTSC stands for "National Television Systems Committee". This is a US institution that defined the first color carrier system for TV which is now used in most of America and some East Asian countries.

  - The image repetition rate for NTSC is 29.97 Hz.

- **SECAM**: SECAM is a TV norm in France and eastern Europe for transferring analog color video signal.

- **MAC**: The MAC process (Multiplexed Analogue Components) involves TV norms developed for satellite TV. They have also been developed for an HDTV standard (HD-MAC).

- **Unspecified**: This setting does not make any special optimization.

**Tip**: The best results are achieved with the setting "Auto", since this automatically uses the project settings as a basis by MAGIX PhotoStory on CD & DVD 10.
Profiles
Defines which profile is applied in the AVC/H.264 stream.

- **Baseline profile**: The basis of applications with limited computing performance, especially for video conferences or videos on mobile telephones.
- **Main profile**: This profile was originally intended for the broadcast industry and for backup purposes. The process has however retreated somewhat from use, since "High Profile" has been developed for these purposes.
- **High profile**: This profile is used for broadcast and backup applications, and it is also used sometimes in the HDTV industry (High Definition Television). For example, this profile for HD-DVD and Blu-ray Discs.

Level
H.264 defines different levels. The higher the level, the larger the video’s bit rate. In this table, you can see the maximum permitted values for the respective level in relation to the selected profile.

<table>
<thead>
<tr>
<th>Level</th>
<th>Max. macro blocks per seconds</th>
<th>Max. image size in macro blocks</th>
<th>Max. video bit rate (VCL) for baseline and main profile</th>
<th>Max. video bit rate (VCL) for high profile</th>
<th>Examples (Resolution / image rate in Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1485</td>
<td>99</td>
<td>64</td>
<td>80</td>
<td>128 x 96/30.9</td>
</tr>
<tr>
<td>1.1</td>
<td>3000</td>
<td>396</td>
<td>192</td>
<td>240</td>
<td>176 x 144/30.3</td>
</tr>
<tr>
<td>1.2</td>
<td>6000</td>
<td>396</td>
<td>384</td>
<td>480</td>
<td>320 x 240/10</td>
</tr>
<tr>
<td>1.3</td>
<td>11880</td>
<td>396</td>
<td>768</td>
<td>960</td>
<td>320 x 240/36</td>
</tr>
<tr>
<td>2</td>
<td>11880</td>
<td>396</td>
<td>2 Mbit/s</td>
<td>2.5 Mbit/s</td>
<td>320 x 240/36</td>
</tr>
<tr>
<td>2.1</td>
<td>19800</td>
<td>792</td>
<td>4 Mbit/s</td>
<td>5 Mbit/s</td>
<td>352 x 480/30</td>
</tr>
<tr>
<td>2.2</td>
<td>20250</td>
<td>1620</td>
<td>4 Mbit/s</td>
<td>5 Mbit/s</td>
<td>352 x 576/25.6</td>
</tr>
<tr>
<td>3</td>
<td>40500</td>
<td>1620</td>
<td>10 Mbit/s</td>
<td>12.5 Mbit/s</td>
<td>720 x 480/30</td>
</tr>
<tr>
<td>3.1</td>
<td>108000</td>
<td>3600</td>
<td>14 Mbit/s</td>
<td>17.5 Mbit/s</td>
<td>1280 x 720/30</td>
</tr>
<tr>
<td>3.2</td>
<td>216000</td>
<td>5120</td>
<td>20 Mbit/s</td>
<td>25 Mbit/s</td>
<td>1280 x 1024/42.2</td>
</tr>
<tr>
<td>4</td>
<td>245760</td>
<td>8192</td>
<td>20 Mbit/s</td>
<td>25 Mbit/s</td>
<td>1920 x 1080/30.1</td>
</tr>
<tr>
<td>4.1</td>
<td>245760</td>
<td>8192</td>
<td>50 Mbit/s</td>
<td>62.5 Mbit/s</td>
<td>1920 x 1080/30.1</td>
</tr>
<tr>
<td>4.2</td>
<td>522240</td>
<td>8704</td>
<td>50 Mbit/s</td>
<td>62.5 Mbit/s</td>
<td>1920 x 1080/64</td>
</tr>
<tr>
<td>5</td>
<td>589824</td>
<td>22080</td>
<td>135 Mbit/s</td>
<td>168.75 Mbit/s</td>
<td>1920*1080/72.3</td>
</tr>
<tr>
<td>5.1</td>
<td>983040</td>
<td>36864</td>
<td>240 Mbit/s</td>
<td>300 Mbit/s</td>
<td>1920 x 1080/120.5</td>
</tr>
</tbody>
</table>
The setting "Level auto" specifies the encoder levels automatically, among other things for the resolution of the video format specified under "AVC preset" and the set profile bit rate. If a level is manually set in this case, then other parameter values may not exceed the permitted maximum values.

**Picture type**
"Picture type" specifies which parts of a frame should be used as the basis for the encoding:

- **Frame**: A frame is a single image from a video sequence, also called a full image.
- **Field**: A half-image, two of which combine to produce a frame. Read more about this explanation regarding "Interlace (view page 203)".
- **MBAFF (macro block adaptive frame field)**: A macro block consists of 16 x 16 pixels. The encoder creates a "frame field" on this basis for encoding.

**Field order**

**Note**: This parameter is only available if the setting "Field" is selected for "Picture type".

In case of interlaced streams, the half-image sequence is set. Read more about this explanation regarding "Interlace (view page 203)".

**Pulldown**

**Note**: This parameter is only available if the setting "Frame" or "MBAFF" (only for AVC/H.264)" is selected for "Picture type".

In normal cases, an image playback rate of 24 (or 23.976) frames per second is use; the NTSC system however requires 30 (or 29.97) frames/s, and there is a special algorithm for converting the video's frame rate. For compilations or test purposes, switch this option to "No". In normal cases, the setting can be set to "Auto".

**Slice count**
A frame can be divided into multiple slices for encoding. Specify the maximum number of slices are permitted. If set to "0", then the number will be determined automatically.
Bit rate control
The bit rate indicates how much data per second is saved in the video (playback speed). This makes the bit rate the deciding parameter for the video to be encoded.

Mode
- **Constant bit rate**: The constant bit rate should only be used if the device used to play the video supports constant bit rates.
- **Constant quantizer**:
- **Variable bit rate**: The bit rate varies. For faster movements in the video, the bit rate increases, and for still images or slow pans, a lower bit rate is sufficient for creating the video in constant quality.

Pass
- **Single pass**: The encoder process takes place without prior analysis. This requires the least amount of time, however quality suffers.
- **Multi-pass analysis**: The first encoding is carried out at the same time as the analysis for the second encoding is calculated.
- **Multi-pass encode**: The first encoding is carried out at the same time as the analysis for the second encoding is calculated and updated. This produces the best results, but the process requires the most time.

Bit rate (Bits/s)
- In "**Constant bit rate**" mode: Exactly those values entered are applied to be able to calculate the size of the video precisely.
- In "**Variable bit rate**" mode: The values entered here are applied to the video as an average as a guideline. The size of the video to be exported can only be approximated.

HSS rate
This is the maximum bit rate that should be present in the video stream, i.e. maximum number of bits that may be transferred to the decoder.

**Note**: This option is only available in "Variable bit rate" mode.

CPB size
This sets the size of the "coded picture buffer" in bits. This is the buffer where the encoding is carried out. The larger the buffer is, the better the results will be, but the processing will also take much longer.
Aspect ratio
In the film industry, this is an indication of the ratio between width and height of a rectangle, monitor, or screen.

There are 3 different sizes available:

- **Picture Aspect Ratio** (also Display Aspect Ratio, DAR): This indicates the desired aspect ratio of the video to be exported. Here are some examples of typical aspect ratios: at home 4:3, 16:9 (typical for TV sets) or 16:10 (widescreen-flatscreens, widescreen notebooks), 3:2 for 35mm films and photos. In cinemas you mostly find 1.85:1.
- **Pixel Aspect Ratio (PAR, pixel aspect ratio):** Indicates the aspect ratio of individual pixels. The majority of computer monitors have quadratic pixels (PAR=1:1), for analog television monitors (PAL at 4:3) 128:117.
- **Sample Aspect Ratio (SAR, also Storage Aspect Ratio):** Aspect ratio of the saved resolution (number of pixels), e.g. 720:576 at PAL. It also calculates picture aspect ratio and pixel aspect ratio: \( \text{SAR} = \frac{\text{DAR}}{\text{PAR}} \).

**Note:** In the standard case, the "Aspect ratio" remains set the way it is. You should only change the settings if the resulting video is exported distorted or stretched or if you need to correct the video because it is in the wrong aspect ratio.

GOP structure
Max GOP length
Determines the maximum GOP (view page 203) length. High values mean improved compression. Lower values create stronger security protection and enable improved access to individual frames for processing the video.

Max b-frames count
The maximum number of b-frames (view page 205). Several cases of application, e.g. video conferences require "no b-frames" in order to achieve the shortest possible reaction times during transfer.

Scene change detection
If this option is activated the scenes will be detected during encoding, thus allowing you to insert an I frame (view page 203) after a scene change.

Input info
Information about the incoming video stream is displayed here during live recordings.
Statistics
Information about the encoder activity is displayed here during live recordings.

AMR
AMR involves a parametric codec with different data rates between 4.75 and 12.2 kbit/s. The 12.2-kbit/s setting roughly corresponds with the GSM-EFR codec in terms of algorithm and audio quality.

This audio format is used by mobile telephones for transferring the conversation and is optimized for encoding conversation (voices). Low bit rates provide compensation for mobile phones in case of transfer errors, i.e. bad reception. Depending on the signal strength, the compression increases or decreases to enable the best possible quality for a conversation. The AMR sound, on the other hand, encodes a fixed sample rate of 8,000 Hz compared to AAC sound.

The advanced AMR audio menu includes the following settings options:

The bit rate can be set between 4.75 and 12.2 kbit/s. The higher the bit rate, the greater the file size and the higher level of audio quality. The standard settings provide a bit rate of 7.4 kbit/s. The highest bit rate for this format is more suited for transferring conversations.

AAC
The AAC audio was developed by MPEG, the Moving Picture Experts Group (Dolby, Fraunhofer Institut für Integrierte Schaltungen in Erlangen, AT&T, Nokia, Sony) as an audio data compression process, that was specified as a further development of MPEG-2 Multichannel in the MPEG-2 standard.

It's also a further development of MPEG-2 audio. This format is equally suitable for encoding general audio information and not especially optimized for certain types of audio material. As with video material, the audio format should be considered for playback later.

AAC audio can be encoded with a sample rate of 8,000, 16,000, 24,000, 32,000 or 48,000 Hz and in mono and stereo sound, respectively. By default, the sound is set to 48,000 Hz stereo. The higher the sample rate is, the larger the resulting file and higher the audio quality.

The advanced AAC audio menu includes the following settings options:

- The **bit rate** can be set between 6 and 512 kbit/s. 160 kbits/s is active by default. The higher the value is, the larger the resulting file and higher the audio
quality. After a certain limit, additional improvements to audio quality will not be perceived. Bit rates under 64 kb/s are not recommended.

- As an **MPEG version**, set MPEG-4 or the older, proven MPEG-2 format.
- For the **File Header Type**, choose either RAW or ADTS. The "Header" indicates an explanatory head for the beginning of the file segment, which in fact takes up extra space, but is required for decoding under circumstances.
  - **RAW** indicates material which does not include a file header in audio format. The audio material is therefore transferred directly without any special additional information (raw).
    This requires that decoding routines are able to process the material without the explanatory file header. Especially in case "exotic" sample rates are set, this can lead to problems during RAW encoding.
  - **ADTS** indicates a file header type which contains information for encoded audio material. In case of doubt, select this file header type, since fewer problems can be expected in this case.

**Object type:** This provides selection between "Main" and "Low complexity".

- **Low complexity:** Data is present in a form that hinders different decoding algorithms (noise replacement), but enables others (temporal adjustment noise formation).
- **Main:** This sets other focuses in the encoding, and other decoder algorithms can be used.

**Note:** For example, Apple iPod requires "low complexity encoding". However, you don’t need to worry if you select the right preset for Apple iPod in the export dialog.

**Multiplexer**

The multiplexer is a component of the encoder which combines audio and video streams.

**Output format**

**MPEG-4 file:** This is an MPEG standard (ISO/IEC-14496) with the original goal of supporting devices with less computing performance. Currently, MPEG-4 has reached a wide bandwidth of application, from HD video to support for mobile telephones.

**JPEG2000 file:** DCI (Digital Cinema Initiative) has been replaced by the JPEG2000 format for encoding movies. The current distribution and presentation of films has been taken over by digital projectors that play back **high-resolution Mj2 streams** in outstanding image and sound quality.
3GPP file: A standard supported by plenty GSM and UMTS mobile telephones. 3GPP is very similar to the MPEG-4 standard, but also supports formats that are not permitted by MPEG-4.

ISMA compatible
The "Internet Streaming Media Alliance" combines video codec standards (e.g. MPEG) and continuous transfer within computer networks (e.g. RTP Real-time Transport Protocol) to ensure that videos available online can be correctly transferred and played back.

**Note:** This option can only be activated, if under "Format“ the entry "MPEG-4 file" has been selected.

For Sony PSP
Switch on this option if the video should be played back with the Sony PSP.

**Note:** This option can only be activated, if under "Format“ the entry "MPEG-4 file" has been selected.

For iPod
Switch on this option, if the video should be played back with the Apple iPod.

**Note:** This option can only be activated, if under "Format“ the entry "MPEG-4 file" has been selected.

Live mode (get times from samples)
This option is only important for live transfers and is therefore not required in MAGIX PhotoStory on CD & DVD 10.
MPEG glossary

Motion estimation

Motion estimation is a further element for reducing data used in MPEG encoding.

Motion estimation also occurs in the B and P frames. The image difference that still exist after prediction (view page 205) are examined. Complex algorithms are used to search for an original occurrence of the macro block in the reference frame of each macro block of the P or B frame (these are units of 2x2 blocks specially combined for this purpose), which have been moved either by movement or by camera pan. They can then be left out in the P and B frame. Only the information by how far and to where the macro block has been moved is saved instead. This vector is called the motion detector.

In the General encoder settings (view page 183), you can specify the quality of the final MPEG video. This factor also influences the time required for encoding. The longer it takes, the better the quality.

Bit rate

MPEG is a format used for storage and transferring. With older formats (e.g. AVI) you could predict that 20 seconds of movie would result in 20 MB of data. The file size is this a direct measurement of quality.

This is different for MPEG: The amount of data available can be used differently for different display modes. 20 MB can be 4 seconds of DVD Video or 5 minutes Internet streaming in thumbnail format. The quality of an MPEG video is measured by the width of the created data stream, the bit rate. This is the amount of the transmitted data per time unit; it is stated in kBit/s or bit per second.

Bits, not bytes are used, since the data word width has to address the transmission restrictions.

The file size can be calculated from the average bit rate, if its length is known:

\[ F = (BRV + BRA) \times t \]

F=File size \hspace{1cm} BRV= \hspace{1cm} BRA= \hspace{1cm} t=Length in s

Video bit rate \hspace{1cm} Audio bit rate

www.magix.com
Block
For almost all image file editing techniques the image is subdivided into 8 x 8 pixel blocks (image points). This should be noted if you would like to use user-defined image resolutions (width/height), and they should always be a multiple of 8.

Chroma format
The color value of each image point consists of the color values for the primary colors red, green, and blue (RGB), and for traditional and technical reasons it is transformed into one brightness value \( Y = 0.299R + 0.587G + 0.114B \) and two color difference values \( U = R - Y \) and \( V = G - Y \).

The Y value alone produces the black and white picture. These signal components allow brightness and color information to be handled separately. The first data reduction occurs when single rows comprising a picture are read. Because the human eye has a lower color resolution than a brightness resolution, the color components are recorded only for every other point of a row (4:2:2) for each four pixels grouped (4:1:0), i.e. color signal under-reading.

4:2:2 This corresponds to the established TV standard. One piece of color information is transmitted per row for two pixels which corresponds to a 2/3 compression of the output data.

4:1:0 This is the color coding used for DVDs and most other consumer video applications. For each 4 pixels grouped together on two rows, one unit of color information is saved. This corresponds to an output data compression of 1/2.

Field
A half-image, i.e. two halves which combine to produce a frame (see de-interlacing (view page 203)).

Frame
A frame is a single image from a video sequence which also called a full image. PAL video, for example, contains 25 frames per second, NTSC 29.97 frames.

Video recordings, with the exception of computer animations and still frames, don't contain full images. Instead, they have double numbers of half-images (fields) which are transmitted in an interlaced state. However, we still refer to frames, since many predecessors of MPEG compression are based on such frames. Video editing literature usually refers to frames.
GOP

Group of Pictures: The sequence of I frames and the P and B frames that belong to them.

e.g. I B B P B B P B B I ...

(This GOP has a length of 9, with 2 P frames and 2 B frames)

I frames contain the entire image information of a frame, while P and B have part of the information. So-called prediction (view page 205) and movement approximation are methods used for reduction.

The combination P B B is called a subgroup.

I frames must appear in regular intervals in the data stream for image and sound to be synchronized. Between the I frames only a limited count of P and B frames is allowed. This explains a few things: Since P and B frames contain only differential information, these differences will be larger with time, since more and more changes takes place from frame to frame. A large count does not make much sense, since GOP has a maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B frames between P frames is not allowed).

In a closed GOP, B frames of the last subgroup may contain only backward predictions or references to the preceding P frame, but no references to the following I frame, since it belongs to the next GOP.

I frames

Intra-frames: In these pictures, the entire image information of a frame is saved and only information from this frame is used ("intra-frame encoded"). In contrast to the I frame, P and B frames save only the differences between the current frame, and preceding and/or following frame are also found in MPEG video (P frame = "predicted frame", B frame = "bidirectional frame", see Prediction (view page 205)).

Interlace

For historical reasons, pictures in a movie are always recorded and transmitted in the form of two fields; first the lines with even numbers and then those with odd numbers. These fields are alternatively displayed with double the frame rate. The (lazy) eye of the viewer or the processing of the TV tube puts the two frames together to form one.
The output image  First field  Second field

You normally don’t have to worry about field processing. The video material goes through the entire processing chain as fields and is exported again as fields or burned onto DVD or shown on TV when played back on a DVD as a full picture. Only in certain rare conditions is it necessary to go deeper into this process. Two problems can occur:

1. **Interlace artifacts**

To be displayed on a computer monitor (during recording, in your TV/VCR, and in the arranger during editing), the two fields must be combined to form a full screen.

These two fields are not the same, since two fields are created during the recording between which a 1/50 of a second gap is evident. Moving objects can therefore produce artifacts on vertical edges.

Typical interlacing errors

You can use so-called de-interlacing to avoid this type of artifact. De-interlacing places a picture in between the two fields (interpolated). If you want to create stationary pictures from movies, then you should definitely use a de-interlace filter.

In the system settings ("File" menu -> Program settings) you can set the preview monitor display to use hardware de-interlacing during video recordings for the video recorder and for display in the arranger.
2. Incorrect field rate

If you move around the series of fields in a movie data stream, then you will see strong jitter and flicker effects. Picture objects move in a backward movement – two steps forwards, one back – since a delayed field is shown before the previous one. This can happen in the processing chain if you export video material improperly with the wrong field order and then import it into different material. We use MXV or MPEG "Top field first" format for all analog recordings ("odd" in other programs).

DV-AVI on the other hand is saved with “Bottom Field First”.

You can correct the field series for each video object in its object settings. See: "Menu -> Effects -> Object properties"

P frames and B frames

P frames save only the difference between the current picture and the preceding I frame. The "P" comes from the term "prediction" which describes this process.

B frames save the differences between the current picture and the I or P frame preceding and following. This includes the information that was the same before and remained the same after the current frame. Both directions are analyzed (indicates the "B" in the name, i.e. "bidirectional-predicted"). You can read more under prediction (view page 205).

Prediction

Prediction is a method of data reduction used by the MPEG format. The image elements already known from the previous or following frames are removed from the data stream.

How does it work?

The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is transmitted together with the encoder, which always knows exactly which kind of frame comes next. I, P, and B frames are differentiated.

Hint: When we talk about pictures, we mean frames of the video output, and I, P an dB frames are the frames of the encoded video. Just as in movement approximation, blocks (8x8 pixels) are united into macroblocks (16x16 pixels) during prediction.
The first frame is always the I frame. It is completely encoded from the first picture. Afterwards, the 4th picture is analyzed for the creation of the first P frame. (As already said, the encoder, and later the decoder, will know that two B frames belong between them.) This image will also be completely encoded, and afterwards all macroblocks that haven’t changed in comparison to the I frame will be deleted. They will be replaced by corresponding references for the decoder that tell it "you already know what should be shown here, and you can get it from the last I frame".

Now, the 2nd will be completely encoded, and all macroblocks identical to the first I frame and the following P frame will be removed. References to previous frames are called **backward predictions**, and references to following frames are called **forward predictions**. The third picture will be edited in exactly the same fashion.

The fourth picture we have already explained, and now we need the next P frame, or picture number 7. Pictures 5 and 6 are B frames again, which are compared to P frames to both sides of them (picture 4 and 7); these are followed by the last two B frames. These have a special place, since in closed GOPs, they may contain only backward predictions, and no references to the next I frame, because it belongs to the next GOP.

Something else: Since the decoder is no prophet, the P frames are always transmitted before the B frames! The GOP explained above will be encoded and transmitted in the order it is written.

Original GOP

I₁ B₀₁ B₀₂ P₀₁ B₁₁ B₁₂ P₀₂ B₂₁ B₂₂

Data stream

I₀ P₀₁ B₀₁ B₀₂ P₀₂ B₁₁ B₁₂ B₂₁ B₂₂ ... for closed GOPs

I₀ P₀₁ B₀₁ B₀₂ P₀₂ B₁₁ B₁₂ I₁ B₂₁ B₂₂ P₁₁ ... For open GOPs

Due to this nested structure, it is easy to see that during direct editing of MPEG material, complicated computations have to take place! These are made easier using a **frame table**. A frame table contains a list, where the information of every frame in the data stream is found, identifying the type of frame it is.

Using Movement prediction (view page 201) P and B frames are likewise reduced.
Quantization scaling

The single pictures in MPEG are saved using a compression method comparable to JPEG with bitmaps and associated with quality loss. For this single images are divided into 8 x 8 blocks (view page 202).

Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows and columns) using a DCT (discreet cosinus transformation) mathematical method. Each of these values is produced using all 64 individual pixels of the block, but the values in the matrix are ordered in such a way that the image information is ordered according to its importance.

This matrix will then be multiplied by another matrix, i.e. the quantization matrix. Exactly how and why this matrix must be created is the biggest secret of encoder programmers, since this determines the quality of the whole encoding process. What is known is that the result should contain as many zeros as possible! These zeros correspond to the "unimportant" image elements mentioned and will not be transmitted in the data stream.

Depending on the encoder parameters regarding the target bit rate, fewer or more values of the matrix will be declared unimportant by dividing the quantization matrix by the quantization scaling factor. Since only whole numbers are used, a division can produce a zero is the remainder is discarded.

This factor is also a direct measure of the sought image quality of the MPEG data stream, since the "Q" in "Q" factor stands for quantization and quality.
Annex: Digital Video and Data Storage

Video Editing on the PC

Digital video processing with the PC is comparable to audio processing. The analog medium that is video must first be digitized before it can be processed by the computer.

Digital video processing functions quite similar to recording via a sound card. The signal flow is measured in very short, regular intervals, and the values resulting from it can then be processed by the computer. The accuracy of each individual measurement results in the resolution, and the frequency of the measurements results in the frame rate. The more precise and frequent the signal is measured, the higher the quality of the digitized video, but also the higher demands on the capture performance and the required storage space. The Windows standard format for video files is AVI (audio and video Interleaved).

Digitizing video adopts either the camera or the graphics card, a TV card (e.g. Miro PCTV), or a video card (e.g. Fast AV Master). However, video handling makes much higher demands upon the hardware if good image quality is required. In order to be able to reasonably process video files on today’s PCs, they must be compressed. Digital audio, on the other hand only uses compression for saving storage space.

HDTV

This acronym stands for "High Definition Television.

High definition television is a general term applied to a series of television norms that differentiate themselves from normal television by increased resolution and an altered aspect ratio (16:9). This type of digital television offers cinema-like image quality and impressive sound quality. With doubled horizontal and vertical resolution the image quality of HDTV is approximately four times as sharp as previous standards (PAL, NTSC, SESAM).

At this time MAGIX PhotoStory on CD & DVD 10 supports two resolution standards:

- 720p (1280x720 pixel)
- 1080i (1920x1080 pixel)
MPEG Compression

MPEG means "Moving Picture Experts Group" and defines a workgroup which cooperates with the International Standards Organization (ISO) as well as the international Electro Technical Commission (ETC) to develop standards for video and audio coding.

Generally, the graphic data rate of the digital video standard is 167 megabits per second, which, when not compressed, requires a far higher storage capacity than a DVD can offer. A one-sided DVD with 4.7 GB storage capacity is enough for 4 Minutes. For this reason, the available pictorial material must be effectively compressed – a function which is achieved with the MPEG procedure.

This procedure is based on the simple fact that up to 96% of digital video data consists of repetition and can be compressed without visible degradation of the pictorial quality.

Each MPEG compression is, however, a data reduction and as such connected with information loss. If the video consists of very extensive details, or if the content changes very fast, then the picture may blur (dependent on the strength of the compression and the quality of the encoder).

Errors can also result from so-called compression artifacts such as small color defects or images that are too dark.

At average compression rates under 3 megabits per second it is probable that you will notice reduced quality. At rates around 6 megabit per second the degradation in quality becomes almost invisible.

General notes on AVI videos

The AVI format (Audio Video Interleaved) isn't actually a proper video format! Rather, it is a so-called "container", where the conventions for transferring audio and video files to the program are only loosely defined. The codec (coder/decoder) actually defines what storage format is used. A codec compresses audio/video data into its own unique format which can only be read by the codec itself and is decoded when the film is played.

In concrete terms, a computer-generated AVI file can only be loaded by and played on a different computer if the same codec is installed on it.
Many codecs (e.g. Intel Indeo® video) have now become standard components of the Windows™ installation. Others like the popular DivX codec are not standard. If you are generating an AVI file for future play on another computer using one of these codecs, you should first install this codec on the other PC. The best method available is to copy the codec installer to your export directory and burn it every time you create a video disc (slideshow disc) for play on computers.

You may encounter some problems when using older video editing cards with codecs which only function with the card’s hardware. Such AVIs can only be used on the computer which was used to create them. Try to avoid using this kind of codec.

**Capacity and quality of different disc formats**

In MAGIX PhotoStory on CD & DVD 10, a number of different disc formats are available.

This chapter will explain which formats can be best employed in different cases, the differences in quality, and how much space each format requires.

The following table summarizes the relationship between space requirements and quality. For further information please read the chapters on the individual disc formats.

<table>
<thead>
<tr>
<th>Disc format</th>
<th>Quality</th>
<th>Approx. length</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>VCD</td>
<td>*</td>
<td>Approx. 70 minutes/CD</td>
<td>Slideshow for TVy</td>
</tr>
<tr>
<td>SVCD</td>
<td>**</td>
<td>approx. 30-40 minutes/CD</td>
<td>Slideshow for TV</td>
</tr>
<tr>
<td>DVD</td>
<td>***</td>
<td>approx. 2 hours/DVD</td>
<td>Slideshow for TV</td>
</tr>
<tr>
<td>miniDVD (view page 216)</td>
<td>***</td>
<td>approx. 20 minutes/CD</td>
<td>Slideshow for TV</td>
</tr>
<tr>
<td>JPEG DISC (view page 215)</td>
<td>****</td>
<td>Depends on original images and DVD player*</td>
<td>Slideshow on TV without sound, effects, or transitions</td>
</tr>
<tr>
<td>Slideshow Disc</td>
<td>****</td>
<td>Dependent on the original pictures and music length</td>
<td>Slideshow on PC with some effects, or as a backup</td>
</tr>
</tbody>
</table>
WMV HD **** Depends from resulting material, prediction is difficult, approx. 3 hours/ DVD, approx. 30 min./ CD Slideshow on PC/TV with specialized players that support Windows Media 9 format

MultiDisc ***/*** approx. 1 hour/ DVD Slideshow on TV and PC, highest quality on PC

* The display duration for some DVD players may be set in this menu. The number of photos that can be burned onto a CD or DVD depends on the sizes of the picture files.

**Note:** For all disc types with menus, you can use the menu templates from the "TV ShowTime DVD" section. Each picture of a slideshow is then displayed in full screen on its own menu page without having to play the slideshow.

**Digital Versatile Disc (DVD)**

**Quality**

Featuring a resolution of 720 x 576 (PAL) and encoded with MPEG-2, 25 frames per second provides very good results.

**Writable data storage formats**

The recordable DVD market is currently split into three types: "DVD-RAM", "DVD+RW", and "DVD-RW".

**DVD-R/+R:** This medium may only be written to once. The DVD-R may be specified with file structures for DVD video, DVD audio, or DVD-ROM.

**DVD +RW:** +RW drives allow re-writable DVDs to be created which may be read by almost any commercial DVD-ROM or DVD player. The companies involved are mainly Philips, Sony, HEWLETT PACKARD (as well as Ricoh, Yamaha and Mitsubishi).

**DVD-RW:** This is a write/erase DVD technology promoted by Pioneer and Sharp. This format was developed by the Pioneer company and should be compatible with existing DVD players.

www.magix.com
**DVD-RAM:** DVD-RAM technology is based on either Phase Change, MOs, or hard disks, etc. and is now almost 100% incompatible with all available players.

Due to the small storage capacity and incompatibility with DVD players, setting on this standard is not recommended.

**Note:** MAGIX PhotoStory on CD & DVD 10 supports DVD±R and DVD±RW, but not DVD-RAM.

**Blank discs:** Single-sided recordable blank discs featuring a capacity of 4.7 GB and a duration of approx. 2 hours.

**Copy Protection**

**Macrovision (APS):** The movie industry claims that even DVD-ROM drives and decoders or diagram cards with composite outputs or s-video outputs must support the Macrovision analog copy protection (APS). Only some older DVD players do not possess APS.

APS adds additional signals to a DVD’s stored graphical data. The data is almost unchanged. These supplementary signals disturb the synchronization and the automatic recording regulation of most video recorders to prevent recording of the video. They are not noticeable on the television or the monitor, however.

**Content Scrambling System (CSS):** CSS prevents saving and duplication of DVD video tracks to hard disk. The VOB streams of DVDs without CSS can otherwise (like other video files) be loaded via the Import Video button.

There are further types of copy protection besides APS and CSS which ensure that retail DVDs cannot be copied without distortion.

**WMV HD**

WMVHD (Windows Media High Definition Disc) is a disc type for optimum slideshow playback on your PC. The slideshow(s) are converted in a high-resolution format into the Windows Media 9 format and a menu is added, like with DVDs. The minimum requirement for playback is Windows Media Player 9 (or higher). The slideshows are encoded, by default, in HDTV resolution (1280 x 720, also known as "720p").

However, a powerful PC with Windows Media Player 9 installed is required for playback.
The values "720p" or "1080i" describe the vertical resolution in pixels. The total resolution of the "PC slideshow 720p" is 1280 x 720 pixels, the "PC slideshow 1080i" has 1920 x 1080 pixels.

Unfortunately, there are currently now DVD players for sale that can handle this format as the jump in quality from DVD to WMV HD is greater than from VHS cassettes to DVD.

However, players that support this format may be available in the near future, although we cannot guarantee that discs created with MAGIX PhotoStory on CD & DVD 10 can be played in these players. TV sets that can handle such high resolutions are already available from retailers.

**Blu-ray Disc™**

Since early 2008, Blu-ray Discs are viewed as successors to DVDs and offer especially high storage capacity of up to 27 GB in a single layer (double-layer up to 54 GB) with very few write errors.

The term Blu-ray Disc comes from the blue color of the laser. Because a color cannot be registered as a trademark, the letter "e" was removed from the word "blue".

The high storage capacity of the Blu-ray Disc suits high definition videos and slideshows in high quality perfectly, since these are characterized by large file sizes (depending on material approximately 40 MB/sec) and very high memory use. The MPEG-2 codec is used to create video.

Companies that were involved in developing Blu-ray technology have united themselves into the Blu-ray Disc Association (BDA).

**Blu-ray Discs come in three varieties:**

- Only readable **BD ROM** (comparable to DVD video),
- rewritable **BD-RE** (comparable to DVD±RW or DVD-RAM),
- and as a disc that can be written to only once **BD-R** (comparable to DVD±R).

**AVCHD disc**

Use this format to create a high-resolution video. You can burn Blu-ray (BD-R/RE) blanks as well as conventional DVD±R/RWs. In contrast to Blu-ray Discs (view page 213), MPEG-4/AVC codec (view page 187) is applied as the video format, which requires less memory at a comparable image quality.
Compatibility

**AVCHD disc on Blu-ray blank:** Since this is a BD-conformant format, the disc created can be played back in any conventional Blu-ray player. Playback problems can almost always be traced to incompatibilities between Blu-ray blanks and Blu-ray players. In this case, consult the instructions for your Blu-ray player or ask the manufacturer which blanks are compatible with the device.

**AVCHD disc on DVD blank:** The DVDs created with AVCHD video are not supported by all Blu-ray players. The behavior of the devices is quite different. Normal DVD players cannot replay AVCHD discs, since the AVC format is not supported.

**Super Video CD (SVCD)**

The Super Video CD (SVCD) is a technological advancement of the video CD. SVCDs are also like VCD-specified CD-ROMs which can be played using either a Super Video CD player (connected to the television), or directly with the CD-ROM drive of a computer. Many DVD players can also play SVCDs. MPEG-2 and the increase of the data transfer rate makes it hard to tell videos from videos in DVD quality apart.

**Resolution:** SVCDs use the better MPEG-2 encoder in a standardized resolution of 480 x 576 (PAL). The MPEG-2 format offers a maximum resolution of up to 720 x 576 points and improved compression methods characterized by excellent image definition and homogeneity.

**Hard disk capacity:** An average 90-minute movie must be spread across 3 CDs. On one SVCD you can get about 30 minutes of good-quality movie.

**Encoder setting:** Compared to the VCD with 1.3, the data transfer rate is doubled to 2.6 Mbit/s.

MPEG-2 format introduces the so-called variable bit rate (VBR). In contrast to the constant bit rate (CBR) of the MPEG-1 encoders, this encoder has the option of using more bits for movement-intensive sections, as well as saving bits if picture content remains the same.

**Video CD (VCD)**

Video CDs are specific CD-ROMs for storing videos in certain forms. Compression takes place using the MPEG-1 codec. VCDs can be played on either a video CD player attached to a television or directly via the computer’s CD-ROM drive. Most DVD players can play VCDs.
Resolution: VCDs can play movies with a maximum resolution of 352 x 288 pixels (PAL) or 352 x 240 (NTSC) at 25 pictures per second. The resolution of a VHS cassette offers for instance 300 x 360 pixels. More important than the resolution is the use of a good MPEG-1 encoder. Since video images constantly change, errors cannot always be perceived by the viewer.

Hard disk capacity: A VCD can store about 70 minutes of video. A typical motion picture must therefore be stored on two VCDs. In order to get as much video data on a normal CD as possible, one must forego correction information on VCD/SVCD formats within the individual sectors (sub-ranges) of a CD. You can therefore fit 720 MB of video data on a 650 MB blank CD. Due to improved burning and scanning technology it is now possible to burn up to 985 MB video data on a 99min blank CD.

Encoder settings: Normally the video CD data is played at a data rate of 1150 kBits video and 224 kBits audio. By increasing the video bit rate to 3000kBits you can get the same resolution and an better-quality audio bit rate. Movement artifacts disappear almost completely at approx. 2000 kBits with the picture appearing a little less sharp. This pre-supposes, however, that the player can also play back such a bit rate. The fact that many DVD players can handle an increased data rate is due to well written player software.

Experiment with higher data rates: If you do not need the full running time of the VCD, then you can experiment with space to improve the quality of the video!

JPEG disc

This type of disc is intended for use in case your photos have been optimized and you want to display them on a DVD player at the highest quality.

Each picture will be exported individually with the corresponding photo cleaning effects and burned onto a CD or DVD in a format which is recognized and played by most DVD players.

This format does not support menus, dynamic effects, transitions, or sound. The display length of each picture is not burned onto the disc either and will be determined by the DVD player. There are DVD players which allow the display duration for each picture to be set. Please refer to the manufacturer’s instructions for your DVD player.

This format is usually known as "Photo CD" or "JPEG CD".
**miniDVD**

The miniDVD is nothing more than the DVD data format burned onto a CD-ROM. Thus the MPEG-2 encoder and all other specifications of the DVD data format are used, and only the data carriers are different. Because the CD-ROM can only save about a sixth of the quantity of data a DVD can hold, the capacity of a miniDVD is accordingly limited to approx. 20 minutes of movie.

MiniDVDs are particularly suitable for playing on the computer. For stand-alone devices they must be tested on an individual basis as to whether the device can handle the DVD format on a CD-ROM.

**Multi disc**

A multidisc is a combination of different disc formats on one DVD. It consists of 3 parts and offers the following advantages:

- Maximum quality when played on a PC with WMV HD (Windows Media High Definition Disc) (view page 149)
- Fully compatible with DVD players due to a DVD part (Digital Versatile Disc) (view page 211)
- Greatest possible safety as a data backup of the project is added (burn option (view page 147)).

**Backup disc**

Use this option to compile all movies in the current disc project, including all connected media and burn them to disc.

Even larger projects can be burned straight to disc. The project, if necessary, will be split up and burned automatically to multiple discs. A restore program which is burned to the first disc of such a backup, guarantees easy re-recording of the backup.
MAGIX services in detail

MAGIX Online Album

Impress your friends and family in minutes with your own photos and videos as your own personal photo & video website: http://first_name.last_name.magix.net.

MAGIX Online Album lets you put your favorite photos online directly from within MAGIX products like MAGIX PhotoStory on CD & DVD 10, or mobile phones with built-in cameras, and then send a link to them to your friends via email. All photos are immediately available from anywhere in the world on a professionally-designed photo website, in well-organized photo galleries, as full-screen slideshows, or in the form of a personal photo e-card.

- Personalized album website in many designs,
- unique Internet address (URL),
- upload your pictures directly from a camera phone, send the link, and share the picture with other camera phone users,
- full-screen online slideshows with fade effects and music,
- send individual designer e-cards with your own photos,
- Share your photos with friends, including address management and password protection for private albums.

MAGIX Online Album is available in three versions, of which the smallest (the FREE album with 500 MB webspace for your photos) is entirely free.

The larger versions (CLASSIC or PREMIUM) are available for a monthly charge, but also come with many handy features, such as a faster website, 2 GB or 5 GB storage space, more website designs or access by mobile phone/PDA. More information about prices and features is available at http://www.magix-photos.com.

Upload images from slideshow

1. Select still image and place the start marker at the position of the image which you want to upload from your slideshow.
2. Then, select "Online -> MAGIX Online Album -> Load image from slideshows" in the menu.

In order to upload photos to your MAGIX Online Album, simply log in using your email address. Naturally, access is protected via your personal password. If you still don't have a password, click on "Register now".

www.magix.com
Using your MAGIX Online Media Manager, you can quickly manage your photo website, upload photos and music, create new albums, add designs and text, and much more.

Using "Upload movie as video" you can present your slideshow with fades, music, and all other effects as a playable video in the Internet.

1. Design your slideshow.
2. Save your movies, and then under "MAGIX Online Album" select "Online -> Upload slideshow as video".

Now you just have to follow the instructions on the screen to finish the upload process.

Upload slideshow as audio: With this option, you can present only the audio of your slideshow in your online album.

1. Design your slideshow.
2. Save your movies, and then under "MAGIX Online Album" select "Online -> Upload audio from slideshow".

Now you just have to follow the instructions on the screen to finish the upload process.

The following options are also available:

Send e-cards and photo emails

Send your photos as unique ecards with great designs or as a photo email to your friends and family.

Order photo prints and gifts

Order paper prints or great photo gifts from MAGIX Online Album and have them delivered directly to your home, or pick them up from a photo lab in your area. Delivery time is usually just 2 - 3 days. More about MAGIX Online Print Service

MAGIX Community

MAGIX Community is the place to exchange photos, videos, and music with friends and the world. As soon as you have registered for free, you can use all of its great features.
MAGIX Blog Service

With MAGIX Blog Service, YOU make the news! Share your thoughts, experiences, and news with a worldwide audience in no time using your own interactive online multimedia journal. Invite family, friends, and acquaintances to join in and enter their comments! A free MAGIX Online Album belongs to the MAGIX Blog Service so that you always have full control over your contributions.

Catooh – the Online Content Library

Catooh provides you with high-quality photos, videos, and music for every theme, expanded by intelligent iContent with professional Soundpools, DVD menu templates, and brilliant MAGIX ShowMaker styles to help you make your photo, video, and music projects reality. All of this is available directly from your MAGIX software.

Just choose "Online" from the menu "Catooh" to set up an Internet connection.

Browse through the thematically sorted categories or view the results directly by entering a keyword. After downloading, you can drag the objects from the Media Pool directly into your arrangement.
Youtube / Flickr

This is a direct connection between MAGIX and different communities like YouTube™ or Vimeo™. The Menu entries listed below may be found in the Online menu.

Upload current movie as video

Uploads the current film to the selected portal or to the selected community. Enter the data for video into the fields provided, so that the search function for this portal can also find this video.

MAGIX PhotoStory on CD & DVD 10 partially uses the H.264 format for this, which is a component of the MPEG-4 codec. Since Flash supports this format directly and most communities and portals use the format, the film does not need to be re-rendered on the corresponding server. This avoids loss of quality.

When HD material is uploaded, a resolution of 720p is used for the HD format.

Upload all selected media in Media Pool

Uploads the media selected in the Media Pool to the corresponding portal or the selective community.

Note: To import and export AVC(HD) and MPEG-4 files, the MPEG-4 codec must first be activated. A dialog will open if the codec is required.
If You Still Have Questions

Task assistant

The task assistant is your information center. It helps you complete your tasks and provides support at every step. Not only will you find clear videos with step-by-step instructions, but you’ll also find quick access to a lot of functions.

The task assistant chapters can be found in the "Tasks" menu (view page 175).

Tips for program help

The "Help" file features hints on how to use the program and additional information. Many important terms are indicated in the text in italics and an explanation to them is reached by clicking on them.

**Context help**: Press the "F1" key at any point in the opened program and the help file will open with the matching topic (context help).

**Search function**: Use the search function to find out information about specific words. Enter either the individual word or use logical operators (OR, AND, NEAR) to refine your search if you have several search words.

- "**OR**" (between two words): All topics which contain both words or one of the words will be listed.
- "**AND**" (between two words): Only those topics will be listed which contain both words.
- "**NEAR**" (between two words): Only those topics will be listed which contain both words. A maximum of six other words may be added between the search terms.
- "**NOT**" (before a word): Topics which contain this word will **not** be listed.

**Print**: Use the help program’s print function to make a printout of individual topics or entire sections. The print button is located at the top of the help window in the toolbar.

We hope you have fun using MAGIX PhotoStory on CD & DVD 10 and enjoy hours of entertainment with your slideshows! Your MAGIX Team.

www.magix.com
Glossary

A

AudioID
Audio ID is a process used to determine the title and artist name base on musical properties. An Internet connection is required to access the AudioID database.

AVI
The AVI format (Audio Video Interleaved) isn't actually a proper video format! Rather, it is a so-called "container" for which the conventions for transferring audio and video files to the program are only loosely defined. More in this topic can be found in General notes on AVI videos. (view page 209)

B

Browser
A browser (also known as web browser, or Internet browser) is a computer program that displays websites. The best-known browsers are Internet Explorer, Firefox, Safari, and Opera.

Button
Refers to an element of the graphic user interface of a program. The button initiates an action in the program via left mouse click.

C

Cache
Simply stated, this is a temporary folder where frequently accessed files are saved so that they can be quickly launched while you are working.

CC
CC stands for "Connectivity Co-ordination" and describes how the change of a domain name from one provider to another occurs (domain transfer).
CDA
Short for "audio CD" produced in accordance with the so-called "Red Book" standard. It contains audio files (music) and can be played in CD-ROM drives as well as in regular CD players in stereos.

Clip level
Signifies the volume level at which the recorded signal is overmodulated, or "clipped".

Clipboard
The clipboard is used to temporarily store objects during execution of commands like "copy" and "cut".

Context menu
Context menu can be reached by right clicking on a selected object. It offers functions which are available and can be expected in the given context.

Copyright
Protection of intellectual and creative property against unauthorized copying.

CPU
Central processing unit: The name for the main processor of the computer (CPU). Modern computers have even two or more processors, or one processor with several cores.

Dialog
A dialog opens in a new window and lets the user interact with the program. This means that the dialog can present information to the user and/or expects to receive input from the user.

A dialog can contain various user elements which can be manipulated by a simple mouse click. Keyboard entries are also possible.
Disc project
A project includes everything that you want to put on your CD and DVD. This normally contains one or more slideshows and includes a menu structure/menu design which allows you to choose a slideshow later on the CD or DVD.

Disc types
The disc types determines the format and medium (CD, DVD, Blu-ray disc, etc.) to which the current project will be burned.

DNS
The abbreviation DNS stands for Domain Name Service and refers to a provider of Internet services that registers domain names for customers.

Domain
A domain is the website’s Internet address. It consists of the name of the Internet protocol (usually http://), the computer or network name (such as www), the second-level domain (such as magix), and the top level domain (like .com, .net).

Altogether we have:
protocol://networkname.second-level-domain.top-level-domain (such as "http://www.magix.com").

Domains are allocated by a country’s so-called NIC (Network Information Center). In Germany the DENIC is responsible for the release of domains.

Domain transfer
See CC. If you already have a domain, you can move it from your previous provider to another provider.

Drag & drop
Enables files and objects to be moved freely between various applications (or within an application) by dragging the object and letting it drop using the mouse cursor.

F

Fader
Used for visual input of values. Similar to volume control on a mixing board, you can control various parameters by sliding the fader. A very common example for this is the zoom slider that lets you see a picture in more detail.
Field
A half-image, two of which combine to produce a frame (see interlace).

Flip menu
Drop down menus create menus consisting of lists of selectable choices. They look very similar to text input fields, but have a button with a downward-pointing symbol on the right-hand side.

Frame
A frame is a single image from a video sequence which also called a full image.

A PAL video contains 25 frames per second; NTSC contains 29.97 frames.

H
Handles
Handles are the five little rectangles at the edges of selected objects. All curve points can be moved by holding down the left mouse button.

Length handles: Bottom right and bottom left. You can use them to change the length of an object.

Fade handles: Top right and top left. These can be used to softly fade an object in or out.

Volume/Brightness handle: Above-center. You can use it to adjust the volume or the brightness.

Hard disk
Storage medium with the largest storage capacity where the operating system(s), programs, and files are saved. A hard disk can be built into the computer, but there are also external hard disks which can be used with different computers via a USB connection (portable drives or external hard disk).

Hard disk drive
Storage medium with the largest storage capacity where the operating system(s), programs, and files are saved. A hard disk can be built into the computer, but there are also external hard disks which can be used with different computers via a USB connection (portable drives or external hard disk).
Hardware
The all-encompassing name for all internal components of a computer. For example hard disk, graphics card, mainboard, etc. External peripheral devices are also considered hardware, i.e. printer, scanner, monitor, etc. The synchronization of single hardware components is coordinated by the software.

HDD
Storage medium with the largest storage capacity where the operating system(s), programs, and files are saved. A hard disk can be built into the computer, but there are also external hard disks which can be used with different computers via a USB connection (portable drives or external hard disk).

HDTV
This acronym stands for "High Definition Television.

HTTP
Stands for Hyper Text Transfer Protocol and is used for transferring websites onto the Internet (from web server to the browser). For this reason, the abbreviation http:// always comes before the Internet address. This is automatically inserted and does not have to be entered when entering the Internet address.

Hyperlink
Hyperlinks (or in short "links") are references to other websites/online documents (or other computer networks). They build the base of the World Wide Web (WWW) as it is only via these hyperlinks that networking or interlinking between the billions of website out there is actually possible.

ID3 tags
ID3 tags contain title information that can be added to a music title. This includes the title, artist, album, as well as the genre, year of release, and other criteria that can help searching through a database. The database is created using this information.

Info: Title information will only be saved for MP3s in the so-called ID3 tags (Identify an MP3), but other formats offer similar possibilities, like "Vorbis comment" for the OGG Vorbis format, for example.
Image
An image is a representation of a CD, DVD, hard drive, or another storage medium that is saved as a file.

The difference from a copy or backup is that an image contains information about the structure of the original storage medium, and not just individual files. This enables 1:1 copies of complete storage media to be created.

Caution! Copyright laws forbid copying of commercial CDs/DVDs, and for this reason, this process can be prohibited by copy protection.

IMAP
Stands for Internet Mail Access Protocol and is an advanced procedure used for receiving emails.

Interlace
Describes the creation of a full image from 2 half-images (fields).

In this process, even and odd lines are alternately assigned to one of the two fields.

The human eye perceives both of the projected half-images as a single full image, so that despite the slow image repetition rate (25 Hz for PAL, 29.97 for NTSC) a subjectively fluid image is seen.

Intro
"Intro" means the introduction or opening credits of a movie.

J

jpx
A format developed by MAGIX which is used for photo editing. It enables free experimentation with effects without altering the original file. The effects settings are also displayed when the photos are opened using a different MAGIX program.

M

Menu
Menus contain practically all function of a program. They can be opened using a simple mouse click on the corresponding menu. Keyboard shortcuts, if available, are also found at the end of menu entries.
The graphical surface of a CD/DVD will also be represented as a menu.

Menu bar
Almost every program has a menu bar. It can normally be found underneath the title line of the program. A simple mouse click opens a corresponding menu.

MIDI
MIDI files do not contain the actual sounds like audio files, but only the note control information which can be interpreted during playback by the synthesizer chip on the sound card or an external synthesizer.

Motherboard
This is the centerpiece of hardware components of a computer. All other hardware components like CPU, RAM, hard disk, additional drives, graphics cards, as well as other cards for specialized uses are connected to the motherboard.

MOV
MOV is a video and audio format developed by Apple, which has since become widely used with Windows. QuickTime supports lots of compression technology, which make it possible to optimize audio and video and even graphics for the Internet and multimedia/video applications. Conventional (hardware) DVD players are not able to play this format.

MP3
MP3 (actually MPEG-1 layer 3) is currently the most important standard for compressing audio files.
MPEG
MPEG is short for "Moving Picture Experts Group" and refers to a committee concerned with the standardization of video and audio data compression as well as container formats.

MS audio
A process developed by Microsoft for compressing audio files with properties similar to those of MP3.

MXV
This is the MAGIX video format for quicker processing with MAGIX products. It offers very low loss of quality, but it cannot be played via conventional DVD players.

Noise Sample
Sample of a noise that is to be removed

NTSC (USA, Japan)
NTSC stands for "National Television Systems Committee". This is a US institution that defined the first color carrier system for TV which is now used in most of America and some East Asian countries.

The image repetition rate for NTSC is 29.97 Hz.

Numeric keypad
Also known as the numpad, or the number block.

OGG VORBIS
This is a new, royalty-free format with similar properties to MP3.

PAL (Europe)
Phase Alternating Line, or PAL, is a process for color transmission for analog TV that is primarily used in Europe, but also in Australia, South America, and many African and Asian countries.

The image repetition rate for PAL is 25 Hz.
Play marker
The play marker is a red vertical line which moves from left to right during playback. It indicates the current play position.

Playlist
Arrange your songs in playlists from various sources in different formats and in whatever way you like, sometimes updated daily.

**Important:** Playlists are only links to songs on your hard drive or in your CD drive.

When you add a song to your playlist whose real source is a CD in your computer’s drive, the song will no longer be playable when the CD is removed from the drive.

Similarly, when you move a folder on your hard drive, the playlist will no longer be able to play the song, since the link is no longer valid.

For the latter, however, there is a simple solution: If you know where the song has been saved, then you can redefine the path. A corresponding dialog window is provided for this purpose. You can reset the path by navigating through the Explorer folders. The playlist is now correct once again.

Plug-in
Plug-ins are additional programs that expand the functionality of the main program. They are inserted into the main program.

Podcast
Think of a podcast as something like a radio station on the Internet. Regular Internet radio stations "transmit" in real time, which means that you can simply listen to the program that’s playing and edit it. Podcasting is different. The programs are preproduced and loaded to an Internet server for downloading. As a listener you can subscribe to the podcast and the files will be downloaded at a specified time for you to listen to them whenever you like, for example on the go via your portable player.

Podcasting
Podcast is the name for a relatively new Internet transfer form. It is made up of "pod" from "iPod", the name of a popular portable MP3 player, and the term "casting" for broadcasting content to a wide group of listeners/viewers.
A podcast is therefore something like an online radio station. "Broadcasting" web radio stations means you can only listen to and record the currently broadcast radio station. Podcasting is different. You as the listener can subscribe to the podcast and the files will be downloaded at a specific time and you can listen to them whenever you like, for example, on the move with your portable player. The shows are pre-produced and placed on an Internet server for download.

**POP3**
Stands for Post Office Protocol (version 3) and is used in standard email programs for receiving email (for example, Outlook Express). POP3 enables email to be collected by the provider's email server and loaded into your email program.

**Project**
A project includes everything that you want to put on your CD and DVD. This normally contains one or more slideshows and includes a menu structure/menu design which allows you to choose a slideshow later on the CD or DVD.

**Project**
A "Disc project" includes everything that you want to put on your CD and DVD. This normally contains one or more movies and includes a menu structure/menu design which allows you to choose a movie later on the CD or DVD.

**Provider**
A provider or ISP (Internet Service Provider) offers Internet services like webhosting or domains (DNS). In relation to the MAGiX Website Service, MAGiX is the provider.

**RAM (Random Access Memory)**
This is a hardware component of a computer. RAM is needed to temporarily save files. This type of storage is erased when the computer is shut down or reset. The larger this storage is, the faster you can work with programs to change and save files.
Ratio
The aspect ratio is the ratio between the height and width of a rectangle. In practice these are photos, screens or projection screens. This method can also be used to describe the aspect ratio of pixels.

Here are some examples of typical aspect ratios: at home **4:3**, **16:9** (typical for TV sets), or **16:10** (widescreen flat screens, widescreen notebooks), **3:2** for 35 mm films and photos. In cinemas you mostly find **1.85:1**

Red Book
Specific standards have been established for the different CD types in order to unify their data structure and to make them compatible with the different CD drives. Their names refer to the color of the books where these standards were written.

The term "Red Book" is common language for the Compact Disc Audio Standard. The requirements listed here have to be observed for industrial CP production. Audio CD players only read CDs created according to the Red Book format. It is therefore necessary to first convert PC files into this format before writing them onto an audio disc compatible with any audio CD player.

Restore
Restoration of files originating from a backup will be called "Restoring".

RM
RealMedia includes all of the media formats from software developer RealNetworks. RealMedia especially refers to the "RealVideo" video format and the "RealAudio" sound format. The quality of RealVideo files is comparably good at high compression rates, but does have some loss of quality. These formats cannot be played back by (hardware) DVD players.

Screenshot
A screenshot is an image composed of all visible screen elements (messages, open dialogs, etc.) at a certain time. By pressing the "Print screen" key on the keyboard, this image is saved into the clipboard. Next, open a program which can edit images and select "Insert" (shortcut "Ctrl+V") in a new document to add the screenshot for editing and saving.

Note: Press "Alt + Print screen" on the keyboard to capture the active window only.
Slider
Used for visual input of values. Similar to volume control on a mixing board, you can control various parameters by sliding the fader. A very common example for this is the zoom slider that lets you see a picture in more detail.

Slideshow
An arrangement of various objects (photos, text, sound, etc.) is called a slide show. Slideshows can be saved separately as "MVM" files.

SMTP
Stands for Simple Mail Transfer Protocol and enables the exchange of emails across computer networks.

Software
The name for all non-physical functional components of a computer. This primarily includes computer programs and files that are meant to be used by computer programs.

Submenu
Besides normal entries, a menu can contain submenus that offer additional functions. This makes menus more comprehensive.

Super Video CD (SVCD)
The Super Video CD (SVCD) is a technological advancement of the video CD. SVCDs are also like VCD-specified CD-ROMs which can be played using either a Super Video CD player (connected to the television), or directly with the CD-ROM drive of a computer. Many DVD players can also play SVCDs. MPEG-2 and the increase of the data transfer rate makes it hard to tell videos from videos in DVD quality apart.

Resolution: SVCDs use the better MPEG-2 encoder in a standardized resolution of 480 x 576 (PAL). The MPEG-2 format offers a maximum resolution of up to 720 x 576 points and improved compression methods characterized by excellent image definition and homogeneity.

Hard disk capacity: An average 90-minute movie must be spread across 3 CDs. On one SVCD you can get about 30 minutes of good-quality movie.

Encoder setting: Compared to the VCD with 1.3, the data transfer rate is doubled to 2.6 Mbit/s.
MPEG-2 format introduces the so-called variable bit rate (VBR). In contrast to the constant bit rate (CBR) of the MPEG-1 encoders, this encoder has the option of using more bits for movement-intensive sections, as well as saving bits if picture content remains the same.

T

Toolbar
Here you will find small buttons that provide a function when clicked. For example, you can cut out a selected object by clicking on the scissors.

Toolbar
All basic functions of the corresponding program can be found here. The corresponding functions can be called up via mouse click.

Top-level domain
Top-level domains (TLD) are always those separated by a dot at the end of an Internet address (for example, "http://www.magix.com" < here, .com is the top-level domain). Among these are also country top-level domains, such as .co.uk, .us, .de as well as so-called generic top-level domains like .net, .org, .biz, and so on.

Traffic
Traffic (data transmission) occurs within your MAGIX Website Service as soon as data is transferred across the Internet: for example, when uploading or downloading files to your website or when someone else opens your website.

U

Universal Plug & Play; UPnP
Universal Plug ‘n’ Play (UPnP) is a network protocol which enables data exchange between different devices (PCs, hi-fi systems, video cameras, PDAs, and webserver). UPnP allows various devices to participate in network-wide communication, i.e. the initialization of functions and other device functions. Long-winded configuring or installing of drivers is not required as the devices can handle their own functions and data sources by themselves. Find out more at www.upnp.org.

Hint: To work with UPnP you have to activate it first. This can be found under "Options" ("Y" -> UPnP).
**URL**
URL stands for Uniform Resource Locator and describes where a source can be found online (for example, a website). The address or the path to the storage location of a file on your computer is known as a URL. Often the term URL is used as a term for the domain. The URL for the MAGiX website is: http://www.magix.co.uk

**V**

**VST and DirectX plug-ins**
Plug-ins are additional programs that expand the functionality of the main program. They are inserted into the main program.

Two standards exist for audio editing: VST (Steinberg) and DirectX (Microsoft). VST has asserted itself stronger in the current market.

**W**

**WAV**
Wave (*.WAV) is a standard uncompressed audio format.

**Wave**
Wave (*.WAV) is a standard uncompressed audio format.

**Wave file**
Wave (*.WAV) is a standard uncompressed audio format.

**Webhosting**
This means that an Internet Service Provider makes domains and webspace available to its customers. With the MAGiX Website Service, MAGiX provides webhosting to its customers.

**Webmail**
Webmail enables the customer to view and receive the contents of their email inbox without having to install email software on their computer. Customers of the MAGiX Website Service can use MAGiX Webmail for this.

**Webmaster**
A webmaster is responsible for the administration and maintenance of a website. Often, the webmaster is also the owner of the website as well as the domain that belongs to it. Once you have registered a domain in the MAGiX Website Service, an email account will automatically be set up, for example: "mailto:webmaster@domainname.co.uk".
Webserver
Webserver refers to the computer on which your host saves your website's pages and which makes your pages accessible on the Internet 24-hours a day.

WMA
A process developed by Microsoft for compressing audio files with properties similar to those of MP3.

WMV
Windows Media Video (WMV) is a trademark video codec from Microsoft. If you have Windows installed on your PC, then playing WMV files shouldn’t be a problem. Only a few (hardware) DVD players are able to play this format. Read more about this in your DVD player’s manual.

This video format is very good for web videos as it allows relatively high compression rates.

World Wide Web (WWW)
WWW stands for "World Wide Web" and is the most used service of the Internet. On the WWW, web browsers (for example, Internet Explorer) are used to display information via websites. The process is colloquially called "Surfing the Internet".

Zip
ZIP is a file format for archiving your files. The original file is reduced and then restored to its original size after it is unpacked without losing any quality.
## Index

### 3

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D basics</td>
<td>107</td>
</tr>
<tr>
<td>3D series</td>
<td>84</td>
</tr>
<tr>
<td>3D text</td>
<td>98, 100, 113</td>
</tr>
<tr>
<td>3D transitions</td>
<td>82, 84, 119</td>
</tr>
</tbody>
</table>

### A

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AAC</td>
<td>187, 198</td>
</tr>
<tr>
<td>About MAGiX PhotoStory on CD &amp; DVD 10</td>
<td>177</td>
</tr>
<tr>
<td>Accept media after download</td>
<td>56</td>
</tr>
<tr>
<td>Actions at the end of the slideshow (Slideshow menu only)</td>
<td>133</td>
</tr>
<tr>
<td>Activate additional functions</td>
<td>178</td>
</tr>
<tr>
<td>Activation problems</td>
<td>180, 181</td>
</tr>
<tr>
<td>Add new font to text</td>
<td>143</td>
</tr>
<tr>
<td>Additional new features of the deluxe version</td>
<td>16</td>
</tr>
<tr>
<td>Adjust background and buttons</td>
<td>143</td>
</tr>
<tr>
<td>Adjust brightness/volume</td>
<td>50</td>
</tr>
<tr>
<td>Adjust music to section</td>
<td>158, 174</td>
</tr>
<tr>
<td>Adjust size of image material in higher quality (slower)</td>
<td>118</td>
</tr>
<tr>
<td>Adjusting the Signal Level</td>
<td>74, 75, 77</td>
</tr>
<tr>
<td>Advanced audio recording settings</td>
<td>75</td>
</tr>
<tr>
<td>Advanced configurations in the video capturing dialog</td>
<td>79</td>
</tr>
<tr>
<td>Advanced settings</td>
<td>99, 161</td>
</tr>
<tr>
<td>Advanced video settings</td>
<td>185</td>
</tr>
<tr>
<td>Align videos and pictures for 3D</td>
<td>111</td>
</tr>
<tr>
<td>All modes</td>
<td>40</td>
</tr>
<tr>
<td>Also in the deluxe version</td>
<td>19</td>
</tr>
<tr>
<td>Also in Timeline mode and Overview mode</td>
<td>41</td>
</tr>
<tr>
<td>Alternative Mode 1 (Mixer Overlay)</td>
<td>121</td>
</tr>
<tr>
<td>Alternative Mode 2 (Video Mixing Renderer 9)</td>
<td>121</td>
</tr>
<tr>
<td>AMR</td>
<td>187, 198</td>
</tr>
<tr>
<td>Angle &amp; shape</td>
<td>70</td>
</tr>
<tr>
<td>Animate objects</td>
<td>72</td>
</tr>
<tr>
<td>Animated GIF</td>
<td>163</td>
</tr>
<tr>
<td>Animated selection menus</td>
<td>130</td>
</tr>
<tr>
<td>Animation</td>
<td>98</td>
</tr>
<tr>
<td>Annex - Digital Video and Data Storage</td>
<td>137, 208</td>
</tr>
<tr>
<td>Anti-flicker filter</td>
<td>171</td>
</tr>
<tr>
<td>Appendix - MPEG Encoder Settings</td>
<td>148, 183</td>
</tr>
</tbody>
</table>

www.magix.com
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applying BPM and beat detection</td>
<td>102</td>
</tr>
<tr>
<td>Arranger</td>
<td>118</td>
</tr>
<tr>
<td>Artistic filter</td>
<td>62</td>
</tr>
<tr>
<td>Aspect ratio</td>
<td>197</td>
</tr>
<tr>
<td>Attach</td>
<td>156</td>
</tr>
<tr>
<td>Audio buffer size</td>
<td>117</td>
</tr>
<tr>
<td>Audio playback</td>
<td>117</td>
</tr>
<tr>
<td>Audio recording</td>
<td>74, 159</td>
</tr>
<tr>
<td>Audio settings</td>
<td>186</td>
</tr>
<tr>
<td>AudioID</td>
<td>222</td>
</tr>
<tr>
<td>Automatic preview when changing transition</td>
<td>120</td>
</tr>
<tr>
<td>Automatic Tempo Recognition</td>
<td>101</td>
</tr>
<tr>
<td>Automatically create frametable during import</td>
<td>120</td>
</tr>
<tr>
<td>Automatically cut to fit monitor</td>
<td>172</td>
</tr>
<tr>
<td>Automatically fade photos with effects</td>
<td>120</td>
</tr>
<tr>
<td>Automatically preview exported clips</td>
<td>120</td>
</tr>
<tr>
<td>Automatically select preview image</td>
<td>124</td>
</tr>
<tr>
<td>Autoscroll during playback</td>
<td>118</td>
</tr>
<tr>
<td>AVC / H.264</td>
<td>187, 192</td>
</tr>
<tr>
<td>AVC preset</td>
<td>192</td>
</tr>
<tr>
<td>AVCHD disc</td>
<td>136, 213</td>
</tr>
<tr>
<td>AVI</td>
<td>222</td>
</tr>
<tr>
<td>Background</td>
<td>71</td>
</tr>
<tr>
<td>Background design</td>
<td>173</td>
</tr>
<tr>
<td>Background music</td>
<td>89, 90</td>
</tr>
<tr>
<td>Backup copy</td>
<td>164</td>
</tr>
<tr>
<td>Backup disc</td>
<td>216</td>
</tr>
<tr>
<td>Basic settings</td>
<td>26</td>
</tr>
<tr>
<td>B-frames count</td>
<td>192</td>
</tr>
<tr>
<td>Bit rate</td>
<td>201</td>
</tr>
<tr>
<td>Bit rate (Bits/s)</td>
<td>191, 196</td>
</tr>
<tr>
<td>Bit rate control</td>
<td>190, 196</td>
</tr>
<tr>
<td>Block</td>
<td>202, 207</td>
</tr>
<tr>
<td>Blu-ray Disc™</td>
<td>136, 213</td>
</tr>
<tr>
<td>Border cropping adjustment</td>
<td>171</td>
</tr>
<tr>
<td>Brightness &amp; contrast</td>
<td>58</td>
</tr>
<tr>
<td>Browser</td>
<td>222</td>
</tr>
<tr>
<td>Burn dialog for DVD player</td>
<td>146</td>
</tr>
<tr>
<td>Burn disc</td>
<td>124, 134, 166</td>
</tr>
<tr>
<td>Burn JPEG disc</td>
<td>149</td>
</tr>
<tr>
<td>Burn project (image) again</td>
<td>167</td>
</tr>
<tr>
<td>Burn slideshow and media to CD/DVD</td>
<td>165</td>
</tr>
<tr>
<td>Index</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>Burn WMV HD</td>
<td>149, 216</td>
</tr>
<tr>
<td>Burning wizard</td>
<td>136</td>
</tr>
<tr>
<td>Button</td>
<td>222</td>
</tr>
</tbody>
</table>

C

- Cache | 222 |
- Calculating the panorama image | 114 |
- Camera/zoom | 67 |
- Capacity and quality of different disc formats | 210 |
- Catooh – the Online Content Library | 13, 55, 115, 219 |
- CC | 222 |
- CDA | 223 |
- Change the program interface | 168 |
- Choose music style | 115 |
- Choppy or uneven playback | 181 |
- Chroma format | 202 |
- Clean-up Wizard | 157 |
- Clip level | 223 |
- Clipboard | 223 |
- Color | 59, 104 |
- Color shade | 60 |
- Compatibility Mode (Video for Windows) | 121 |
- Completely reworked Slideshow Maker | 14 |
- Compressor | 95 |
- Computer | 53 |
- Concentrated multimedia power | 18 |
- Connecting the source for recording | 76 |
- Content | 175 |
- Context menu | 50, 223 |
- Convert to 3D titles... | 174 |
- Copy | 41 |
- Copy keyframes | 73 |
- Copy project and media into folder... | 165 |
- Copy Protection | 212 |
- Copy slideshow and media into folder... | 165 |
- Copyright | 2, 223 |
- CPB size | 196 |
- CPU | 223 |
- Create a new slideshow with the wizard | 26, 157 |
- Create DVD menus without a template | 144 |
- Create multiple slideshows | 33 |
- Create panorama image... | 173 |
- Create PC show | 149 |
- Create slideshow | 91 |
Create titles for 3D videos
Create webDVD
Creating an ISO image
Creating backgrounds
Creating CD/DVD menus
Creating titles using a template
Creating titles without a template
Creation of custom color spaces
Cut
Cut button and editing menu
Cut slideshow or objects

D
Declipper
decoration
Define the path for saving Internet media.
Dehisser
De-interlacing
Delete
Delete keyframe
Delete specific files
Deleting, copying and moving files
Design
Design button
Design page
Designing slideshows
Determining the start of a measure
Dialog
Digital Versatile Disc (DVD)
Direction & time
Disc options
Disc project
Disc projects, slideshows, and photos
Disc types
Disk space
Display
Display duration...
Display keyframes of individual parameters
Display Tool Tips
Distortion
DNS
Domain
Domain transfer
Download presets for new device

www.magix.com
| Drag & drop                  | 224 |
| Drag & drop onto a          | 81  |
| Driver info                 | 75  |
| Driver selection            | 117 |
| Duplicate objects           | 50  |
| Easily                      | 25  |
| Edit bitmap externally      | 42  |
| Edit disc menu              | 128 |
| Edit DVD menus featuring MAGIX Photo & Graphic Designer | 139 |
| Edit externally             | 142 |
| Edit Fotoshow               | 20, 36 |
| Edit image (external)...    | 172 |
| Edit Menu                   | 169 |
| Edit menu elements          | 128 |
| Edit title                  | 98  |
| Edit your own menu entries  | 134 |
| Editing a menu for 3 to 5 movies | 142 |
| Editing slideshows          | 30  |
| Effects                     | 58, 85, 89, 98 |
| Effects from the Media Pool | 85  |
| Effects in menus            | 85  |
| Effects Menu (FX)           | 85, 103, 114, 171 |
| Encoder                     | 183 |
| Encoder settings            | 147 |
| Equalizer                   | 91, 94 |
| Even more custom design options in menu design | 16 |
| Exchange object             | 41, 57 |
| Exit                        | 168 |
| Export                      | 150, 159 |
| Export and burning 3D videos | 113 |
| Export as 3D video (deluxe version only) | 151 |
| Export for mobile device - export video/audio | 154, 164 |
| Export menu                 | 139, 143, 144 |
| Export slideshow file       | 156 |
| Export to mobile devices    | 154 |
| Exporting                   | 17  |
| Exposure                    | 103 |
| Fade in date as title       | 174 |
| Fader                       | 224 |

www.magix.com
Fades 58, 173
Fee-based activation (MPEG-4) 179
Field 202, 225
Field order 190, 195
File Menu 26, 124, 155
File will not load 181
Film length 89
Finished panorama (2 images) 115
Finishing a new slideshow 28
Flip menu 225
Font 98
For iPod 200
For Sony PSP 200
Frame 202, 225
Free activation (MPEG 2 codec) 178

G

General notes on AVI videos 159, 181, 209, 222
General options 48, 75
General settings 117, 168, 183, 201
General use 103
Generate background music 116
Generic 187, 192
GOP 184, 191, 197, 203
GOP structure 191, 197
Grid 49
Group associated images together 90

H

Handles 225
Hard disk 225
Hard disk drive 225
Hardware 226
Hardware Acceleration (Direct 3D) 121, 122
Hardware acceleration for 3D effects 119
HDD 226
HDTV 208, 226
Help 175
Help Menu 175
Hide news 120
High output quality with dynamic zoom and combination effects 119
HSS rate 196
HTTP 226
Hyperlink 226

I

I frames 190, 192, 197, 203
ID3 tags 226
If You Still Have Questions 221
Image 227
Image formation in Vertical Blank Intervals (VBI) 122
Image material playback 118
Image optimization 42, 58, 85, 103, 168, 171
Image stabilization dialog 86
IMAP 227
Import 158
Import slideshow file 156
Importieren 17
Including video objects 89
Individual Frame Capture 78
Information on special program versions 10, 14, 21
Input info 192, 197
Integrated browser 55
Intelligent mouse mode 42, 51
Intensity 88
Interlace 121, 183, 190, 195, 202, 203, 227
Internet 163
Interpolation for interlace material 171
Intro 227
Introduction 14
Intros/Outros: 71
Invert image sequence for panorama image 114
ISMA compatible 200

J

JPEG disc 210, 215
jpx 227
Jump to linked page 132

K

Keyboard shortcuts 21

L

Level 194

www.magix.com
Live mode (get times from samples) 200
Load an OnDisc editing from disc (only deluxe version) 128
Load CD tracks via record dialog 120
Load image material in the background 118
Load photos 27
Load pictures, texts and audio files 57
Load project 40
Loading Internet media 56
Lots of new templates 15

M

MAGIX Blog Service 12, 219
MAGIX Community 13, 218
MAGIX media 54
MAGIX Music Editor 16
MAGIX News Center 12, 120
MAGIX Online Album 12, 217
MAGIX Photo Manager 15
MAGIX Screenshare 176
MAGIX services in detail 217
MAGIX Soundtrack Maker 115, 158
MAGIX video export 160
MAGIX Website Maker 12
magix.info 176
Magnetic objects 71
Manage slideshow 156
Max b-frames count 197
Max GOP length 197
Max key interval 191
Max. rate 191
Media 52, 55
Media Pool 21, 39, 51
Menu 126, 137, 227
Menu bar 228
Menu entry/menu page properties 131, 132
Menu image 133
Menu templates 127
Menu text 132
Menu text with external menu editing 140
Menu view and menu navigation 33
Menus 20, 155
MIDI 228
miniDVD 136, 210, 216
Mirror 70
Index

Mirror & Rotate 69
Mode 190, 196
More about MAGIX 12
More disc types 35
Motherboard 228
Motion estimation 183, 201, 206
Mouse mode for individual objects 42, 51
Mouse modes 50
MOV 228
Movement in direction 67
Movie properties 124
MP3 228
MPEG 229
MPEG Compression 209
MPEG glossary 201
MPEG-4 187
MPEG-4 encoder settings 187, 213
MPEG-4 preset 187
MS audio 229
Multi disc 211, 216
Multiplexer 199
Mute sound 43
MXV 229
My media 53
My music 54
My pictures 54
My videos 54

N

Navigation 129
Navigation buttons 52
Navigation in the browser 55
New 155
New project 39
New project - Settings 123
New Title Editor 14
Noise Reduction - Denoiser and Dehisser 92
Noise Sample 229
Note on SVCD compatibility 130
NTSC (USA, Japan) 229
Numeric keypad 229
### O

<table>
<thead>
<tr>
<th>Item</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object cutting and fades</td>
<td>49</td>
</tr>
<tr>
<td>Objects</td>
<td>49</td>
</tr>
<tr>
<td>Objekt austauschen</td>
<td>170</td>
</tr>
<tr>
<td>OGG VORBIS</td>
<td>229</td>
</tr>
<tr>
<td>OnDisc Editing</td>
<td>134</td>
</tr>
<tr>
<td>Online menu</td>
<td>119, 175</td>
</tr>
<tr>
<td>Online Services</td>
<td>119</td>
</tr>
<tr>
<td>Online Update</td>
<td>177</td>
</tr>
<tr>
<td>Only in overview mode</td>
<td>42</td>
</tr>
<tr>
<td>Only in Timeline mode</td>
<td>42</td>
</tr>
<tr>
<td>Open</td>
<td>155</td>
</tr>
<tr>
<td>Open automatically saved project...</td>
<td>155</td>
</tr>
<tr>
<td>Open browser</td>
<td>55</td>
</tr>
<tr>
<td>Opening and closing credits</td>
<td>90</td>
</tr>
<tr>
<td>Optimize grid view</td>
<td>42</td>
</tr>
<tr>
<td>Optimize photo</td>
<td>42</td>
</tr>
<tr>
<td>Optimize picture</td>
<td>42, 85, 103, 168</td>
</tr>
<tr>
<td>Optional AVCHD support</td>
<td>16</td>
</tr>
<tr>
<td>Options</td>
<td>119, 147, 216</td>
</tr>
<tr>
<td>Other</td>
<td>119</td>
</tr>
<tr>
<td>Output device</td>
<td>117</td>
</tr>
<tr>
<td>Output format</td>
<td>199</td>
</tr>
<tr>
<td>Output to device</td>
<td>164</td>
</tr>
<tr>
<td>Overview mode</td>
<td>18, 20, 43</td>
</tr>
<tr>
<td>Overview of the program screen</td>
<td>20</td>
</tr>
</tbody>
</table>

### P

<table>
<thead>
<tr>
<th>Item</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>P frames and B frames</td>
<td>191, 192, 197, 205</td>
</tr>
<tr>
<td>PAL (Europe)</td>
<td>229</td>
</tr>
<tr>
<td>Pass</td>
<td>196</td>
</tr>
<tr>
<td>Paste</td>
<td>41</td>
</tr>
<tr>
<td>Paths</td>
<td>118</td>
</tr>
<tr>
<td>Picture type</td>
<td>189, 195</td>
</tr>
<tr>
<td>Picture-in-picture collages</td>
<td>71, 173</td>
</tr>
<tr>
<td>Pixel aspect ratio</td>
<td>191</td>
</tr>
<tr>
<td>Play back menu in MAGiX PhotoStory on CD &amp; DVD</td>
<td>143</td>
</tr>
<tr>
<td>Play marker</td>
<td>230</td>
</tr>
<tr>
<td>Playback</td>
<td>117</td>
</tr>
<tr>
<td>Playlist</td>
<td>230</td>
</tr>
<tr>
<td>Plug-in</td>
<td>230</td>
</tr>
<tr>
<td>Podcast</td>
<td>230</td>
</tr>
</tbody>
</table>
Podcasting 230
POP3 231
Position 65
Prediction 201, 203, 205
Preface 3
Preparation - Setting the start marker and object end 100
Prepare 3D editing 109
Preparing animations 72
Prerequisites for using the beat recognition assistant 100
Present & share 19
Preview 57, 119
Preview and editing 125
Problems and solutions 181
Produce panorama pictures 114, 173
Profile/Level 188
Profiles 194
Program Settings 168
Project 25, 155, 231
Project- and slideshow-relevant settings 123
Project... 167
Projects 53
Projekt, Fotoshows und Medien brennen 165
Properties 17, 175
Properties & title 89
Provider 231
Publish directly on the Internet. 152
Publish via MAGIX Online Album 153
Pulldown 190, 195

Q

Quantization scaling 207
Quick start 25

R

RAM (Random Access Memory) 231
Ratio: 232
RAW support 16
Reactivate hint dialogs 119
Real Media Export 161
Record 74
Record 3D 107, 108
Recording 159
Red Book 232

www.magix.com
Red/Green/Blue 60
Red-eye removal 60
Redo 169
Register as guest of a screen session 177
Register as host for a screen transfer 176
Register online 177
Remote control 125
Remove from project 156
Remove object end 38
Remove start 38
Rename 156
Reset Effects 174
Reset Program Settings to Default... 168
Restore 40, 232
Restore data backup from (S)VCD/Video DVD 166
Retroactively editing an effect’s keyframes 73
Revised DVD menu design 15
RM 232
Rotate 69
Rotate 90° 171
Rotate 90° to the right 42

S

Saturation 60
Save 158
Save as title template... 174
Save Disc Project as 158
Save project 40
Save slideshow as video on your computer 150
Save/delete style template 88
Scan image 159
Scan photo externally... 159
Scan with 159
Scene change detection 192, 197
Screenshot 232
Search 52
Search and delete superfluous files 157
Section 66
Select background music 27
Select objects 50
Select pictures for panorama 114
Select source 159
Selective color correction (deluxe version) 61
Send slideshow as email (deluxe version) 163
Separate project onto multiple discs 138
Serial number 11, 17
Set keyframes 72
Set mood change 116
Set playback mode for 3D 84, 110, 111
Setting the manual and Onbeat/Offbeat 101
Settings 167
Sharpness 62, 105
Show/Hide 174
Simple crossfade in Timeline Mode 81
Single frame as BMP 163
Single frame as JPG 163
Size 65
Size & Position 65
Slice count 190, 195
Slider 233
Slideshow 21, 25, 155, 233
Slideshow & photo menu 129
Slideshow effect settings 168
Slideshow effects 103
Slideshow Maker 40, 88, 157
Slideshow wizard 157
Slideshow... 167
SMTP 233
Soft movement 73
Software 233
Sorting Photos 28
Sound in picture support 57
Sound optimization 75, 91, 174
Soundtrack Maker 115, 158
Specify effects 27
Speed 64
Split object 38, 170
Split slideshow 38
Standard picture length 121
Start and end markers 29, 43, 115
Start introductory video 176
Statistics 192, 198
Stereo FX 95
Stereo3D (deluxe version) 37, 70, 107, 151
Stereo3D in the Media Pool 70
Stereo3D transitions (deluxe version only) 84, 88
Storyboard mode 17, 20, 45, 85, 172
Straighten horizon 69
Structure of a PSD file 141
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style templates</td>
<td>88</td>
</tr>
<tr>
<td>Submenu</td>
<td>233</td>
</tr>
<tr>
<td>Super Video CD (SVCD)</td>
<td>214, 233</td>
</tr>
<tr>
<td>Support</td>
<td>8, 180, 182</td>
</tr>
<tr>
<td>System</td>
<td>120</td>
</tr>
<tr>
<td>System requirements</td>
<td>10</td>
</tr>
<tr>
<td><strong>T</strong></td>
<td></td>
</tr>
<tr>
<td>Task assistant</td>
<td>221</td>
</tr>
<tr>
<td>Tasks menu</td>
<td>175, 221</td>
</tr>
<tr>
<td>Templates</td>
<td>58</td>
</tr>
<tr>
<td>Tempo and beat recognition</td>
<td>100</td>
</tr>
<tr>
<td>Test series with variable encoder settings</td>
<td>137</td>
</tr>
<tr>
<td>Three views</td>
<td>17</td>
</tr>
<tr>
<td>Timeline</td>
<td>47</td>
</tr>
<tr>
<td>Timeline mode</td>
<td>17, 20, 47</td>
</tr>
<tr>
<td>Tips for program help</td>
<td>221</td>
</tr>
<tr>
<td>Title</td>
<td>58</td>
</tr>
<tr>
<td>Title editor</td>
<td>41, 96</td>
</tr>
<tr>
<td>Title Editor</td>
<td>173</td>
</tr>
<tr>
<td>Title object</td>
<td>99</td>
</tr>
<tr>
<td>Toolbar</td>
<td>39, 234</td>
</tr>
<tr>
<td>Top Toolbar</td>
<td>39</td>
</tr>
<tr>
<td>Top-level domain</td>
<td>234</td>
</tr>
<tr>
<td>Track damping options</td>
<td>76</td>
</tr>
<tr>
<td>Tracks</td>
<td>47</td>
</tr>
<tr>
<td>Traffic</td>
<td>234</td>
</tr>
<tr>
<td>Transfer to external device</td>
<td>163</td>
</tr>
<tr>
<td>Transitions</td>
<td>88</td>
</tr>
<tr>
<td>Transitions (fades)</td>
<td>46, 80, 120</td>
</tr>
<tr>
<td>Transitions in Storyboard Mode</td>
<td>80</td>
</tr>
<tr>
<td>Travel route animation</td>
<td>16</td>
</tr>
<tr>
<td>Turn camera movements into 3D videos</td>
<td>112</td>
</tr>
<tr>
<td>TV image size (Slideshow master effects)</td>
<td>99, 103, 105, 129, 171</td>
</tr>
<tr>
<td>TV picture</td>
<td>85, 171</td>
</tr>
<tr>
<td>Twain scanner</td>
<td>159</td>
</tr>
<tr>
<td><strong>U</strong></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>40, 169</td>
</tr>
<tr>
<td>Update preview images in the background</td>
<td>120</td>
</tr>
<tr>
<td>Upload all selected media in Media Pool</td>
<td>220</td>
</tr>
<tr>
<td>Upload current movie as video</td>
<td>220</td>
</tr>
<tr>
<td>Universal Plug &amp; Play</td>
<td>234</td>
</tr>
</tbody>
</table>

www.magix.com
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upright-format effects</td>
<td>71</td>
</tr>
<tr>
<td>URL</td>
<td>235</td>
</tr>
<tr>
<td>Use high resolution for fullscreen playback</td>
<td>122</td>
</tr>
<tr>
<td>Use image file</td>
<td>124</td>
</tr>
<tr>
<td>Use output and file cache</td>
<td>117</td>
</tr>
<tr>
<td>Use preview image from movie</td>
<td>124</td>
</tr>
<tr>
<td>User directory</td>
<td>53</td>
</tr>
<tr>
<td>V</td>
<td></td>
</tr>
<tr>
<td>VBV buf. size</td>
<td>191</td>
</tr>
<tr>
<td>Video as AVI</td>
<td>159</td>
</tr>
<tr>
<td>Video as MPEG video</td>
<td>160</td>
</tr>
<tr>
<td>Video as MPEG-4 video</td>
<td>162</td>
</tr>
<tr>
<td>Video as Quicktime Movie</td>
<td>160</td>
</tr>
<tr>
<td>Video CD (VCD)</td>
<td>214</td>
</tr>
<tr>
<td>Video Editing on the PC</td>
<td>208</td>
</tr>
<tr>
<td>Video format</td>
<td>193</td>
</tr>
<tr>
<td>Video Mode</td>
<td>121</td>
</tr>
<tr>
<td>Video monitor and transport control</td>
<td>36</td>
</tr>
<tr>
<td>Video options</td>
<td>119</td>
</tr>
<tr>
<td>Video playback</td>
<td>117</td>
</tr>
<tr>
<td>Video settings</td>
<td>183, 184</td>
</tr>
<tr>
<td>Video Stabilization</td>
<td>85, 173</td>
</tr>
<tr>
<td>Video standard</td>
<td>119</td>
</tr>
<tr>
<td>View &amp; animation</td>
<td>65, 171</td>
</tr>
<tr>
<td>Volume curves</td>
<td>48</td>
</tr>
<tr>
<td>VST and DirectX plug-ins</td>
<td>235</td>
</tr>
<tr>
<td>W</td>
<td></td>
</tr>
<tr>
<td>WAV</td>
<td>235</td>
</tr>
<tr>
<td>Wave</td>
<td>235</td>
</tr>
<tr>
<td>Wave file</td>
<td>235</td>
</tr>
<tr>
<td>Webhosting</td>
<td>235</td>
</tr>
<tr>
<td>Webmail</td>
<td>235</td>
</tr>
<tr>
<td>Webmaster</td>
<td>235</td>
</tr>
<tr>
<td>Webserver</td>
<td>236</td>
</tr>
<tr>
<td>What is MAGIX PhotoStory on CD &amp; DVD 10?</td>
<td>14</td>
</tr>
<tr>
<td>What is Timeline mode?</td>
<td>47</td>
</tr>
<tr>
<td>What’s new in MAGIX PhotoStory on CD &amp; DVD 10?</td>
<td>14</td>
</tr>
<tr>
<td>White balance</td>
<td>59</td>
</tr>
<tr>
<td>Windows Media Export</td>
<td>161</td>
</tr>
<tr>
<td>Wizards</td>
<td>157</td>
</tr>
<tr>
<td>WMA</td>
<td>236</td>
</tr>
<tr>
<td>Term</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>WMV</td>
<td>236</td>
</tr>
<tr>
<td>WMV HD</td>
<td>212</td>
</tr>
<tr>
<td>World Wide Web (WWW)</td>
<td>236</td>
</tr>
<tr>
<td>Youtube / Flickr</td>
<td>220</td>
</tr>
<tr>
<td>Zip</td>
<td>236</td>
</tr>
<tr>
<td>Zoom in video monitor</td>
<td>39</td>
</tr>
<tr>
<td>Zooming</td>
<td>48</td>
</tr>
</tbody>
</table>